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1 Welcome to The Journal

Keeping a daily journal has never been easier! The Journal always knows what day it is, and
automatically organizes your entries by day, month and year.

Get organized! With The Journal's many options for categories and entries you can be as
organized as you want to be. Keep your  personal journal separate from your work notes, or your
dreams separate from your correspondence--but only if you want to.

Do it Your Way! The Journal has no "agenda"--except to be as useful as possible. Use any
journaling technique or writing style you want, even none at all. It's completely up to you.

The Journal Newsletter! Sent out monthly, The Journal Newsletter provides tips for using The
Journal, articles about journaling and writing, writing exercises, news of updates and fixes, and more.

Getting Started - New Users

Getting Started with The Journal - A Step by Step Guide

Frequently Asked Questions (FAQ)

Getting Started - Upgrading from The Journal 5 or earlier

See what's new in The Journal 6!
Lightning-fast searches!
Synchronize multiple copies of The Journal!
Improved printing, exporting, and importing!
And much, much more!

Upgrading from The Journal 5 or Earlier
Upgrading Add-on Packages
Upgrading from The Journal 2.x
Make The Journal 6 look more like The Journal 4

http://www.davidrm.com/thejournal/newsletter/
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2 The Journal Information

Getting Started with The Journal - A Step by Step Guide

Frequently Asked Questions (FAQ)

Contact Information (email, Web page, etc.)

THE JOURNAL - PRODUCT LICENSE INFORMATION

Credits
Dedication
Special Thanks

Buy The Journal
The Journal Pricing
The Journal Order Form

Version History

See what's new in The Journal 6!

2.1 Contact Information

The Journal Home Page
http://www.davidrm.com/thejournal/

The Journal Customer Support, Bug Reports & Suggestions
support@davidrm.com

The Journal Newsletter
http://www.davidrm.com/thejournal/newsletter/

The Journal User Discussion
http://groups.yahoo.com/group/thejournal-users

DavidRM Software
http://www.davidrm.com

Mailing Address:

DavidRM Software
7018 East 78th Place
Tulsa, OK 74133
United States of America

http://www.davidrm.com/thejournal/
mailto:support@davidrm.com
http://www.davidrm.com/thejournal/newsletter/
http://groups.yahoo.com/group/thejournal-users
http://www.davidrm.com
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2.2 THE JOURNAL - PRODUCT LICENSE INFORMATION

NOTICE TO USERS: CAREFULLY READ THE FOLLOWING LEGAL AGREEMENT.

USE OF THE SOFTWARE PROVIDED WITH THIS AGREEMENT (THE "SOFTWARE") CONSTITUTES
YOUR ACCEPTANCE OF THESE TERMS. IF YOU DO NOT AGREE TO THE TERMS OF THIS
AGREEMENT, DO NOT INSTALL AND/OR USE THIS SOFTWARE.

1. LICENSE GRANT.

DavidRM Software grants you a license to use one copy of the version of this SOFTWARE on any one
hardware product for as many licenses as you purchase. "You" means the company, entity or
individual whose funds are used to pay the license fee. "Use" means storing, loading, installing,
executing or displaying the SOFTWARE, whether on the hardware product directly or via a network.

Household License: Individuals (not companies nor other entities) who purchase the SOFTWARE may
use the SOFTWARE on any hardware products they own or are the primary user of, and on any
hardware products owned by members of their immediate family residing in their household.

When you first obtain a copy of the SOFTWARE, you are granted an evaluation period of not more
than 45 days or 45 uses, whichever is greater, after which time you must pay for the SOFTWARE
according to the terms and prices discussed in the SOFTWARE's documentation, or you must remove
the SOFTWARE from your computer.

You may not modify the SOFTWARE or disable any licensing or control features of the SOFTWARE
except as an intended part of the SOFTWARE's programming features.

This license is not transferable to any other company, entity, or individual.

2. OWNERSHIP.

The SOFTWARE is owned and copyrighted by DavidRM Software. Your license confers no title or
ownership in the SOFTWARE and should not be construed as a sale of any right in the SOFTWARE.

3. COPYRIGHT.

The SOFTWARE is protected by United States copyright law and international treaty provisions. You
acknowledge that no title to the intellectual property in the SOFTWARE is transferred to you. You further
acknowledge that title and full ownership rights to the SOFTWARE will remain the exclusive property of
DavidRM Software and you will not acquire any rights to the SOFTWARE except as expressly set forth
in this license. You agree that any copies of the SOFTWARE will contain the same proprietary notices
which appear on and in the SOFTWARE.

4. UNAUTHORIZED USE.

You may not use, copy, rent, lease, sell, modify, decompile, disassemble, otherwise reverse engineer,
or transfer the SOFTWARE except as provided in this agreement. Any such unauthorized use shall
result in immediate and automatic termination of this license.

5. U.S. GOVERNMENT INFORMATION.

Use, duplication, or disclosure by the U.S. Government of the computer software and documentation in
this package shall be subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in
Technical Data and Computer Software clause at DFARS 252.277-7013 (Oct 1988) and FAR 52.227-19
(Jun 1987). The Contractor is DavidRM Software, 7018 East 78th Place, Tulsa, OK, 74133.
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6. LIMITED WARRANTY.

THIS SOFTWARE IS PROVIDED ON AN "AS IS" BASIS. DAVIDRM SOFTWARE DISCLAIMS ALL
WARRANTIES RELATING TO THIS SOFTWARE, WHETHER EXPRESSED OR IMPLIED, INCLUDING
BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. NEITHER DAVIDRM SOFTWARE NOR ANYONE ELSE WHO HAS BEEN
INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS SOFTWARE SHALL BE
LIABLE FOR ANY INDIRECT, CONSEQUENTIAL, OR INCIDENTAL DAMAGES ARISING OUT OF THE
USE OR INABILITY TO USE SUCH SOFTWARE, EVEN IF DAVIDRM SOFTWARE HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR CLAIMS. THE PERSON USING THE
SOFTWARE BEARS ALL RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE.

SOME JURISDICTIONS DO NOT ALLOW LIMITATION OR EXCLUSION OF INCIDENTAL OR
CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS OR EXCLUSION MAY NOT APPLY TO
YOU TO THE EXTENT THAT LIABILITY IS BY LAW INCAPABLE OF EXCLUSION OR RESTRICTION.

IN NO EVENT SHALL ANY THEORY OF LIABILITY EXCEED THE LICENSE FEE PAID TO DAVIDRM
SOFTWARE.

7. NO LIABILITY FOR CONSEQUENTIAL DAMAGES.

IN NO EVENT SHALL DAVIDRM SOFTWARE OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY
CONSEQUENTIAL, SPECIAL, INCIDENTAL OR INDIRECT DAMAGES OF ANY KIND ARISING OUT
OF THE DELIVERY, PERFORMANCE OR USE OF THE SOFTWARE, EVEN IF DAVIDRM
SOFTWARE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT WILL
DAVIDRM SOFTWARE'S LIABILITY FOR ANY CLAIM, WHETHER IN CONTRACT, TORT OR ANY
OTHER THEORY OF LIABILITY, EXCEED THE LICENSE FEE PAID BY YOU, IF ANY.

8. SEVERABILITY.

In the event of invalidity of any provision of this license, the parties agree that such invalidity shall not
affect the validity of the remaining portions of this license.

9. GOVERNING LAW.

This agreement shall be governed by the laws of the State of Oklahoma excluding the application of its
conflicts of law rules and shall inure to the benefit of DavidRM Software and any successors,
administrators, heirs and assigns. Any action or proceeding brought by either party against the other
arising out of or related to this agreement shall be brought only in a STATE or FEDERAL COURT of
competent jurisdiction located in Tulsa County, Oklahoma. The parties hereby consent to in personam
jurisdiction of said courts. This agreement will not be governed by the United Nations Convention on
Contracts for the International Sale of Goods, the application of which is expressly excluded.

10. ENTIRE AGREEMENT.

This is the entire agreement between you and DavidRM Software which supersedes any prior
agreement or understanding, whether written or oral, relating to the subject matter of this license.

11. RESERVED RIGHTS.

All rights not expressly granted here are reserved to DavidRM Software.
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2.3 Credits

The Journal was designed and developed by David Michael.

The Journal splash screen and icon graphics were designed by Don Michael, Jr (http://www.
donmichaeljr.com).

The Journal was developed using Borland Delphi (http://www.borland.com/delphi).

The Journal's online help was created with Help & Manual from EC Software (http://www.
helpandmanual.com).

The Journal uses the following third-party algorithms, libraries and components:
TRichViewEdit component by Sergey Tkachenko (http://www.trichview.com).
TScaleRichView component by Ilya I. Zelensky.
DISQLite3 database components by Delphi Inspiration (http://www.yunqa.de/delphi/doku.php/).
Configurable menu and toolbars from Developer Express (http://www.devexpress.com).
BusinessSkinForm and SkinAdapter components from Almediadev (http://www.almdev.com).
Toolbar, menu and many, many Calendar Charm icons by IconShock (http://www.iconshock.com).
Spell checker and thesaurus from Addictive Software (http://www.addictivesoftware.com).
MD5 (password hashing) algorithm produced by RSA Data Security, Inc.
Twofish block cipher (entry text encryption) designed by Bruce Schneier (http://www.counterpane.
com).
Twofish encryption component programmed by Dave Barton.
MD5 hashing component programmed by Greg Carter.
LZH5 compression algorithm (a Lempel-Ziv-Huffman algorithm) programmed by South Pacific
Information Services Ltd.
GraphicEx (image file handling) library by Mike Lischke (http://www.soft-gems.net).
RBCalendar from Borshack Software Solutions.
ShellBrowser from JAM Software (http://www.jam-software.com).
ZipForge components by ComponentAce (http://www.componentace.com).
Year/month/day planners by Shorter Path Software (http://www.shorterpath.com).
Doodler component created using Image Editor by Greatis Software (http://www.greatis.com).

The Journal 4's original Calendar Charm icons (    ...) were created by Dan MacDonald.
Additional Calendar Charms were created by Jennifer Holstien and Mickael Pointier.

All trademarks are the property of their respective owners.

2.4 Dedication

For Susan, Davis, Serene, & Quaid.

2.5 Special Thanks

First, I must thank my wife, Susan, for being there, and for being here. I couldn't have finished The
Journal 6 (or any previous version) without her.

The Journal 6 testers: Frances Aranda, Joan J. Artus, Brad Barker, Christina Becker, Ben Charron,
David Cooper, Kathy Dunham, Kimberly Elahab, Mike Ellis, Laura Federico, Aaron Gravvat, Patricia
Harris, Rebecca Henry, Donavon C. Hiss, Nicole Holzem, Al Jacques, Sue James, Floyd Johnson,
Helga Kocurek, Wayne Lampel, Jock McDonald, Matthias Nagel, Amir Noori, Sandro Perotti, James
Salyers, Rich See, Daniel Shin, Julie Smith, Brendan Stallard, Wandio Tim, Jeff Toomb, Mark
Tyrnauer, Martin Vernhout

mailto:support@davidrm.com
http://www.donmichaeljr.com
http://www.donmichaeljr.com
http://www.borland.com/delphi
http://www.helpandmanual.com
http://www.helpandmanual.com
http://www.trichview.com
http://www.yunqa.de/delphi/doku.php/
http://www.devexpress.com
http://www.almdev.com
http://www.iconshock.com
http://www.addictivesoftware.com
http://www.counterpane.com
http://www.counterpane.com
http://www.soft-gems.net
http://www.jam-software.com
http://www.componentace.com
http://www.shorterpath.com
http://www.greatis.com
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The Journal 6 translators:
Matthias Nagel (German)
Daniel Calbimonte (Spanish)
Hrant Ohanyan (Armenian)

Special Thanks from The Journal 5

The Journal 5 testers: Christina Becker, Vicki Bourg, Chuck Carruthers, Sue Cifelli, Beth Collins, Jim
Cook, Dawn Del Guercio, Emrah Diril, Robert Dunn-Miller, Mark Fassett, James Galiano, Aaron
Gravvat, Gary Ingraham, Wesley Jones, Joan Korte, Heather Kuhn, Jim McGowan, Dave McRobie,
Steve Martinez, John Mihnos, Andrew Mitcham, Leslie Moore, Rich O'Brien, Val Peever, Terry
Rickman, James Salyers, Rich See, Julie Smith, Russell Starner, Renger van Nieuwkoop, Ken Virapen,
Bill Watkins, Arthur White, Tenzin Yonten

The Journal 5 translators:
Baryshnikov Kirill (Russian)
Matthias Nagel (German)

Special Thanks from The Journal 4

My hat is off to Sergey Tkachenko, developer of the TRichView components. The Journal 4 owes a lot
to what Sergey has made possible.

The Journal 4 testers: Brett Allen, Rob Barrett, Patricia Campbell, Trudi Champion, Jim Cook, Kathy
Dunham, Laurie Engle, Laura Federico, Gary Filipski, Len Flier, M. Hamilton, Patricia Harris, David
Hollingworth, Peter Hollyer, Floyd Johnson, Lily Labrecque, Patrick S. Lewis, Michael Lowe, Raphael
Love, Jerry McKee, Kevin McKenzie, Gerard Montigny, John Murphy, Noelle Neuwirth, Craig Nicol,
Oskar Ortiz, Tom Plunket, Cindy Rasmussen, Kenneth S. Rhee, Lisa Smith, Brenden Stallard, Steve
Sutton, Andrew Wray, Mel Yow, Stephen Zeoli

Special Thanks from The Journal 3

I would also like to thank Alexis Balmont-Aoutine, Tony Costanzo, Gary L. Filipski, Brian Ford, Pete
Hollyer, Allen Johnson, Floyd Johnson, Sheila Perry, Tom Plunkett, and Julie W. Smith for their help
with testing the initial release of The Journal 3.

Special Thanks from The Journal 1.x and 2.x

Many thanks to Steve Kellock, Marty Brown, Andrew Williams, Sylvia Lutnes, Lance Perry, Ken
Marineau, Matej Trampus, Edmo Abreu Mendes Filho, Bernard Beam, Chris Victor, Gary L. Filipski,
John R. Hutchings, and Alexis Balmont-Aoutine.

2.6 Buy The Journal

Click Here to Buy The Journal! (only $44.95)

Benefits of Buying The Journal

Keeping a daily journal has never been easier! The Journal always knows what day it is, and
automatically organizes your entries by day, month and year.

Get organized! With The Journal's many options for categories and entries you can be as

http://www.davidrm.com/thejournal/buy/
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organized as you want to be. Keep your  personal journal separate from your work notes, or your
dreams separate from your correspondence--but only if you want to.

Do it Your Way! The Journal has no "agenda"--except to be as useful as possible. Use any
journaling technique or writing style you want, even none at all. It's completely up to you.

The Journal Newsletter! Sent out monthly, The Journal Newsletter provides tips for using The
Journal, articles about journaling and writing, writing exercises, and more.

FREE bug-fixes and feature updates! All releases of The Journal 6, whether simple bug-fixes or
major updates, are FREE! *

FREE technical support via email! I've tried to make The Journal as easy to use as possible, but if
you have any problems, questions, or suggestions, don't hesitate to email DavidRM Software!

* Some releases of The Journal may include modules that must be purchased separately. However, if
these releases also include bug-fixes or other new features, these will be available free of charge.

For pricing information, including special upgrade rates, see The Journal Pricing.

How to Buy the Journal via the World Wide Web

Click Here to Buy The Journal!

Your payment will generally be processed and your Registration Keys emailed to you within 24 hours.

How to Buy the Journal via "Snail" Mail

Print The Journal Order Form, fill it out, and send it along with your payment to:

DavidRM Software
7018 East 78th Place
Tulsa, OK 74133

Please make checks and money orders payable to David Michael.

If you include your email address, you will receive the Registration Keys much quicker. Otherwise, your
Registration Keys must be mailed back to you.

Please allow 10-15 business days for the payment to arrive and be processed.
All payments are processed the business day they are received.

2.7 The Journal Pricing

The Journal 6 (Download) $44.95
The Journal 6 on CDROM (Download + CDROM) $59.95
The Journal 6 Complete (Download + CDROM) $89.95

Amounts are in US Dollars.

Click Here to Buy The Journal!

Discounts Available

http://www.davidrm.com/thejournal/newsletter/
mailto:support@davidrm.com
http://www.davidrm.com/thejournal/buy/
http://www.davidrm.com/thejournal/buy/


The Journal Information 19

© 1996-2014 by David Michael

The following discounts are available:
Student
Teacher/Educator
US Military (active duty and veterans)
US Law Enforcement
Firefighter/EMT/Nurse
Senior Citizen
Hardship

To purchase The Journal using one of these discounts, contact DavidRM Software.

Upgrade Pricing

People who have purchased any previous version of The Journal are eligible for special upgrade
pricing.

The Journal 6 Upgrade$19.95

To receive your The Journal 6 Upgrade Coupon Code, you must submit your full name, mailing
address, and date of purchase to DavidRM Software (support@davidrm.com).

Your Upgrade Coupon Code will be emailed back to you within 24 hours. Enter this code when you
purchase The Journal 6 and you will receive $25 off the regular price (a 55% discount).

Quantity Pricing

Quantity Price Per
1-9 $44.95

10-49 $39.95
50-99 $37.45
100+ $34.95

To purchase The Journal using Quantity Pricing, contact DavidRM Software.

2.8 The Journal Order Form

Print this page as an order form.

The Journal Order Form

Full Name
_______________________________
Email Address
_______________________________
Mailing Address
_______________________________
_______________________________
_______________________________
_______________________________

_____ The Journal 6 (Download) $44.95 US

_____ The Journal 6 on CDROM (Download + CDROM) $59.95 US

mailto:support@davidrm.com
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(Free Shipping to USA/Canada)

_____ The Journal 6 Complete (Download + CDROM)
Includes all available add-ons for The Journal.
(Free Shipping to USA/Canada)

$89.95 US

_____ The Journal Upgrade from any previous version
Upgrade Coupon Code:
____________________________

$19.95 US

NOTE: To receive your Upgrade Coupon Code for The Journal 6, email your full name, mailing
address, and date of purchase to: support@davidrm.com

Send payment to:

DavidRM Software
7018 East 78th Place
Tulsa, OK 74133

Make check payable to: David Michael

Please allow 10-15 business days for the payment to arrive and be processed.
All payments are processed the business day they are received.

2.9 Version History

v6.0.0.784 - Interim Update
Released 5 November 2014

Fixed
"List index out of bounds" error when viewing entry in Search Entries by Topic.
Batch Entry Import, Simple CSV format isn't recognizing time in the "Date+Time" column.

New
Now saving "Search Entries by Topics" options: "Display only topic text in search result" and "Include
sub-topics in search results".

v6.0.0.779
Released 21 October 2014

Fixed
If the Diaro entries aren't assigned to a folder, they aren't being imported.
TIFF images aren't inserting.
"The Journal Newsletter" page link is still pointing to the old URL.
Applying the highlighter to an item in a numbered list sometimes is resetting the list back to 1.
In User Preferences, on the Editor tab, can't enter a decimal (.) in Default Tab Width.
When applying a style with the option "Blend with active font styles" to a block of varied text, the font
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styles aren't being blended.
Active reminder list above entry editor for default entry sometimes a few pixels smaller than it should
be.
Default tab width not being updated after UI size is changed.

New
Added new spiral notebook background image colors: blue, gray, green, and pink.

v6.0.0.773
Released 15 September 2014

Fixed
Popup messages (errors, confirmations, etc) aren't being scaled in high DPI.
Diaro changed their export format. Again.
Even when multiple users in a Journal Volume are marked as "auto-login", only one of them is being
opened on startup.
When "Insert large images as thumbnails" option is checked, images imported from Evernote aren't
being inserted as thumbnails.
Multi-line image descriptions are displaying a "<br>" in the image viewer.

New
Updated MD5 hashing and TwoFish encryption components.
Importing from Diaro now includes photos, if the media\photo folder is available.
Added "The Journal Support Page" link to the Help menu.
When importing images, accommodate possibly misnamed files (example: PNG image files with .jpg
extension).

v6.0.0.767
Released 5 August 2014

Fixed
Clicking on a table cell is getting an "Index out of Bounds" error. (error introduced in Build #765)
When using "Paste as Text" with preserve images option, tables aren't being converted to text
properly.
Changed default for "When pasting as Plain Text, preserve images" (to false; again).

v6.0.0.765
Released 4 August 2014

Fixed
Changed default for "When pasting as Plain Text, preserve images" (to true).
When syncing from an export file, sub-categories aren't always automatically mapping.
When importing from an export file, sometimes reporting a conflict with a just-imported entry.
When skinning is active, category names with ampersands (&) are displaying an underscore on their
tab instead of the ampersand.
Pasted entry links aren't being detected and converted to hyperlinks.
Entry names and category names aren't allowed to include colons (:).
Sometimes pressing Ctrl and clicking on a link doesn't activate the link.
When pasting an entry link into the link editor, default tag should be the entry name.
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New
Search Results form now saves "Results per Page" setting.
Added "Paste as Text" to the editor context menu (right-click).
New option, "Highlight dates with entries on calendar".
Tweaked colors for month and year calendars.

v6.0.0.759
Released 30 June 2014

Fixed
Getting an error when using the highlighter tool on a table row.
Displaying borders of Journal Volume and User even when those tabs aren't visible.
Setting the background image of an entry not marking the entry as changed.
When inserting a to-do item (checkbox), sometimes getting a "Duplicates not allowed" error.
Clipboard Viewer not always displaying images in copied HTML.
Tables with borders set to "None" not displaying the dashed-line borders when editing.
Search results form displaying ampersand (&) as an underscore.

New
Updated database component.
New category option: "Show list of active to-do items" (displays list above entry editor)
New editor option: "When pasting as Plain Text, preserve images"
New option on Clipboard Viewer: "Paste as Plain Text"
Tweaked menu and toolbar colors for all skins.
Tweaked colors for day planner and monthly and yearly calendars.
Rearranged some items on the Entry menu, Topic menu, and entry tree context menu.
Added new background image/paper textures: Graph Paper, Lined Paper, Texture Paper (gray,
green, blue, lavender), and Old Paper.
Right-clicking any reminder (not just tasks) now offers the options to set the status (active, done,
skipped, cancel).
Added a zooming trackbar to WYSIWYG editor (lower right corner).
Added "Show Entry Preview" option to "Import Entries" form.
Added "Background Color" and "Background Image" commands to the entry editor's right-click menu.

v6.0.0.751
Released 2 June 2014

Fixed
When upgrading Journal Volumes from The Journal 5, sometimes running into a duplicate entry ID
which causes the upgrade to fail.
Changed defaults for Show Journal Volume tabs and Show User Names tabs options (to false).
Batch Entry Import of 750words file only importing the last entry in the file.

New
Updated skinning components.
Added "List of Keyboard Shortcuts" to Help menu.
Updated entry editor components (including WYSIWYG).
Updated database component.
Updated The Journal's Product License Information (now includes a "household license" for
individuals).
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v6.0.0.743
Released 31 March 2014

Fixed
On Batch Entry Import, changed list of available import file types to a drop-down list.
"Dictionaries" list on Spell Checker tab of User Preference sometimes too small to use.
Form for editing spell checker words added, autocorrections, and so on, displays incomplete on
some computers.

New
The Journal is now High DPI Aware.

v6.0.0.739
Released 3 February 2014

Fixed
Changed wording of Category, Calendar option "Only create new entries by request" to "Start on
latest entry by default".
Typo in "Paragraph Backgrounds & Border" command.
"Export Entries to Document..." isn't always exporting all selected entries.
View All Reminders incorrectly showing some past reminders as still active.
Search Entries result snippets could stand to be a bit longer.
"Update Entry Topics" should show progress more frequently.
Changed wording of "Apply <No Topic>" to "Clear Topic(s)".
User Preferences form is almost unusable when UI is set to largest setting (+100%).

New
New toolbar, menu, and entry tree icons.
Added Lotus Organizer CSV file support to Batch Entry Import.
Added Orange Diary Pro CSV file support to Batch Entry Import.
New calendar charm set: "Numbers/Letters Charms".
New option: "Display week numbers on calendar" (User Preferences, General tab).
In calendar categories, the folder for "Days" now has an "Entries" sub-tab that shows all entries for
that day.
New command "Copy Reminder" available when right-clicking reminders.
New option for when there is a missing Journal Volume on startup: "Ignore this warning"
Changed default view of image entries (to scaled-to-fit).
Image entries now bring up the Image Viewer on double-click.
Image entries now rotate JPEG images to the proper orientation on insert.
Image rotation and flip commands can now be performed on image entries.
View All Reminders form is now resizeable.
Added "Extra Large (+75%)" option to "User Interface Size" sub-menu.

v6.0.0.727
Released 6 January 2014

Fixed
In "Edit Topics", the hot-keys are not displayed.
When applying highlighting to a block of selected text, highlighting sometimes getting stuck on.
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On the yearly calendar view, the entry for 1 January is not showing its Calendar Charm.
750words changed their export format.
When using "Insert Date" or "Insert Time" in a paragraph, it is changing the paragraph to be left
justified.

New
Changed default (to true) for displaying word count in calendar categories.
Changed automatic image resizing to have just a single number (used for both width & height).
Changed default (to 1920) for automatic image resizing.
New Image Option: "Insert large images as thumbnails"
Changed "Toggle Image Full/Fit Window" to "Toggle Image Full/Thumbnail".
Changed double-clicking an image to bring up an image viewer.
Added "Page Break (RTF export)" options to "Export Entries as Document..."

v6.0.0.721
Released 4 December 2013

Fixed
Special Day reminder birthday/anniversary year display calculation not especially reliable.
"Import Journal Volume..." not always working when importing Journal Volumes from previous
versions.

New
Added "User Interface Size" sub-menu to View menu, with options for "Normal", "Large (+25%)",
"Larger (+50%)", and "Largest (+100%)".

v6.0.0.719
Released 4 November 2013

Fixed
Diaro changed their export format. Again.
When copying-and-pasting text with topics applied, the highlight colors on the text are being messed
up.
When applying multiple topics to the same block of text, not always seeing all topics in the flyover
hint.
When updating entries after editing a topic name, sometimes messing up the flyover list of applied
topics.
When typing the name of the font in the toolbar dropdown list, sometimes getting an "Index out of
bounds[-1]" error.
When cutting the selection in a table, sometimes getting an error.

New
"Apply Topic..." and "Tag Entry with Topic..." commands now default to typing in comma-separated
topic names.
"Apply Topic..." and "Tag Entry with Topic..." commands automatically create new topics.
Reminders set to display "Until Done or Canceled" or "N Days Before" now show a countdown of
days to or past the due date.
Updated skin/themes.
Added "Wrap Text on Right" and "Wrap Text on Left" to the Image context menu.
Automatic backups no longer prompt, they just happen.
Display the year of a birthday or anniversary reminder. (See Birthday in Special Days for more
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information.)
Changed "Insert CheckBox" command to "Insert To-Do (CheckBox)".
Added new report to "Entry Report Wizard": To-Do Item (CheckBox) Report.
Added "How to Use The Journal" link to Help menu.
If a template entry has a background image assigned to it, this background image is applied to the
active entry when inserting the template.
Added "BACKGROUNDIMAGE" attribute to <SECTION> tag in Enhanced Template Tags.

v6.0.0.709
Released 3 October 2013

Fixed
DayNotez changed their export format.
When editing table properties, cannot make table wider than 1000 pixels.
When The Journal is minimized via "Show the desktop" Windows command, it is not prompting for
password.
If The Journal is open overnight, sometimes not properly bringing up a new blank entry for the
current date+time.
Sometimes, when copy-and-pasting from a browser, getting an "Index out of bounds" error.
Pasting/downloading some images from the Web not always working.
"Go Back/Forward" commands still won't go to some hourly entries.

New
Updated Russian translation.

v6.0.0.705
Released 27 August 2013

Fixed
"Search active categories" option not being saved between searches.
Should be able to wrap text around media attachments.
When "Display Larger User Interface" is active, editing User Preferences causes the UI font to
become even larger.
In Edit Topics it's possible to make a topic a sub-sub-topic of itself.
In Search Entries by Topic, topics list should use all available space.
Sometimes getting "No duplicates allowed" when sync-ing from a Diaro export file.
When changing font face/color/size on a numbered/bulleted list, the numbers/bullets aren't being
changed.
Default link tag for entry links to calendar entries should include the entry title, if there is one.
Diaro changed export file format.

New
New feature: Doodling in Entries
Added "Insert Doodle" to the Insert menu.
Added "Doodle on Image" to the Image menu.
Added "Display Larger User Interface (+25%)" command to the View menu.
Added DayNotez support to Batch Entry Import.
Added "Save Image As..." command to save selected image to your hard drive.
Added "Save Media Attachment As..." command to save selected media attachment to your hard
drive.
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v6.0.0.693
Released 1 August 2013

Fixed
When editing a link in the entry editor, changes aren't being saved.
If the entry tree is resized to nothing, it cannot be resized again without restarting The Journal.
When editing a topic, if that topic is one of multiple topics applied to a block of a text, all of the other
topics applied to that block of text are being erased.
In Edit Auto-Replace Strings, tabbing from "replace this" to "with this" should select the contents of
"with this".
In Search Entries, under "Search Options", selected categories should be saved.
Sort Sub-entries command should prompt to ask about searching all levels of sub-entries (if there's
more than one).
"Go Back/Forward" commands won't go to hourly entries.
Restore from Backup form can be confusing if you want to restore into a new Journal Volume.
On "Modify Style" form, should say "Background Color" (instead of "Highlight Color").
When exporting (or printing), entries viewed in the preview panel are being locked.
Day planner view isn't supporting inclusive end effective date.

New
New option for Entry Report Wizard: Show entries from last n days
New Edit menu command: Select Paragraph
Video/audio attachments now use Windows Media Player for playback (if available).

v6.0.0.691
Released 10 June 2013

Fixed
After setting user preferences, active calendar category is resetting to the current date, regardless of
what date was active before (from #675).
Applying numbering should default to "continue numbering" instead of "restart numbering".
If a sub-topic has an invalid parent topic, clear the parent setting on login.
When clicking on the calendar to select a date, empty entries for other dates viewed should not show
up in the entry tree.
When The Journal is minimized and locked, hovering the mouse over the taskbar icon is displaying
the last active entry.
Loading JPEG images in "User Images..." not working.
When moving between environments with multiple monitors, sometimes getting stuck off screen on a
monitor that isn't available.
When clicking on entry links in a table, sometimes getting an error.

New
New menu/UI translation: Armenian (View menu, Language sub-menu)
When using The Journal on a USB drive or over a network, save form positions separately for each
computer.

v6.0.0.675
Released 9 April 2013

Fixed
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Sub-topics (still) not always sorting properly in tree display.
Non-task reminders set to display N days before are continuing to display past their due date.
If a category's default entry template is no longer valid, clear the setting.
Drop-down list of styles is always showing the user default style, even if the category has overridden
the user default style.
During an import or sync, when displaying entry text to resolve a conflict, display the number of
words in each entry.
The running word count is sometimes getting out of sync when an empty paragraph is deleted.
Search Results should include the first line of the entry if that category option is set.

New
New option "Display user interface larger (+25%)"
New feature: When inserting JPEG images with orientation information in the ExIf, the image is
rotated (losslessly) to match the specified orientation.
New image commands: Rotate Image Right, Rotate Image Left, Rotate Image 180 degrees, Flip
Image Horizontally, Flip Image Vertically

v6.0.0.669
Released 12 February 2013

Fixed
Format Painter isn't working.
There is an issue marking tasks due on a future date as "Done".
A recurring reminder that is set to display "N Day(s) Before" is always displaying.
When closing from user unlock form, allow the backup prompt.
Editing a link on a bulleted/numbered list is setting the bullet/number to the same font color as the link.
Need to detect the possibility that a Journal Volume is already open in another running instance of
The Journal (useful for when the Journal Volume is on a cloud drive and might be accessed from
multiple computers simultaneously).
In a multi-user environment, try for 3 seconds before reporting that the database is busy.
Sometimes getting an error if minimizing when timer is active.
If the entry tree is focused and the active entry has text selected, pressing DEL should delete the
selected text.
When comparing entries during import, if both entries have a table with the same number of columns,
but the number of rows is different, getting an error.
The entry tree context menu should remove non useful items when multiple entries are selected.

New
New global option: "When The Journal is inactive, mouse-click only activates"
New option for Batch Entry Import when importing entries from separate files: "Use file modified
date+time as entry date+time" (useful for importing from MacJournal)
New menu/UI translation: Spanish (View menu, Language sub-menu)
New Tools menu commands: "Count Words in Entry + Sub-Entries..." and "Count Words in Selected
Entries..."

v6.0.0.657
Released 11 December 2012

Fixed
A recurring reminder set to "always display" isn't always displaying.
When minimizing on idle, close open modal forms.
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Spell checker configuration on a USB drive isn't using a relative path.
"Sync from Export File..." menu command is disabled when there is only one Journal Volume.
Text snippet displayed in Search Results should be longer.
When upgrading from The Journal 5, spell checker configuration sometimes not updating fully.
When accessing a Journal Volume on an external drive on different computers, if the drive letter is
different, then getting "There is no disk in drive" error.
Search Entries isn't finding text with $, # or similar characters.
Journal Volumes aren't remembering the date of their last backup.
When opening The Journal after a Windows sleep/hibernation, sometimes getting an error.
Added new skinning option "Disable shadows under forms when skins are active".
Sometimes "hangs" when more than one Journal Volume is open at one time.
Sometimes main form title bar gets stuck off the top of the screen.
When using Insert Date or Insert Time in a numbered list, the number of the current list item is reset
to 1.
Sub-topics not always sorting properly in tree display.

New
Batch Entry Import support for Diaro app (text entries only).
New option for Batch Entry Import when importing entries from separate files: "Use file creation
date+time as entry date+time" (useful for importing from LifeJournal)
New option on Search Entries "Options" tab: Force re-indexing of all entries in categories searched

v6.0.0.635
Released 7 November 2012

Fixed
Using "Insert Link" shortcut (Ctrl+K) on an existing link should edit the link, not try to create a new
link.
Sometimes, inserting/editing a link, the link shows the proper formatting, but the link doesn't work.
User default style sometimes has extraneous (incorrect) font override flags.
"Apply Default Style" (with and without retain formatting) should affect links.
Links are not being detected when typing them into reminder notes.
Checkboxes in entries aren't printing.
When editing the name of an entry, cannot use DEL key to delete a character without selecting it
first.
After highlighting a typed link, resume the font formatting that was active before the link instead of
reverting to the category default.
You should be able to select a table, or a subset of a table's cells, and apply a topic.
Some changes to prevent "List index out of bounds (-1)." errors.
Reminder setting "Show Reminder xxx days before" is not working.
When renaming entries, the new name is not being properly indexed for searching.
Clicking "Close" on the user unlock form should force the close (ignoring the "Minimize on Close"
option).
Applying a topic to a table, or to cells in a table, sometimes not working properly.
Viewing topics in a table when doing a search by topic sometimes getting an error.
After startup, the idle timer minimized The Journal with the backup prompt active.
Search Entries should default to prefix searching, unless "match whole words" option is checked.
When changing a category with Category Properties, the active category's entry editor scrollbar
loses its skinning.

New
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New option for calendar categories: "Round time to 5 minutes"

v6.0.0.621
Released 26 September 2012

Fixed
After restoring from minimized, title bar displays only "The Journal 6".
Sometimes getting an error during the backup, though it doesn't affect the backup.
"Search Entries" is not searching linked/shared categories.
"Daily/Weekly Entry Report" is showing only the entry headers (with links) in the report, instead of
the full entry body.
When creating or editing reminders, the time pickers aren't displaying 24-hour time properly.
When auto-pasting from Clipboard Viewer, each paste should happen on a new line.
In the month and year calendar views, don't display the day planner or the reminder list above the
calendar.
In the month calendar, the reminders and entries for all visible dates should be displayed.
When searching entries with a date range, sub-entries of entries outside the date range are being
searched.
When importing calendar entries with sub-entries, the sub-entries aren't being imported.
Default auto-save interval should be 10 minutes.
External object entries and image entries not exporting properly to TJEXP format.
TJXML format needs to save date+time values with milliseconds.

New
New global option in User Preferences: "International character hot-keys override topic hot-keys".
New international hot-keys for: ß, æ, œ
Swapped hot-keys for Insert Link (now Ctrl+K) and Block Justify (now Ctrl+Shift+K).

v6.0.0.609
Released 6 August 2012

Fixed
The Journal is not remembering its maximized window state.
If The Journal's system database is closed when resuming from a sleep/suspend, close The Journal.
Dragging and dropping an image file into a table cell is sometimes causing an error.
When printing, images in a table cell aren't using the table cell dimensions to limit their resize, they're
using the whole page width.
When editing styles, applying the overrides to the sample text is causing confusion.
Possible issues pasting RTF from clipboard.
Double-clicking to toggle a large image resize-to-fit isn't marking the entry as modified.
When printing, images that have been resized by the user aren't using their adjusted size.
Importing html/xml not handling &apos; correctly.
Links in pasted text are not properly merging active font and link style.
When pasting HTML from Paste Special..., not using category/user default font.
Re-worded User Preferences, Editor option to "When pasting, Rich Text Format has priority over
HTML Format"
User Preferences, Editor option "Insert URL when pasting from Web pages" feature isn't working.
Getting gibberish when trying to paste into the timer.
In "Export Entries as Document", when exporting each entry to its own document, if there is more
than one entry for a date/time, only the last entry for that date/time is being exported.



The Journal30

© 1996-2014 by David Michael

Reminders aren't being searched by Search Entries.
Image entry and external object entry titles aren't being indexed for Search Entries.
Missing hot-keys for Insert Media File (M), Insert CheckBox (X), and Insert Symbol (Y).
Attempting to uninstall an add-on with Tools | Add-ons... causes an error.
Importing TIFF, TGA and a few other image formats is not working.
When importing from Evernote, spaces are getting lost between formatted text.
Additional fixes to importing HTML and XML.
"Lock All Password-Protected Categories" not properly locking sub-categories.
When upgrading a TJ5 Journal Volume, sometimes incorrectly detecting that TJ5 is running.

New
When importing from Evernote, you can now choose to import into any category (calendar as well as
loose-leaf).
When importing from Evernote or Penzu, the category you choose to import into is remembered and
used as the default on the next import.
Import to-do items from Evernote as checkboxes.

v6.0.0.597
Released 18 July 2012

Fixed
If the Journal Volume database exceeds 1GB, the backup fails.
Progress forms are sometimes getting lost behind modal forms, and the main form.
With skinning turned off, the next/prev entry buttons sometimes have the wrong images.
When the help file is open, clicking on the help icon on the taskbar doesn't bring up the help. Instead,
it brings The  Journal's main form forward, in front of the help.
Hiding The Journal with the hot-key while playing back audio or video causes errors.
Clicking on an image with a link sometimes behaving oddly.
Sometimes getting an error when reviewing image conflicts during sync.
"Sync from External Journal Volume" not working with TJ6 Journal Volumes.
If the indexed text search of a category generates an error, force a re-indexing of all entries in the
category.
Possible error when posting to Google Blogger.
Deleting entries could cause an error in Search Entries for that category.

New
Added "The Journal on Facebook" link to the Help menu.
Added "Journal Volume Integrity Check..." report to Maintenance sub-menu.

The Journal 6

v6.0.0.589 - Released 9 July 2012

June 2012: My mission statement for The Journal 6 was: "The Journal, Even Better!" I wanted to
make The Journal easier to use, while also adding some powerful new features like synchronizing and
indexed text searching. Work on The Journal 6 began in June 2011 while my wife and I were waiting for
our 3rd child to arrive. He was late, but was eventually induced to make his appearance. Which
appearance then seriously slowed The Journal 6 development for a while. :-)

The Journal 6 new features:
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Lightning-fast searches! Even if you have thousands of entries in hundreds of categories,
searching them is fast and easy.
Synchronize multiple copies of The Journal! Have The Journal on your laptop at work and your
desktop at home? Keeping them in sync is easier than ever. You can sync from another Journal
Volume, a backup file, or any of The Journal's export files.
Synchronize The Journal with your mobile- and tablet-based software! Import your entries and
notes from such products as Evernote, Penzu, and more. The Journal also supports exporting to the
Xml-based ATOM publishing format which can be imported by other products.
Use The Journal with automatic backup/sync-ing software! The Journal's new, single-file
database configuration is faster, takes up less space on your hard drive or USB/Flash drive, and
makes it much easier to use with products like DropBox.
More!

Improved printing, exporting, and importing!
New Entry Report Wizard (on the Tools menu), with new and improved reports!
Improved topic support and reporting!
Improved international character support, including Insert Symbol (on the Insert menu)!
More options for categories, including specifying the day the week starts and sorting options
for loose-leaf entries.
New entry editor options like linking images, a running word count on the status bar, improved
highlighting, and format painter.

The Journal 5.1

December 2009: The Journal 5.1 is a feature update and bug-fix of The Journal 5. Work on The
Journal 5.1 began in late October 2009. My goal for The Journal 5.1 was to add some of the features
that had been planned for the initial release of The Journal 5 but, due to time constraints, had been put
off to the future.

The Journal 5.1 fixes some bugs (see the list below), updates a few third-party components, and adds
some significant new features:

Improvements to skinning and more new skins! Many of the skins have been updated, including
The Journal's default skin (BlueBrilliant).
New toolbar icons for a number of commands, plus the option to use The Journal 4's icons for
toolbars, menus and the entry tree.
Localization support - As new language translations of The Journal become available, they will be
added.
Improvements for using The Journal over a network with multiple simultaneous users.
View your Outlook calendar reminders in The Journal!
Support for "Quick Blogcast" blog tool and new blog posting options.
And, finally, you can wrap text around images in your entries!

v5.1.0.497 - Released 11 April 2012
v5.1.0.489 - Released 14 February 2012
v5.1.0.481 - Released 14 November 2011
v5.1.0.469 - Released 8 August 2011
v5.1.0.461 - Released 6 June 2011
v5.1.0.453 - Released 24 January 2011
v5.1.0.451 - Released 27 December 2010
v5.1.0.435 - Released 4 October 2010
v5.1.0.427 - Released 10 May 2010
v5.1.0.417 - Released 3 March 2010
v5.1.0.409 - Released 27 January 2010
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v5.1.0.407 - Released 25 January 2010
v5.1 (v5.1.0.393) - Released 15 December 2009

The Journal 5

July 2009: My plan for The Journal 5, which began development in September 2007, can be summed
up as "The Journal Even Better". I wanted to improve all the major parts of The Journal--the database,
the internal data structures, the user interface--and provide more support for international users. Plus I
wanted to offer additional category and entry options, more reports and other tools, and, finally, to offer
a selection of "skins" for the user interface.

I think I achieved most of that--even if it took a bit longer than I expected.

In short, The Journal 5 is an inside-out redesign of The Journal, preserving all the great journaling and
writing features that have accumulated over the years and adding some cool new features and
capabilities.

The Journal 5 adds lots of significant new features:

Updated user interface:
Choose your favorite "skin" from the many, many available (180+).
Quickly switch between logged in users and open Journal Volumes with their (optional) tabs.

Updated Journal Volumes:
No more 2 GB limit. Store up to 128 GB in your Journal Volumes.
Have as many Journal Volumes as you want, all open at the same time.
Be more secure with the improved backup and restore features, with options to copy your backup file
to separate locations automatically.

More category options:
You can have categories that create new entries for you every century, decade, year, month, week,
day, and hour.
See a month or a year at a time with the new month and year calendar views.
Use the day planner to see your reminders for today or the whole week.
Automatically "stamp" your entries with current date and time.
Edit your entries with WYSIWYG (what-you-see-is-what-you-get) formatting.

More entry options:
Your calendar category entries can have loose-leaf sub-entry "attachments".
Drag and drop entries between categories with ease.
Select multiple entries and copy (or cut) them to the Windows clipboard--then paste those entries into
another category of The Journal or even into a word processor like MS Word.
Insert media files (audio & video) into your entries, and play them back within The Journal.
Take advantage of the new (optional) grammar checking features to automatically change i to I and
automatically capitalize the first word of a sentence.
Use topics to mark blocks of text within an entry, or to tag an entire entry.
Be even more organized with topics that have sub-topics (that have sub-topics, that have sub-
topics...).
Easily wrap text around inserted images.

More search options:
Automatically include sub-topics when searching by topics.
Search for multiple topics with either AND (all) or OR (any) logic.
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Search in reminder notes.
Limit your search to whole words.

And more:
See your MS Outlook calendar reminders in The Journal.
Export your categories and entries to HTML and get a Web-page-like list of categories and entries.
Create a wiki-like set of entries with automatically updated links.
Run a report of those entries that you've created or updated in the last week, month, year or other
date range.
Post to Blogger (Google) without getting an annoying error message (and lots of other minor fixes and
changes).

v5.0.0.367 - Released 5 October 2009
v5.0.0.359 - Released 21 September 2009
v5.0.0.355 - Released 9 September 2009
v5.0.0.347 - Released 31 August 2009
v5.0 (v5.0.0.341) - Released 26 August 2009

The Journal 4.1

(March 2006 - August 2009)

March 2006: Though not a major upgrade like the one from v3 to v4, The Journal 4.1 is still a significant
step forward. Reminders & Tasks have now been added to The Journal, supplying whole new ways you
can use The Journal to organize your life and life's work. Set reminders for daily tasks, monthly
appointments, special days and anniversaries, and more! And with the new entry locking features for
shared categories, The Journal edges closer to becoming a true multi-user, maybe even a collaborative,
platform. I look forward to building on all of the 4.1 additions and changes as The Journal continues to
grow.

August 2007: The last major new feature added to The Journal 4.1 was the option to have multiple
entries on a given date. Such an obvious feature (in retrospect), and yet added so late. I'm always
surprised by how The Journal continues to evolve.

v4.1.0.253 - Released 5 February 2008
v4.1.0.247 - Released 10 December 2007
v4.1.0.241 - Released 15 October 2007
v4.1.0.239 - Released 9 October 2007
v4.1.0.237 - Released 4 September 2007
v4.1.0.231 - Released 13 June 2007
v4.1.0.229 - Released 11 June 2007
v4.1.0.219 - Released 8 May 2007
v4.1.0.213 - Released 23 April 2007
v4.1.0.207 - Released 19 February 2007
v4.1.0.195 - Released 4 December 2006
v4.1.0.189 - Released 2 October 2006
v4.1.0.181 - Released 12 June 2006
v4.1.0.177 - Released 26 April 2006
v4.1.0.175 - Released 17 April 2006

The Journal 4

(November 2004 - March 2006)
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August 2004: Though the story of The Journal 4 lacks the drama of The Journal 3's grueling
development period, it's an important upgrade nonetheless. Built on the foundation created in v3, v4
takes The Journal to new levels of power and ease of use.

Work on The Journal 4 began in December 2003, with early efforts centered on switching from using
the Windows Rich Text Common Control to the very powerful TRichView components created by
Sergey Tkachenko. This was a huge change, both in source code and in philosophy, because The
Journal was originally built around the rich text edit, and probably would not have existed except for that
feature of Windows 95. After years spent tweaking and cajoling (and cursing) the rich text edit to get it
to do things that Microsoft probably never meant for it to do, I suffered a few withdrawals. However, this
one change, by itself, made possible a large portion of The Journal 4's new features, including
background images for entries, print preview, tables, and on and on. So I'm past the withdrawals now,
and not looking back.

With the new entry editor in place, I shifted to adding numerous other features that users have asked
for over the years, such as n-depth category nesting, user-created Calendar Charms, and daily/weekly
reporting. Beyond user requests, there were other extensions that I wanted to make, such as the ability
to install and run The Journal on read-only CDROM's, that would make The Journal more stable overall
and useful in new arenas.

By late August 2004, I had implemented the last of the planned additions and on 1 September I handed
The Journal 4 over to a small group of testers. There's nothing like user testing to help smooth out a new
interface and add the necessary polish to new features--and point out the obvious features and
extensions you somehow forgot.

The Journal 4 added:

A more modern look-and-feel  
Improved editing capabilities, including:  

Background images for entries  
More powerful and more flexible text styles  
Improved image handling (faster saving and loading, resizing, and more)  
Tables  
HTML importing and improved HTML exporting  
Paragraph borders and background colors  
Outline mode  
Improved bullets and numbering  
Improved auto-replace, supporting both formatted and unformatted text  
Assigning topics to blocks of text within an entry  

Improved printing, including print preview  
Improved searching, with:  

Google-like results presentation, with excerpts of found text and links to the found entries  
Search text highlighting in found entries  
Date range limiting for standard categories  
Searching by topic, or by image description  

Daily/weekly/etc "reporting" for standard categories, with printing  
Support for user-created Calendar Charms and entry background images  
Improved blog support, with posting of images (if the blog supports posting images)  
Web page "archiving" within entries  
Improved arranging of loose-leaf entries and categories  
Improved category "nesting", so you can have sub-categories of sub-categories of sub-categories
of...  
New category options likes "Read Only" and "Folder Only"  
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The ability to install and run The Journal on self-contained, removable media, like a USB flash drive or
CDROM  
Improved database speed and security  

v4.0.0.163 - Released 6 December 2005
v4.0.0.161 - Released 24 October 2005
v4.0.0.157 - Released 26 September 2005
v4.0.0.153 - Released 29 August 2005
v4.0.0.147 - Released 20 July 2005
v4.0.0.145 - Released 13 July 2005
v4.0.0.141 - Released 11 April 2005
v4.0.0.137 - Released 2 February 2005
v4.0.0.135 - Released 24 January 2005
v4.0.0.133 - Released 29 December 2004
v4.0.0.127 - Released 8 December 2004
v4.0.0.123 - Released 2 December 2004
v4.0 - Released 29 November 2004

The Journal 3

(November 2001 -  November 2004)

(November 2001): The Journal 3 is a complete re-design and re-write of The Journal, incorporating
years of accumulated feedback and suggestions. Since The Journal was first released in 1996, users
have sent in their suggestions for features and extensions. As much as possible, these suggestions
were incorporated. But some suggestions were beyond what the original design of The Journal could
tolerate. There was only so far that The Journal's feature set could be stretched without starting over
from scratch.

Begun in the summer of 1999, development on The Journal 3 proceeded slower than expected. Those
initial delays were caused by several factors. I was (and still am) co-owner of another software
company (Samu Games, http://www.samugames.com) and other projects came up that stalled the
development of The Journal 3. Plus there was the ever-present need to support the current version of
The Journal. By the end of 1999, only The Journal 3's new database configuration was completed.

In 2000, two major projects with Samu Games prevented significant work on The Journal 3. The Journal
2.3 was released in early 2000, and The Journal 2.4 was begun in the fall of the year. Though the 2.3
release was a relatively straightforward update of The Journal 2.2. The 2.4 release incorporated some
of the features that had been designed for The Journal 3. New word processing features (like numbered
lists and multi-level undo), improved image handling, and especially the new export/import format were
all from work done for The Journal 3.

Most of the work on The Journal 3 that occurred during 2000 was on the new user interface. There was
a lot of experimentation with new layouts, new configurations, and new ways of representing the
categories and entries in the database. Some of it worked, and was kept. A lot of it, though, proved "iffy
at best" and was discarded (or turned into a "user preference", default off).

In March 2001, following the release of The Journal 2.4, I realized that I had spent too much time on
"research and development". If I expected to release The Journal 3 in this lifetime, I was going to have
to stop thinking up new features to add and experiment with. So the feature set of The Journal 3 was
"frozen", and I began working on getting The Journal 3 done.

Interestingly enough, while The Journal 3 already sported quite a few features that The Journal 2.x
would never be able to duplicate, The Journal 2.x had many more features that had not yet been

http://www.samugames.com
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implemented in The Journal 3. So to get The Journal 3 "done" I had to get all of the existing 2.x features
working in the new version. Everything from simple options like "minimize to system tray" to more
complex features like entry templates had yet to be added to The Journal 3.

This turned out to be the single largest effort in the development of The Journal 3. The Journal had
accumulated quite a few features in its 5+ years, and re-doing them for The Journal 3 proved to take
more time than I estimated. In August 2001, 6 months later, the last of the 2.x feature set was finally
added to The Journal 3.

In September 2001, The Journal 3 was handed over to a small number of volunteers to see how it would
stand up. With their help, most of the bugs and issues were found and either fixed or resolved. The last
bit of testing and polishing occurred when The Journal 3 "pre-release version" was made available in
mid-November.

The Journal has already grown beyond my original vision for the project. I'm excited to see what new
directions the product will head in the future.

2004 Afternote: The Journal grew significantly after the initial release of v3. Here's a list of the major
improvements and features added to The Journal 3 from November 2001 to October 2004:

Improved printing  
Improved "Search Entries..."  
Improved entry navigation  
Improved entry templates  
Improved initial defaults for new users  
Improved entry export and import  
Improved user interface, including lots of new hot-keys  
Improved entry links and internet links  
Improved database maintenance  
Improved documentation  
Calendar Charms  
Add-on package support  
MemoryGrabber add-on package  
Writing Prompts 1 add-on package  
Blog support  

v3.0.0.73   -Released 19 January 2005
v3.0.0.71   -Released 22 September 2004
v3.0.0.67   -Released 13 July 2004
v3.0.0.65   -Released 13 April 2004
v3.0.0.63   -Released 6 April 2004
v3.0.0.61   -Released 10 February 2004
v3.0.0.59   -Released 29 December 2003
v3.0.0.57   -Released 15 December 2003
v3.0.0.51   -Released 6 October 2003
v3.0.0.49   -Released 15 July 2003
v3.0.0.47   -Released 9 July 2003
v3.0.0.45   -Released 10 April 2003
v3.0.0.43   -Released 24 February 2003
v3.0.0.41   -Released 9 December 2002
v3.0.0.39   -Released 26 August 2002
v3.0.0.35   -Released 2 April 2002
v3.0.0.33   -Released 18 February 2002
v3.0.0.31   -Released 12 February 2002
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v3.0.0.27   -Released 6 February 2002
v3.0.0.25   -Released 4 February 2002
v3.0.0.23   -Released 7 January 2002
v3.0.0.21   -Released 17 December 2001
v3.0.0.19   -Released 3 December 2001
v3.0      -Released 28 November 2001

The Journal 2

(September 1998 - October 2001)

The Journal 2.0, released in September 1998, built on the feature set that had been finalized in the 1.51
release. More word-processing and security features were added, and database maintenance and
stability were greatly enhanced. Throughout the 2.x series of releases, The Journal continued to mature,
though not at the same pace as before. Refinement and extension replaced a headlong rush to add new
features. The 2.4 release of The Journal, coming nearly a year after the previous release, was the most
significant of the 2.x updates after 2.0.

v2.43   - Released September 28, 2001.
v2.42   - Released August 20, 2001.
v2.41   - Released April 16, 2001.
v2.40   - Released February 9, 2001.
v2.30   - Released April 7, 2000.
v2.20   - Released December 6, 1999.
v2.11   - Released June 21, 1999.
v2.10   - Released April 5, 1999.
v2.02   - Released February 1, 1999.
v2.01   - Released November 11, 1998.
v2.00   - Released September 30, 1998.

The Journal 1

(October 1996 - August 1998)

v1.30 was the first shareware release of The Journal, made available in October, 1996. This was a
period of expanding features for The Journal. Hardly a month went by without a new release coming out
with more features--and bug-fixes for previously added features. This "growth spurt" period went on for
nearly a year before finally slowing down.

With the release of The Journal 1.5 in January, 1998, The Journal became a mature software product.

v1.51   - Released February 20, 1998.
v1.50   - Released January 30, 1998.

v1.44   - Released December 12, 1997.
v1.43   - Released September 26, 1997
v1.42   - Released July 19, 1997
v1.41   - Released July 1, 1997
v1.40   - Released June 28, 1997

v1.39   - Released June 7, 1997
v1.38   - Released March 23, 1997
v1.37   - Released February 9, 1997
v1.36   - Released January 12, 1997



The Journal38

© 1996-2014 by David Michael

v1.35   - Released December 29, 1996
v1.34   - Released December 13, 1996
v1.33   - Released November 25, 1996
v1.32   - Released November 15, 1996
v1.31   - Released October 14, 1996
v1.30   - First Shareware Release October 11, 1996

The Journal 1 - The Freeware Days

(June-September 1996)

The Journal started out as a quick project, mostly as a way to learn how to use Delphi. Fittingly, most of
the original users of The Journal were other Delphi programmers who downloaded it from the various
"Made in Delphi" web pages. Feedback from these and other users prompted me to extend The Journal
significantly, and release it as shareware.

v1.21   - Released August 12, 1996
v1.20   - Released August 9, 1996
v1.1   - Released July 8, 1996
v1.0   - Initial Release. June 18, 1996

2.10 What's New in The Journal 6

The Journal, Even Better!

More Convenience!

Synchronize multiple copies of The Journal! Have The Journal on your laptop at work and your
desktop at home? Keeping them in sync is easier than ever. You can sync from another Journal
Volume, a backup file, or any of The Journal's export files.

Click on the File menu, Import sub-menu, and choose one of the "Sync from ..." options.

Synchronize The Journal with your mobile- and tablet-based software! Import your entries and
notes from such products as Evernote, Penzu, and more. The Journal also supports exporting to the
Xml-based ATOM publishing format which can be imported by other products.

Export the entries from your other software, then click on the File menu, Import sub-menu, and
choose "Import Entries..." Browse to select the file you want to import.

Give your tired eyes a rest! Today's high-def displays (especially newer tablet displays) come with
tiny print that can be very hard to read. The Journal 6 includes new, easier-to-read toolbar icons, and
lets you see what you're typing!

Click on the View menu, open the "User Interface Size" sub-menu, and choose from "Large
(25% bigger)", "Larger (50% bigger)" and "Largest (100% bigger)".

More Power!

Lightning-fast searches! Even if you have thousands of entries in hundreds of categories,
searching them is fast and easy.
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Click on the Search menu and choose "Search Entries..." (hot-key: Ctrl+Shift+F).

Improved printing, exporting, and importing!

Improved topic support and reporting!

Improved international character support, including Insert Symbol (on the Insert menu)!

Improved image/photo support, including image rotation, thumbnails, and doodling (directly in the
entry or on other images)!

Improved media file support, with playback using Windows Media Player!

More options for categories, including specifying the day the week starts and sorting options for
loose-leaf entries.

New entry editor options like hot-linking images, a running word count on the status bar, format
painter, and improved text highlighting.

New Entry Report Wizard (on the Tools menu), with new and improved reports!

Improved Security & Stability!

Easily use The Journal with automatic backup/sync-ing software! The Journal's new, single-file
database configuration is faster and uses less space on your hard drive or USB/Flash drive, and
makes it much easier to use The Journal with products like DropBox.
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3 How to Use The Journal

Step 1. Getting Started

The first things you have to do after installing The Journal are create your first Journal Volume and your
login name and (optional) password.

Don't worry: Most users can just click right through these and use the default settings.

Step 2. Making Entries

Once you have your login name and password, you can run The Journal and start making entries and
printing entries. And since you almost certainly want more than text in your entries, this section shows
you how to  insert images and media filesinto your entries.

Step 3. Using Categories

The Journal automatically creates a "Daily Journal" category and a "Notebook" category for you. But
you aren't limited to just those. This section describes the difference between a calendar category and
a loose-leaf category, and shows you how to create a new category.

Step 4. Creating Additional Logins

Want your spouse to have his or her own login (with password) in The Journal? This tells you how to
create a new user login.

Step 5. Creating Additional Journal Volumes

One Journal Volume is enough for most users, but if you need more than one, this section tells you how
to create a new Journal Volume.

Step 6. Maintaining The Journal

Finally, this section gives you the basics of backing up your entries.

Also check out the Frequently Asked Questions.

3.1 Getting Started

The first time you start The Journal, the New User Wizard is run automatically to help you.
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Don't worry: Most users can just click right through these and use the default settings.

The most important part of this process is Creating your login name.

Once you've done that, you're ready to start making entries in The Journal.

3.1.1 Creating Your First Journal Volume

Unless you check the option "I would like to choose the location of The Journal's data files", The
Journal will handle this step for you automatically.

What is a Journal Volume?

A Journal Volume is an "entry database". The Journal Volume created during this step will hold your
login name, your categories, and all of your entries.

If you are unsure about the Journal Volume, simply accept the default settings by clicking on Next.

NOTE: The  default settings are recommended for most users.

Journal Volume Name

The default Journal Volume name is "My Journal". You can set this to be any name you want.
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The Journal Volumes Folder

The Journal Volumes folder is the path where your first Journal Volume will be created as a sub-folder.
If you later create additional Journal Volumes, they will also use this same base path.

The default path for the Journal Volumes folder is:
My Documents\The Journal Volumes\5\

If you are installing The Journal on a USB/external hard drive, the default path is relative to the installed
path:
.\The Journal Volumes\5\

See Journal Volumes for more information about Journal Volumes.

3.1.2 Creating Your Login Name

Your login name and password are how you access The Journal.

User Name

Your login name defaults to your Windows user name. You can change this to be any name you want
(and you can have as many login names as you want, each with their own categories and entries; more
about that here).

Password

Type in the password you want to use for this login name.

If you do not want a password, simply check the "I don't need a password" option. This gives you a
blank password and sets the Auto-Login option so you aren't prompted for a password when you login.

If you change your mind later, you can always give yourself a password by clicking on the User menu,
un-check the Auto-Login option and then choose Change User Password...

When you're ready, click on Next to continue. If you have chosen a password, you'll be asked to
confirm your password (type it in again exactly the same) before continuing.
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3.1.3 Confirm Your Journal Volume and Login Name

The last step is confirm your Journal Volume and login name.

If everything looks good, click on Finish.

This will create your Journal Volume and login name and log you in.

3.1.4 Installing Add-on Packages

If you purchased The Journal with add-on packages (like the MemoryGrabber, Devotional Prompts 1, or
Steve Pavlinas Templates) or chose to install any optional add-on packages (like My Address Book),
you will now be prompted to install those now.

Un-check any add-ons you don't want to install (you can always install them later by clicking on the 
Tools menu and choosing Add-ons...) and click on Install. Or click on Skip to install no add-ons at this
time.

Now you're ready to start making entries in The Journal.

3.2 Making Entries in The Journal

Creating entries in The Journal is easy.

Making Entries in "Daily Journal"

The "Daily Journal" category that is created for you automatically is a calendar category. You'll notice
that The Journal has created a single entry for the current date. You can type in this entry just as you
would a word processor or text editor.
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To create a new, blank entry for today, press F9 (or click on the Entry menu, find the Create New
Entry sub-menu and choose Create Entry: Document).

To create a past entry, simply click on a past date on the calendar. A new, empty entry will be brought
up for you. The entry is not added to the "tree" of dates below the calendar yet, because the entry is
empty. Once you begin adding text to the entry, then it will show up in the date tree.

As the days and weeks go by, your collection of entries will grow. In the tree of dates, your entries will
be organized by year and month.

Making Entries in "Notebook"

To the right of the entry editor, there is a collection of tabs. The active tab should say "Daily Journal".
The one next to it should say "Notebook". Click on that tab now to make it active.

The "Notebook" category is a loose-leaf category. Unlike "Daily Journal", entries in "Notebook" are not
tied to a date. Instead, the entries are named.

To create a new entry, click on the Entry menu, choose Create New Entry, and then Document (or
press F9). This will create a new document entry. Enter the name you want the entry to have and hit
ENTER. You now have a new loose-leaf entry following the first one in the tree.
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"Notebook Entry" is the default name of entries created in this category. To change the name of the
entry, click on the entry in the tree (or press F2). Then type in what you want to call the entry.

Press F10 ("Create New Sub-Entry") to create a new entry as a sub-entry of the current entry.

A loose-leaf entry can have as many sub-entries as you want. Loose-Leaf entries can also be
organized by dragging and dropping them in the tree.

Click on the second entry in the tree and "drag" it up to the first entry. Then release it. The second
entry is now a "sub-entry" of the first entry.

This gives you the basics of creating and using entries in The Journal.

For more information, see Entries.

3.2.1 Printing Entries

Once you have created entries in The Journal, a common task is to print those entries.

To print a single entry, bring up that entry. Then click on the File menu and choose Print (or press
Ctrl+P).

With "Active Entry" selected, click on "Print". That will print the currently selected entry.

Want to review the entry before you print? Click on "Preview".
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You can also print multiple entries, either from the same category or multiple categories. To do that,
click on "These Categories/Entries" and then select the categories and/or entries that you want to
print. Then click "Print".

For more information, see Printing.

To learn more about headers and footers, see Printing Headers and Footers and User Preferences:
Printing.

3.2.2 Inserting Images and Media in Entries

Your entries aren't limited to just text. You can insert digital photos, clip art, and even media like audio
and video.

Inserting Images

To insert almost any kind of image in your entries:
digital photos,
clip art,
any image of type JPG, PNG, BMP or GIF.

Click on this icon on the toolbar:

 
Or click on the Insert menu, and choose "Insert Image..."

You can also drag images from Windows Explorer and drop them into your entry.

By default, inserted images are positioned relative to the base line of the current entry text. You can
change this default, for example to be to the left of your entry text, in User Preferences: Editor Image
Options.

Inserting Media

You can also insert most types of audio and video files into your entries:
audio - wma, wav, mp3, mid, midi, ra, ram
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video - wmv, mpg, mpeg, avi, mov, rm

Click on this icon on the toolbar:

Or click on the Insert menu, and choose "Insert Media File (Audio/Video)..."

You can also drag images from Windows Explorer and drop them into your entry.

An attached audio file shows this icon:

An attached video file shows this icon:

NOTE: Some media files are very large. Media files larger than 10 MB will cause your entries to load
and save slower. Media files larger than 50 MB may not perform well when stored in The Journal.

Also note: The Journal relies on Windows for media file playback. If you are using Windows XP, it's
possible that not all types of media file listed above will play.

3.2.3 Other Entry-Related Topics

Besides printing and inserting images, you can also:
post your entries to a blog;
insert tables;
use images as backgrounds for your entries;
link entries together like a Wiki;
tag your entries with topics;
and more!

These topics are covered in detail in The Journal Reference section of this online help.

3.3 Using Categories

The Journal's categories provide a powerful tool for organizing your journaling, notes or other writing
projects.

The "Daily Journal" and "Notebook categories" are created for you automatically, but you are not limited
to just those. You can have as many or as few categories as you want. Every category has its own tab.

The Journal supports two kinds of category: calendar and loose-leaf.

Calendar Categories

Calendar categories can have entries for an hour, a day, a week, a month, a year--even for decades
and centuries. The "Daily Journal" category created for you automatically is a calendar category that
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creates a new entry for you every day.

Calendar categories automatically organize your entries for you into days, weeks, months, and years.
You can also view summaries of your entries in a monthly calendar, or a horizontal yearly calendar.

You can create an entry for any date: past, present or future. Any date, as far back or as far forward
as you want to go.

Don't worry about empty entries: The Journal doesn't store empty calendar entries.

Further, calendar categories can have loose-leaf sub-entries, just like a loose-leaf category.

Loose-leaf Categories

Loose-leaf categories are a collection of entries that are not tied to a particular date (as they are in
calendar categories).

Entries in a loose-leaf category are named documents, arranged by you, just like a loose-leaf notebook.
Loose-leaf category entries can be arranged in any order (just click-and-drag in the entry tree), and
entries can have sub-entries (which can have sub-entries, which can have sub-entries, and so on).

3.3.1 Creating a New Category

To create a new category, click on the Category menu and choose "Create New Category..."

Enter the name of the category you would like, then choose whether you want a calendar category or a
loose-leaf category. If you choose a calendar category, you will then have to specify how often you
want the category to create new entries.

When you click "Create", the new category is added to your collection of category tabs.

3.3.2 Editing Categories

To edit a category, right-click on the category tab and choose "Category Properties..."

Or you can click on the Category menu and choose "Category Properties..."
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You can edit the name of your category, its order in the tabs, even whether its tab is visible or not and a
whole lot more.

See Category Properties for more information.

3.4 Creating Additional Logins

When you first started The Journal, you had to create your first login name.

You can have, however, as many logins as you want: one for each project (for even more separation
than categories), one for each family member, one for work and one for home, and so on. Each login
can have its own password.

Create a New User

Click on the File menu and choose "Create New User..."

Every user must have a unique User Name. Every user must also have a password, or choose to have
no password (a blank password).

Once you click Next, and then Finish, the user will be created within the currently active Journal
Volume.



How to Use The Journal 51

© 1996-2014 by David Michael

3.5 Creating Additional Journal Volumes

When you first started The Journal, The Journal automatically created your first Journal Volume.

Like entries, categories and user logins, though, you can have as many Journal Volumes as you want.
Each Journal Volume is completely separate from every other.

Creating a New Journal Volume

Click on the File menu, find the Journal Volume sub-menu, and choose "Create New Journal
Volume..."

Every Journal Volume must have a unique name. This name is used to create a sub-folder for that
Journal Volume.

NOTE: It is not recommended that you change the base Journal Volume folder (displayed under Create
Journal Volume in this Folder).

Once you click OK, the Journal Volume is created.

The first time you open a Journal Volume, you will be prompted to create the first login name for that
Journal Volume.

3.6 Database Maintenance

The Journal's entry database has proven very stable over the years, but it is always a good idea to
make regular backups.

The Journal automatically prompts you to make a backup once a week (every 7 days). If you would like
to backup more or less frequently, you can set this using the Backup Settings.

How do I backup The Journal?

1. Click on the File menu, find the Maintenance sub-menu, and choose "Backup The Journal..."

2. Check to select the Journal Volumes you want to backup.

3. Click on "Start Backup".

See Backup Settings for more information.

How do I copy my backup file to another location?

Your Journal backup files can be automatically copied to another folder on your hard drive, to a
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network folder, to an external hard drive, or even offsite to an FTP server.

1. Click on the File menu, find the Maintenance sub-menu, and choose "Backup Settings..."

2. Under "Copy backup archive to these locations", add the folder(s) or FTP server you would like
your backup copied to.

For more information see Backup Settings.
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4 Frequently Asked Questions (FAQ)

Entries
How do I import my entries from Evernote, Penzu, Diaro, or WordPress?
How can I import my entries from another diary or journal program?
How do I insert images in my entries?
Can I insert digital photos in my entries?
How do I wrap text around pictures in my entries?
How can I use tables in my entries?
How do I make my tables look like those in MS Word/WordPerfect/Etc?
How do I use topics in my entries?
How do I lock my entries so they can't be edited?
How do I post my entries to a blog?
How do I use templates in my entries?
How do I have a template automatically inserted in my entries?
How can I create my own templates?
Why can't I edit my past entries?
How do I create loose-leaf entries in my calendar category?
How many entries can The Journal hold?

Printing
How do I set the printer margins?

Categories
What is a "category"?
What is a "calendar category"?
What is a "loose-leaf category"?
How do I set a category's default font?
How do I create a new category?
How do I delete a category?
How do I put the category tabs on top (instead of on the right)?
How do I see how many entries are in a category?

User Interface
I lost my password. How do I reset my password?
How can I customize the look of The Journal (change the skin)?
How do I customize the toolbars?
What is the hot-key (keyboard shortcut) for...?
How do I make The Journal 5 look like The Journal 4?
Can I use voice-recognition software with The Journal?

Journal Volumes
What is a Journal Volume?  
How do I synchronize 2 Journal Volumes?
How do I move The Journal to a new computer?
How do I install The Journal to a USB/Flash drive?
How do I use The Journal on a Network?
What is the size limit on a Journal Volume?

Export/Import
How can I import my entries from another diary or journal program?
How do I synchronize 2 installations of The Journal?
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Database Maintenance
How do I backup The Journal?
How do I copy my backup file to another location?
How do I restore from a backup?
How do I see what is in my backup file?
How do I restore just one category from a backup file?

Security
How do I set/change my password?
How do I get rid of my password?
What is Extended Security?
What kind of encryption does The Journal use?

Upgrading
Will The Journal 5 upgrade my categories and entries from The Journal 4 (or earlier)?
I am a registered user of The Journal 4 (or earlier). What is the upgrade price for The Journal 5?
How do I make The Journal 5 look like The Journal 4?

Glossary

Your question not here? Feel free to ask! Click here to email DavidRM Software.

4.1 FAQ: Entries

How can I import my entries from another diary or journal program?
How do I insert images in my entries?
Can I insert digital photos in my entries?
How do I wrap text around pictures in my entries?
How can I use tables in my entries?
How do I make my tables look like those in MS Word/WordPerfect/Etc?
How do I use topics in my entries?
How do I lock my entries so they can't be edited?
How do I post my entries to a blog?
How do I use templates in my entries?
How do I have a template automatically inserted in my entries?
How can I create my own templates?
Why can't I edit my past entries?
How do I create loose-leaf entries in my calendar category?
How many entries can The Journal hold?

How do I insert images in my entries?

Click on this icon on the toolbar:

 
Or click on the Insert menu, and choose "Insert Image..."

You can also drag-and-drop images into your entry using Windows Explorer.

By default, inserted images are positioned relative to the base line of the current entry text. You can
change this default, for example to be to the left of your entry text, in User Preferences: Editor Image
Options.

mailto:support@davidrm.com
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Also see: Using Images in Entries and How do I wrap text around pictures in my entries?

Can I insert digital photos in my entries?

Yes. You can insert just about any kind of image into The Journal, including digital photos (which are
most often compressed JPEG images: *.JPG).

Keep in mind, however, that digital photos larger than 3-4 megapixels (MP) may take a noticeable
amount of time to save and load. The more photos in the entry, the longer it will take to load. So you
may want to crop and/or reduce digital photos of 6+ MP before inserting them. Feel free to experiment
and see what works best for you.

The Journal's Automatic Image Resizing feature can help with inserting digital photos into entries.

How do I wrap text around pictures in my entries?

1. First, you insert the image, picture or digital photo as described above.

2. Click on the image to select it.

3. Right-click the image and choose "Edit Image/Object Properties & Layout".

4. Bring up the "Layout" tab.

5. Under "Vertical Alignment", choose the "Align" you want:
left side  <-- the image will be on the left side, the text wrapping on the right
right side <-- the image will be on the right side, the text wrapping on the left

6. Under "Spacing", you can put a little "white space" around the image, so the text doesn't run right up
to it. I like: 5

7. Click on OK.

How can I use tables in my entries?

To insert a table, click on this icon on the toolbar:

Or click on the Insert and choose "Insert Table..."

See Using Tables.

How do I make my tables look like those in MS Word/WordPerfect/Etc?

You can give your tables the single-black-line border used in most word processors by adjusting the cell
spacing and turning off the table's border.

1. Select the table.
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2. Click on the Table menu and choose "Table Properties..."

3. Click on More... (next to Cell Spacing).

4. Un-check Equal Values.

5. Change the Horizontal and Vertical values for Between Cells to: -1

6. Change the Horizontal and Vertical values for From Table Border to Cells to: 0

7. Click on OK.

8. Click on Table Border...

9. Under Border Type click on None.

10. Click on OK.

11. Click on OK.

How do I use topics in my entries?

See Using Topics.

How do I lock my entries so they can't be edited?

You can make any entry "read only", to prevent changes to that entry.

1. Select the entry you want to lock.

2. Click on the Entry menu and un-check "Lock/Unlock Entry" (hot-key: F4).

You will see "Locked" displayed on the status bar below the entry.

You can edit the entry again by repeating that procedure. F4 toggles locked/unlocked status.

You can make all past entries in a calendar category locked automatically by checking the option in the 
Calendar tab of the Category Properties.

How do I post my entries to a blog?

See Using a Blog.

How do I use templates in my entries?

To insert a template in an entry:

1. Click on the Insert menu, and bring up the "Insert Template" sub-menu.

2. Choose the template to insert, and the text from that template will be inserted in your entry.
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How do I have a template automatically inserted in my entries?

1. Right-click on the category tab and choose Category Properties...

2. Bring up the Entry tab.

3. Select the Default Entry Template from the available drop down list of templates.

The selected template will be inserted into new entries. For calendar categories, this template will be
inserted into new entries for the current day. For loose-leaf categories, the template will be inserted into
all newly created entries.

How can I create my own templates?

See Creating Simple Templates and Creating Enhanced Templates.

Why can't I edit my past entries?

In your category, past entries may be set to be locked. You can override this by clicking on the Entry
menu and choosing "Lock/Unlock Entry" (or pressing the hot-key: F4).

You can also change the category setting so that all past entries edit-able:

1. Click on the Category menu and choose "Category Properties..."

2. Bring up the Calendar tab.

3. Un-check the option: "Automatically lock past entries"

How do I create loose-leaf entries in my calendar category?

To create a sub-entry of a calendar entry (or a loose-leaf entry): Press F10

To create a new, root-level loose-leaf entry: Press Shift+F9

How many entries can The Journal hold?

You can have a maximum of just over 2 billion entries in a Journal Volume.

4.2 FAQ: Printing

How do I set the printer margins?

To set the printing margins:

1. On the User menu, click on "User Preferences..."

2. Bring up the Printing tab.
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3. Click on "Edit Default Page Setup".

4. There you can set the margins to how you want them, and click "OK" when you're done.

Those settings will be used every time you print, unless you override them at the category level.

4.3 FAQ: Categories

What is a "category"?
What is a "calendar category"?
What is a "loose-leaf category"?
How do I set a category's default font?
How do I create a new category?
How do I delete a category?
How do I put the category tabs on top (instead of on the right)?
How do I see how many entries are in a category?

What is a "category"?

Categories are a powerful way to organize your entries in The Journal. The Journal creates three
categories for you automatically: "Daily Journal", "Notebook", and "Templates". Each category has its
own tab, making it easy to switch back and forth. You can create as many categories as you want.

"Daily Journal" is a calendar category which creates a new entry for you every day, and organizes
those entries into months and years for you.

"Notebook" is a loose-leaf category. Entries in a loose-leaf category are not tied to a specific date.
Instead, they are like named documents that you can arrange any way you want.

For more information, check out Calendar Categories and Loose-leaf Categories.

What is a "calendar category"?

Calendar categories can have entries for an hour, a day, a week, a month, a year--even for decades
and centuries. The "Daily Journal" category created for you automatically is a calendar category that
creates a new entry for you every day.

Calendar categories automatically organize your entries for you into days, weeks, months, and years.
You can also view summaries of your entries in a monthly calendar, or a horizontal yearly calendar.

You can create an entry for any date: past, present or future. Any date, as far back or as far forward
as you want to go.

Don't worry about empty entries: The Journal doesn't store empty calendar entries.

What is a "loose-leaf" category?

Loose-leaf categories are a collection of entries that are not tied to a particular date (as they are in
calendar categories). Instead, entries in a loose-leaf category are named documents, arranged by you,
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just like a loose-leaf notebook.

Loose-leaf category entries can be arranged in any order (just click-and-drag), and entries can have
sub-entries (which can have sub-entries, which can have sub-entries, ...).

How do I set a category's default font?

You can use any Windows font (TrueType or Type-1) for your entries.

To set the default font used by a category:

1. Click on the Format menu and choose "Change Default Font for [category name]".

If you want to change the default font for all categories, you need to change your user default font:

1. Click on the User menu and choose "Change User Default Font".

How do I create a new category?

1. Click on the Category menu and choose "Create New Category..."

2. Choose a name for your category (example: "Dreams").

3. Pick a category type, Calendar or Loose-leaf.

4. If you are creating a calendar category, you will need to choose how often you want a new entry:
Every 1-12 hours,
Every day,
Every week (on a particular weekday),
Every month (on a particular day), or
Every year, decade, or century (if you're writing a history)

5. If you would like the new category to be a sub-category, choose the category that the new category
will be under.

When you click on "Create", your new category will be created and you will be able to click on its tab
and start making entries immediately.

Learn more about The Journal's categories here: Categories

How do I delete a category?

1. Right-click on the category tab, and choose "Category Properties..."

2. Select the category to delete from the list of categories.

3. Click on "Delete Category".

NOTE: Deleting a category also deletes all of the entries in that category, as well as any sub-categories
(and their entries). Deleting a category cannot be undone. You would need to restore from a backup to
recover a deleted category.
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How do I put the category tabs on top (instead of on the right)?

1. Click on the User menu and choose "User Preferences..."

2. On the "General" tab, un-check the option: "Arrange category tabs on right"

How do I see how many entries are in a category?

Click on the Category menu and choose "Category Statistics..."

4.4 FAQ: User Interface

I lost my password. How do I reset my password?
How can I customize the look of The Journal (change the skin)?
How do I customize the toolbars?
What is the hot-key (keyboard shortcut) for...?
How do I make The Journal 5 look like The Journal 4?
Can I use voice-recognition software with The Journal?

I lost my password. How do I reset my password?

Most lost user passwords and category passwords can be reset.

Email DavidRM Software and request a password reset code.

You will be sent a password reset code and instructions for how to use it.

NOTE: Users who have activated Extended Security cannot have their passwords reset. That is one of
the features of Extended Security.

How can I customize the look of The Journal (change the skin)?

There are a lot skins for you to choose from, which you can easily change as your mood or style takes
you.

Click on the View menu and choose "Change Skin/Theme..."

You can also change the skin--or turn off skinning--of The Journal in User Preferences (on the User
menu), on the "Global" tab, "Skinning" sub-tab. Note that if you turn skinning off (or back on), that
you will need to close and restart The Journal.

How do I customize the toolbars?

Right-click on the menu or toolbar that you want to customize, and choose Customize. This will open
up a form which contains all available menu and toolbar commands.

Bring up the Commands tab.

mailto:support@davidrm?subject=I need a Password Reset Code for The Journal
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Click on the commands you want and drag-and-drop them on the menu or toolbar where you want them
to appear.

In addition, all toolbars, as well as the main menu, can be undocked and be floating at any position on
your screen. Mouse over the far left of each toolbar until the four directional cursor appears, then left-
click and drag the toolbar to the position you’d prefer.

What is the hot-key (keyboard shortcut) for...?

All hot-keys are listed here: Keyboard Shortcuts

Can I use voice-recognition software with The Journal?

Yes, The Journal can be used with most voice-recognition software (VRS).

When you use VRS with The Journal, it's recommended that you turn off a couple of features:
"Check spelling as you type"
"Correct spelling errors as you type"

Both of these features can be turned off on "Spell Checker" tab of "User Preferences" (on the User
menu).

4.5 FAQ: Journal Volumes

What is a Journal Volume?  
How do I synchronize 2 Journal Volumes?
How do I move The Journal to a new computer?
How do I install The Journal to a USB/Flash drive?
How do I use The Journal on a Network?
What is the size limit on a Journal Volume?

What is a Journal Volume?

A Journal Volume is an "entry database" for The Journal. A Journal Volume can contain one or more
user logins and all of their categories and entries.

Journal Volumes can be placed on any available hard drive, internal or external or network attached, or
even removable thumb drives. Each Journal Volume must have a unique name.

Most users of The Journal will only need a single Journal Volume.

See Journal Volumes for more information.

How do I synchronize 2 Journal Volumes?

It is possible to keep entries across multiple Journal Volumes "in sync" several ways:
Using a backup file created by The Journal.
Using an export file from The Journal.
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Using the Journal Volume folder on an external hard drive.

See the Export/Import Overview and Synchronizing The Journal for more information.

How do I move The Journal to a new computer?

1. Create a backup of your Journal Volume(s) (File menu, Maintenance sub-menu, Backup The
Journal...).

2. Download and install The Journal on your new computer.

3. Copy the backup file(s) you created in #1 to your new computer.

4. Run The Journal on your new computer. In the New User Wizard, check the option "I need to
Restore from a Backup of The Journal" and click on "Next".

5. Browse to select the backup file.

6. Click on "Restore". You will be prompted to create the Journal Volumes you need.

See also: How do I restore from a backup?

How do I install The Journal on a USB/Flash Drive?

The Journal can be installed and run on USB/flash drives and external hard drives. This provides a
simple way for you to have The Journal available to you on just about any computer with Windows and
a USB connector. 

Here's how: 

1. Install The Journal to the USB drive. You will need to override the default installation path. Type in the
path or browse to the folder on the USB drive that you want to use.

2. During the install, after you've typed in the path to the USB drive, you will next need to check the
option:
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"I am installing The Journal on a USB/Flash drive."

And *UN*-check these options:
"Create Start Menu icons" 
"Create a desktop icon" 
"Create a Quick Launch icon" 
"Have The Journal start with Windows."

3. After the install completes, double-click on Journal5.exe on the USB drive to run The Journal.

4. The first time you run The Journal on the USB drive, in the New User Wizard, check these options:

"I have just installed (or re-installed) The Journal." 
"I am running The Journal on a USB/Flash drive." (This option will probably be disabled, as it's
already been set during the install.)

5. The default path is ".\The Journal Volumes\5". You can change the default path, but make sure that
the path you enter uses the relative path format. If you're not sure what that means...just accept the
defaults. =)
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And that's it.

If you want to transfer an existing Journal Volume onto the USB drive, use The Journal's backup and
restore feature. Do the backup from the install of The Journal that you had before (the one on your
computer's main hard drive), and then do the restore from The Journal on the USB drive.

How do I use The Journal on a Network?

The Journal can have its Journal Volume(s) on a shared or network folder, allowing multiple users to
access those Journal Volume(s) at the same time. To do this, though, The Journal must be installed
properly.

1. When you install The Journal, on the "Select Additional Tasks" page of the install wizard, you need
to check this option: "The Journal's database will be in a shared or network folder"

2. You will be prompted to specify the shared/network folder to use.

3. You will have to do this on each of the computers or workstations that will be using The Journal over
the network.

4. If the users will be accessing or updating the same categories and entries simultaneously:Once you
have The Journal installed, you'll want to have set categories to use the "Lock Entries on Edit" option (on
the "Sharing" tab of Category Properties).

What is the size limit on a Journal Volume?

The maximum size of a Journal Volume is 30 TB (terabytes) on Windows.

NOTE: If you are running The Journal under a Windows emulator, the maximum size of the Journal
Volume will be limited by the host operating system (e.g., 2 GB under Wine on Linux).
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4.6 FAQ: Export/Import

How do I import my entries from Evernote, Penzu, Diaro, or WordPress?
How can I import my entries from another diary or journal program?
How do I synchronize 2 installations of The Journal?

How do I import my entries from Evernote, Penzu, Diaro, or WordPress?

The Journal supports importing from a variety of other software products, including Evernote, Penzu,
Diaro, and WordPress. This same process can be used for any software products that can export to
the ATOM publishing format.

1. Export the entries from the other software to a file.

2. In The Journal, click on the File menu, Import sub-menu, and choose "Import Entries..."

3. Browse to select the file you exported in #1.

4. Do the import.

You don't have to worry about importing the same entries more than once. The Journal detects this, and
checks the entries. If the entries are identical, nothing happens. If the current entry and the imported
entry are different, however, you will be prompted to import the new entry, keep the current entry, or
keep both.

Diaro NOTE: If possible, point the import to the folder with the Diaro xml file *and* the "Media" folder
(with "Photo" sub-folder). That will allow The Journal to import your photos as well as your text entries.

How can I import my entries from another diary or journal program?

The Journal supports batch entry import, which makes it relatively simple to import entries from other
diary or journal programs.

1. Create a temporary folder on your hard drive.

2. Export your entries from the other software into individual text (.txt), rich text (.rtf), or HTML (.htm;.
html) files. Export to the temporary folder you created in #1. If the entries are for a particular day, make
sure the date is used in the name of the exported file. The best date format will use a 4-digit year, a 2-
digit month, and a 2-digit day.

Example:
1993-10-05.rtf (entry for 5 October, 1993)

3. Once you have the entries exported, start The Journal. On the File menu, Import sub-menu, choose
"Batch Entry Import..." to import the entries into The Journal.

4. Choose the option "Each in a separate file", and click on "Next".

5. Choose the category you want to import the entries into (like "Daily Journal").

6. Browse to the temporary folder where your exported entries are.

7. Set the "Specify Date Format" to match how the export named your entries.
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Example:
yyyy-mm-dd.rtf

Then do the import.

See Importing Entries from Other Journal Software and Batch Entry Import for more information.

How do I synchronize 2 installations of The Journal?

It is possible to keep entries across multiple Journal Volumes "in sync" several ways:
Using a backup file created by The Journal.
Using an export file from The Journal.
Using the Journal Volume folder on an external hard drive.

See the Export/Import Overview and Synchronizing The Journal for more information.

4.7 FAQ: Database Maintenance

How do I backup The Journal?
How do I copy my backup file to another location?
How do I restore from a backup?
How do I see what is in my backup file?
How do I restore just one category from a backup file?

How do I backup The Journal?

1. Click on the File menu, find the Maintenance sub-menu, and choose "Backup The Journal..."

2. Check to select the Journal Volumes you want to backup.

3. Click on "Start Backup".

See User Preferences: Backup/Restore for more information.

How do I copy my backup file to another location?

Your Journal backup files can be automatically copied to another folder on your hard drive, to a
network folder, to an external hard drive, or even offsite to an FTP server.

1. Click on the File menu, find the Maintenance sub-menu, and choose "Backup Settings..."

2. Under "Copy backup archive to these locations", add the folder(s) or FTP server you would like
your backup copied to.

See User Preferences: Backup/Restore for more information.
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How do I restore from a backup?

1. Click on the File menu, find the Maintenance sub-menu, and choose "Restore From Backup..."

2. Browse to select your backup file.

3. When the backup file is opened, the Journal Volume name will be displayed, as well as the date the
backup file was created.

4. If more than one Journal Volume is listed, select the Journal Volume to restore from the list. 

6. Click on "Restore Journal Volume".

7.a. If the Journal Volume doesn't exist in The Journal, you will be asked if you want to create the
Journal Volume.

7.b. If a Journal Volume with the same name does exist, you will be ask to confirm overwriting the
current Journal Volume.

7.c. Otherwise, select the Journal Volume to restore into. 

NOTE: Everything that is in the Journal Volume you select will be overwritten by the information in the
backup. So select the Journal Volume *very* carefully.

Once the restore is finished, you can open the Journal Volume and log in.

How do I see what is in my backup file?

1. On the File menu, find the Maintenance sub-menu, and choose "Restore from Backup...". Browse
to select your backup file.

2. When the backup file is opened, the Journal Volume name will be displayed, as well as the date the
backup file was created.

3. Click on "Create New Journal Volume" to create a new, temporary Journal Volume that you can
restore into.

4. Click on "Restore Journal Volume". This will restore the backup file into the newly create Journal
Volume.

Then you can open the new Journal Volume, log in and review what it contained.

When you need to delete the temporary Journal Volume:

5. Click on the File menu, Journal Volume sub-menu and choose "Delete Journal Volume..."

6. Select the Journal Volume you created in #3 above, and then click on "Delete".

How do I restore just one category from a backup file?

1. Click on the File menu, Import sub-menu and choose "Sync from Backup File..."
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2. Browse to select the backup file.

3. If you're prompted for the user login password, enter that.

4. Under "What would you like to synchronize", un-check all the options except "Categories &
Entries". Then click on "Next".

5. Click on "Clear All", the check the category (on the left side) that you want to restore. Then click on
Next.

6. There will not be any entry conflicts, so click on "Next" again.

7. Click on "Sync".

And you're done.

4.8 FAQ: Security

How do I set/change my password?
How do I get rid of my password?
What is Extended Security?
What kind of encryption does The Journal use?

How do I set/change my password?

Click on the User menu and select "Change User Password..."

You will need to enter your current password (unless you have a blank password) to create a new
password, and then confirm your new password.

How do I get rid of my password?

If you do not want The Journal to prompt you for your password:

1. Click on the User menu and choose "Auto-Login".

2. Enter your password at the prompt to confirm auto-login.

You can turn off automatic login by clicking on the User menu and choose "Auto-Login" again.

What is Extended Security?

Extended Security enhances The Journal's normal security by adding an additional layer of protection,
and a couple of security-related options.

The Journal's "basic" security is quite good, more than most people will ever need. Extended Security
builds on that to make The Journal as secure as possible.

See Extended Security for more information.
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What kind of encryption does The Journal use?

Encryption of entries uses the Twofish block cipher designed by Bruce Schneier.

See Security Details for more information.

4.9 FAQ: Upgrading

Will The Journal 6 upgrade my categories and entries from The Journal 5 (or earlier)?
I am a registered user of The Journal 5 (or earlier). What is the upgrade price for The Journal 6?
How do I make The Journal 6 look like The Journal 4?

Will The Journal 6 upgrade my categories and entries from The Journal 5 (or
earlier)?

Yes, The Journal 6 will upgrade your existing categories and entries from any past version of The
Journal.

Upgrading Your Journal Volumes from The Journal 5 (or earlier) (Most Users)

Upgrading Your Journal Volumes from The Journal 5 installed on a USB drive

Upgrading from a Backup File (*.jbk or *.jbu)

See Upgrading from The Journal 5, 4 or 3 or Upgrading from The Journal 2.x for more information.

I am a registered user of The Journal 5 (or earlier). What is the upgrade price
for The Journal 6?

If you purchased The Journal 5 from 1 January 2012, up to the release of The Journal 6, you are
eligible for a free upgrade. Email DavidRM Software to request your Registration Keys for The Journal
6. Include your full name, mailing address, and date of purchase.

People who have purchased any previous version of The Journal are eligible for special upgrade
pricing ($24.95 US). To receive your The Journal 6 Upgrade Coupon Code, you must submit your full
name, mailing address, and date of purchase to DavidRM Software.

See The Journal Pricing for more information.

How do I make The Journal 6 look like The Journal 4?

Don't like the tabs down the right side? Or the new tabs for the Journal Volume and user? Or the new
toolbar/menu icons? Here's how to shift things around to make The Journal 6 look more like The Journal
4:

1. Click on the User menu and choose "User Preferences..."

2. Un-check these options on the "General" tab:

Arrange category tabs on the right

mailto:support@davidrm.com
mailto:support@davidrm.com
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Show Journal Volume tabs (global option)
Show User tabs (global option)

3. Check this option on the "Global" tab, on the "Skinning" sub-tab:

Use TJ4 icons for the toolbars, menus and entry tree

4. Click on Done.

4.9.1 Upgrading from The Journal 5, 4 or 3

Upgrading Your Journal Volumes from The Journal 4 (or earlier) (Most Users)
Upgrading Your Journal Volumes from The Journal 4 installed on a USB drive
Upgrading from a Backup File (*.jbk or *.jbu)

Upgrading Your Journal Volumes from The Journal 5 (or earlier) (Most Users)

If you have The Journal 5 (or TJ4 or TJ3) installed, then the first time you run The Journal 6 it will detect
your existing Journal Volumes and offer to import them into The Journal 6.

Click on Yes to start the import.

The import process copies your TJ5/TJ4/TJ3 Journal Volumes to a new location before upgrading
them. Your existing Journal Volumes will not be changed or modified in any way.

The upgrade happens in 2 steps:

1. Database upgrade. This happens the first time you open an imported Journal Volume.

2. User upgrade. This happens the first time you log in with a user name.

If you have a lot of entries, the upgrade may take a few minutes.

UPGRADE NOTES for The Journal 4 and The Journal 3:
A user's auto-login setting (no prompting for password) is not upgraded, so you will be prompted for
your password. You can set auto-login again by clicking on the User menu and choosing "Auto-
Login".
Categories that were set to "read only" lose that setting when upgraded. You can set the category to
read only again in Category Properties, on the Security tab, check the option "Category entries
are Read Only (and no new entries)".

Upgrading Your Journal Volumes from The Journal 5 installed on a USB drive
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NOTE: You will need about 25 MB of space just to install The Journal 6, and then about twice as much
free space as your TJ5 Journal Volume currently uses (it won't always need this much space; just
during the import and upgrade).

First, install The Journal 6 to your USB drive.

Run The Journal 6. It will create a new, empty Journal Volume for you.

To import your TJ5 Journal Volumes do this: Click on the File menu, Journal Volume sub-menu, and
choose "Import Journal Volume..."

Browse to your TJ5 Journal Volume folder and click on "OK".

The Journal 6 will then copy the Journal Volume into your new Journal Volumes folder and upgrade it.

Upgrading from a Backup

If you do not have The Journal 5 (or earlier) installed, but you do have a backup file (*.jbackup, *.JBK
or *.JBU) from The Journal 5 (or earlier), you can upgrade from that.

The first time you run The Journal 6, you will be shown the "New User Wizard". On the first page of
the wizard click on "I need to Restore from a Backup of The Journal", then click on Next.

You will then browse to select the backup file to restore from.

Once the restore has finished, The Journal 6 will ask you to confirm that you want the Journal Volume
upgraded. Follow the on-screen instructions to upgrade the Journal Volume.

The upgrade happens in 2 steps:

1. Database upgrade. This happens the first time you open an imported Journal Volume.

2. User upgrade. This happens the first time you log in with a user name.

If you have a lot of entries, the upgrade may take a few minutes.

Reverting to The Journal 5
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Should you decide not to stick with The Journal 5, you will want to do this:

1. Export all new/edited entries created or changed since you installed The Journal 5.

1.a. Use Windows Explorer to create a temporary folder to export into.
1.b. Back in The Journal 5, click on the File menu, Export sub-menu, Export Entries as Document...
1.c. Click on the "Export Options" tab and make sure that the "File Options" is set to "Create a file
for each exported entry".
1.3. Select the entries you have created/changed in The Journal 6.
1.3. Export these entries to RTF files into the folder you created.

2. Uninstall The Journal 6 using Windows Control Panel.

3. Run The Journal 5 (re-install if necessary). The Journal 5 should see your entries from before
installing The Journal 6.

4. Import the entries exported from The Journal 6.

4.a. In The Journal 5, click on the File menu, Import sub-menu, and choose Batch Entry Import...
4.b. Browse to the folder you created in #1 (above) with your exported entries.
4.c. Select the category to import the entries into.
4.d. Select the .RTF files to import.

4.9.2 Upgrading Add-on Packages

If you have purchased add-on packages for earlier versions of The Journal, such as MemoryGrabber
and Writing Prompts 1, you can still use them in The Journal 6.

Any packages you are already using should be upgraded. If not, the easiest way to get the packages
into The Journal 6 is to run the add-on installation again:

1. Make sure The Journal is not running.

2. Run the installation program for the package. When asked for the folder to install into, change it from:
C:\Program Files\DavidRM Software\The Journal 5\Package\

To:
C:\Program Files\DavidRM Software\The Journal 6\Package\

If you need to download the add-on installation program, email DavidRM Software.

4.9.3 Upgrading from The Journal 2.x

The Journal 6 can upgrade users, categories, and entries created with any 2.x release.

If you already have The Journal 2.x installed, you can upgrade the entry database easily. Just point the
upgrade process to the folder on your hard drive which contains the 2.x database. The 2.x database will
be copied to a temporary location before the upgrade is processed to prevent any changes to it.

If you have a backup that was created with The Journal 2.x, you can also upgrade from that. The
backup will be restored to a temporary database, which will then be upgraded.

NOTE: The information below applies only to users, categories, and entries upgraded from The
Journal 2.x.

mailto:support@davidrm.com
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Upgrading Users

All user-specific settings are upgraded except for some display settings (like the size and position of
The Journal). Settings for "Single User Mode", "Minimize to System Tray", and "Always on Top" are not
upgraded.

Your password is unchanged from the upgrade. It is recommended that you change your password
after upgrading.

If you use "Single User Mode" in The Journal 2.x, it is recommended that you turn if off before you
upgrade so that you can be certain you still remember your password.

Upgrading Categories

All categories are upgraded, whether they are active or inactive.

"Daily" categories in The Journal 2.x are converted to calendar categories (daily).

"Non-Daily" categories are also converted to calendar categories (daily).

"Loose-leaf" categories in The Journal 2.x are converted to loose-leaf categories. The "tree structure" of
entries is preserved, as is the sorting of entries.

Categories with passwords are upgraded, but the password protection is removed. So any password-
protected categories will have to be given passwords again after the upgrade.

Upgrading Entries

All entries in The Journal 2.x are upgraded.
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5 The Journal Reference

This section includes detailed descriptions of all The Journal's features, and how to use them.

Glossary

Blog Support
Categories
Database Maintenance
Entries
Export/Import & Syncing
Images & Media
Journal Volumes
Links
Printing
Reminders & Tasks
Security
Styles
Tables
Templates
Topics
User Interface
User Preferences

5.1 Glossary

Auto-Login

The auto-login option automatically logs you in when you start The Journal. You can turn on auto-login
by clicking on the User menu and checking "Auto-Login". You will be prompted for your password
once more, but not again. You can turn off auto-login by clicking on the User menu and un-checking
the "Auto-Login" option.

This option can also be set on the Security tab of User Preferences.

Blog

Short for "Web log", a form of public diary usually posted on a Web site. The Journal allows you to post
your entries to most blogs (WordPress, Blogger, and so on). See Using a Blog for more information.

Bookmark

A bookmark is a point in an entry that can be linked to. To insert a bookmark, click on the Insert menu
and choose Insert Bookmark... You will be prompted for a name for the bookmark.

Calendar Charms

Calendar Charms are icons, or small graphic images, that can be assigned to entries. The entry's
Calendar Charm is then displayed on the calendar and in the category's entry tree. Calendar Charms
can also be inserted into entries, like clip art.

Categories
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Categories are a powerful way to organize your entries in The Journal. The Journal creates three
categories for you automatically: "Daily Journal", "Notebook", and "Templates". Each category has its
own tab, making it easy to switch back and forth. You can create as many categories as you want.

There are two types of category: Calendar and Loose-leaf.

Categories, Calendar

Calendar categories are also called "daily entry" categories. However, calendar categories can be
hourly, weekly, monthly even yearly as well as daily. Calendar category entries are tied to a specific
date (or range of dates) and optionally a specific time. You can make as many entries on a date and/or
time as you would like.

Categories, Loose-leaf

Loose-leaf categories are often called "notebook" categories. Entries in a loose-leaf category are not
tied to any date. Instead, they are named documents (or external objects or images). Also, unlike
calendar category entries which are always arranged by year, month, day and time, loose-leaf
category entries can be arranged in "trees" of the user's choosing.

Categories, Shared

A shared category is a category that can be accessed by each user that links to it (and provides the
optional sharing password). All entries in the shared category are available. Categories can be shared
"read only" or "full access".

Day Planner

The day planner is your reference for all your active reminders, and can be set to display in any of
your journal categories above the entry editor. You can display your reminders just for today and up to
a week in advance.

Entry (Entries)

Entries, organized by category, are the core of The Journal. Entries can be text "documents", external
objects, or images. Most categories use document entries, because they are the most flexible type of
entry, but any type can be set as the default for the category.

Entry, Document

Document entries are formatted text documents, much like word processor files. Text can be entered
freely to any length. Any Windows font installed on your PC can be used to format the text. Document
entries can also include images, media files, and even embedded files.

Entry, External Object

External object entries are essentially Windows data files stored in (or linked from) The Journal. Double-
clicking an external object entry will open the entry using the associated Windows application. If
possible, the application will be "hosted" inside The Journal.

Entry, Image
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Image entries are graphic files (BMP, JPG, etc) that are stored in The Journal.

Entry Tree

The "entry tree" is the list of entries below the calendar. Calendar entries are arranged automatically by
year, month, day and time. Loose-leaf entries are arranged however you want them (just click and drag
to arrange loose-leaf entries).

Exporting

Use The Journal's export features to make entries available to other software or to synchronize Journal
Volumes.

Importing

Bringing files created by other applications (including other journal software) into The Journal. See 
Importing.

Journal Volume

A Journal Volume is an "entry database" for The Journal. A Journal Volume can contain one or more
user logins and all of their categories and entries. Each Journal Volume has its own folder on your hard
drive (or USB device or network drive).

Links

The Journal supports hypertext-style links in document entries.

There are two types of link: entry links and Internet links. Entry links are links to another entry in The
Journal (or to a bookmark within an entry). Internet links are links to Web pages or email addresses.

If an entry is "read only", you can activate a link just clicking on it. If the entry is not "read only",
however, you will need to hold down the Ctrl key and then click on the link.

Links, Entry

Entry links are special hyperlinks within The Journal to allow  jumping to another entry, or a bookmark
within an entry.

Links, Internet

Internet links are links web page addresses, email addresses, and so on.

Media

Audio files and video files like .wav and .mpg are called "media files".

Synchronizing

Keeping two installs of The Journal up-to-date with each other is known as synchronizing, or syncing.
See Synchronizing The Journal for more information.
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Style

A style is a pre-defined text format. A style can set the font, change paragraph settings, use numbers or
bullets, and more. The Journal automatically creates a small collection of styles for besides the default:
Heading 1, Heading 2, Heading 3, and HTML Passthru (for blogs).

Topic

Topics are another way to organize your entries. You can set a topic (e.g., "Feelings -> Happy") to the
text of entry, either as you type it or afterward. You can set as many topics within an entry as you wish.
You can also "tag" an entry with a topic. In that case, the topic applies to the whole entry, not just to a
block of text. You can then search entries with a topic or topics and review them.

5.2 Blog Support

The Journal's blog support gives you the ability to post entire entries (or just selected portions of
entries), both text and images, to public blogs--without sacrificing privacy and security. You choose
what entries and information are posted to your blog, and keep sensitive and/or private information
inside The Journal.

Blogs Supported
B2Evolution (www.b2evolution.net)  
Blog-City (www.blog-city.com)
Blogger (www.blogger.com)
CafeLog (www.cafelog.com)
LiveJournal (www.livejournal.com)
MovableType (www.movabletype.org)
MSN Spaces (spaces.msn.com)
Quick Blogcast (from GoDaddy)
TypePad (www.typepad.com)
WordPress (www.wordpress.org or www.wordpress.com)
Custom: Blogger (blogs that support the Blogger API)
Custom: LiveJournal (blogs that use the LiveJournal API/source code)
Custom: MetaWeblog (blogs that support the MetaWeblog API)
Custom: MovableType (blogs that support the MovableType API)

Support for more blogs will be added as users request them. So if you don't see your favorite, check 
Setting Up a Custom Blog or contact DavidRM Software (support@davidrm.com).

Using a Blog
Blog Profile

5.2.1 Using a Blog

Here are the steps to using a blog with The Journal:

1. Create your Blog Account

First, you will need a blog account to post to. Many blog hosts, like WordPress, LiveJournal and
Blogger, provide free accounts. You just have to sign up for one.

http://www.b2evolution.net/
http://www.blog-city.com
http://www.blogger.com
http://www.cafelog.com
http://www.livejournal.com
http://www.movabletype.org
http://spaces.msn.com
http://www.typepad.com
http://www.wordpress.org
http://www.wordpress.com
mailto:support@davidrm.com
http://www.wordpress.com
http://www.livejournal.com
http://www.blogger.com
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2. Create a Blog Profile in The Journal

Next, you need to create a blog profile so The Journal knows how to post to your blog.

Click on the Tools menu, and choose Blog Profiles...

On the Blog Profiles form, click on Create New Blog Profile and enter the necessary information:
Blog Tool (example: LiveJournal)
Alias/User Name (example: DavidRM)
And so on.

See Blog Profile for more information about setting up your blog profile.

In most cases, you can leave the rest of the blog profile settings as they are.

3. Make an entry in The Journal

Bring up a blank entry and type up the text you want to post to your blog, just like you were making a
normal entry in The Journal.

4. Post the entry to your Blog

Select the text you want to post to your blog and right-click on it to bring up the editor's context menu.
Open the Post to Blog sub-menu and select the blog profile to use.

You will be prompted for your password, and then the selected text will be posted to your blog.

That's all there is to it!

5.2.2 Blog Profile

Blog Tool

Identifies the type of blog (e.g.: LiveJournal). Each blog tool has its own way of posting new entries.
Once set, the blog tool for a profile cannot be changed.

Alias

This is your alias/user name on the blog tool. This is required when logging into the blog to post an
entry.

Blog API

Host - This is the host site of your blog (e.g.: www.livejournal.com). The Journal communicates with this
site to post the entry to your blog.

Page - This is the page (e.g.: /interface/xmlrpc/) on the blog's host site which The Journal uses to post
the entry to your blog.
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Port - The port number (e.g.: 80) used to communicate with the host site. This number will be 80 in
most cases.

Timeout - The timeout value specifies how many seconds to wait for the host site to respond before
cancelling.

Proxy Settings

Do not use a Proxy Server - Use a direct connection (no proxy server) to the blog's host site.

Use Internet Explorer Proxy Settings - Use Internet Explorer's proxy settings to connect to the blog's
host site.

Use These Proxy Settings - Specify your proxy server information yourself. You must enter both an
Address and a Port. If necessary, you can also enter your proxy User Name and Password.

Export Settings

No Formatting (Simple Text) - Post entries to the blog as simple text, with no formatting.

Force doublespace between paragraphs - Force doublespacing (a blank line) between paragraphs.
NOTE: This option is only available if No Formatting is selected.

HTML Formatting - Post entry to the blog, preserving text formatting with HTML. NOTE: Not all text
formatting supported in The Journal is available in HTML.

Use <BR> tag instead of <P> tag for paragraphs - By default, the HTML exported by The Journal
uses the <p> tag for paragraphs. If you would prefer that the export use the <br /> tag for paragraphs,
check this option.

Force a Leading Blank Line in Post - If checked, a single blank will be inserted at the top of the post,
followed by the content of the post. Specifically what happens is: all "white space" at the beginning of
the post, if any, is removed, and a single blank line is inserted.

Force a Trailing Blank Line in Post - If checked, a single blank will be appended to the bottom of the
post. Specifically what happens is: all "white space" at the end of the post, if any, is removed, and a
single blank line is appended.

Additional Settings

Make blog posts private - Post the entry to the blog as private, or not visible to other bloggers. Not
supported by all blog types.

Prompt for a title when posting - Prompt for a subject/title for the blog post. Not supported by all blog
types.

Use first line of post for title - If checked, the first line of your post will be used as the title, and
removed from the body of the post. Not supported by all blog types.

Save password for this profile - Save the password for this blog profile so that you don't have to type
it in every time. Un-check this option to clear the saved password and be prompted again.
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Always post to this blog - If you can post to multiple blogs with this blog profile, you have the option of
always posting to the same blog, to avoid being prompted over and over. Un-check this option to be
prompted again.

5.2.3 Setting Up a WordPress Blog

If you have a blog hosted by WordPress (blogname.wordpress.com):

1. Blog Tool: WordPress

2. Alias/User name: blogname

3. Host: blogname.wordpress.com

4. Page: /xmlrpc.php

If you are hosting your WordPress blog on your own server:

Example 1: www.blogname.com

1. Blog Tool: WordPress

2. Alias/User name: blogusername

3. Host: www.blogname.com

4. Page: /xmlrpc.php

Example 2: www.server.com/blogname

1. Blog Tool: WordPress

2. Alias/User name: blogusername

3. Host: www.server.com

4. Page: /blogname/xmlrpc.php

Posting Entries with Images

NOTE: This only works if you are hosting WordPress on your own server.

If you want to post entries with images in them, you will need to some additional setup on the blog.

1. In the WordPress "dashboard", click on "Settings", and then bring up the "Miscellaneous Settings"
page.

2. Set the "Store uploads in this folder" option.

3. Finally, make sure that the folder specified exists.
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5.2.4 Setting Up a Blogger (Google) Blog

1. Blog Tool: Blogger (Google)

2. Alias/User name: Your Gmail address (example: name@gmail.com)

The Blog API settings will be filled in for you automatically.

NOTE: If you have multiple blogs on Blogger, you will be prompted which one to post to when you do the
"Post Entry to Blog".

5.2.5 Setting Up a Custom Blog

Even if the blog site you use isn't listed in the Blog Profiles form, there's is still a good chance that The
Journal will work for you.

Gather the Necessary Blog Information

Check in your blog site's Help or FAQ (Frequently Asked Questions) section to find these bits of
information:

1. API supported - Many blog sites support the Blogger API. The MetaWeblog is also popular. You
need this information so you can choose the correct "Blog Tool" in your blog profile. If you cannot find
this information, try "Custom: Blogger API".

2. Host site - The Journal communicates with the host site to post the entry to your blog. For many blog
sites, this is the same as blog's home page (e.g., www.typepad.com).

3. Page - This is the page that is posted to on the host site.

The Host site and Page may be displayed as combined. Example: www.typepad.com/t/api/

In this case, you would separate the Host and Page like this:

Host: www.typepad.com
Page: /t/api/

NOTE: The Page may require a trailing slash (/).

Create Your Blog Profile

Once you have the above information, you can create your blog profile as described in Using a Blog.

5.3 Categories

The Journal's categories provide a powerful tool for organizing your journaling, notes or other writing
projects.

You can have as many categories as you want. Every category has its own tab.

The Journal supports two kinds of category: calendar and loose-leaf.

Calendar Categories
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Calendar categories can have entries for an hour, a day, a week, a month, a year--even for decades
and centuries. The "Daily Journal" category created for you automatically is a calendar category that
creates a new entry for you every day.

Calendar categories automatically organize your entries for you into days, weeks, months, and years.
You can also view summaries of your entries in a monthly calendar, or a horizontal yearly calendar.

You can create an entry for any date: past, present or future. Any date, from 1 AD to 9899 AD.

Don't worry about empty entries: The Journal doesn't store empty calendar entries.

Further, calendar categories can have loose-leaf entries, just like a loose-leaf category. These can be
sub-entries or attachments of calendar entries, or stand-alone entries.

Loose-leaf Categories

Loose-leaf categories are a collection of entries that are not tied to a particular date (as they are in
calendar categories).

Entries in a loose-leaf category are named documents, arranged by you, just like a loose-leaf notebook.
Loose-leaf category entries can be arranged in any order (just click-and-drag in the entry tree), and
entries can have sub-entries (which can have sub-entries, which can have sub-entries, and so on).

5.3.1 Calendar Categories

Calendar categories can have entries for an hour, a day, a week, a month, a year--even for decades
and centuries. The "Daily Journal" category created for you automatically is a calendar category that
creates a new entry for you every day.

Entries in a calendar category are always tied to a particular date (or date+time) or range of dates.
Calendar categories automatically organize your entries for you into days, weeks, months, and years.
You can also view summaries of your entries in a monthly calendar, or a horizontal yearly calendar.

You can create an entry for any date: past, present or future. Any date, from 1 AD to 9899 AD.

Don't worry about empty entries: The Journal doesn't store empty calendar entries.

Further, calendar categories can have loose-leaf entries, just like a loose-leaf category. Loose-leaf
entries can be sub-entries of calendar entries, and the category can have its own loose-leaf entries that
aren't sub-entries of calendar entries (just like a loose-leaf category).

See Category Properties: Calendar for more information.

5.3.1.1 Calendar Views

Calendar categories can display your entries in monthly and yearly calendar views.

In both calendar views, dates with entries have a slightly darker background and the day number 
bolded (see below). You can see the first line of the entry (or entries) on a date by moving the mouse
over that date.

Reminders for a date are displayed with their calendar charm and the time, if applicable. You can see
the full name and time of the reminder by moving the mouse over the reminder.

If you click on a date, you will see a list of all the reminders for that date and summaries of the entry or
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entries on that date. Entries with photos in them will have those photos reduced to thumbnails. You can
click-and-drag to select multiple, consecutive dates.

Month Calendar

The month calendar view has a special "Entries" tab. This tab displays a report of all entries in the
current month, in order.

Year Calendar

5.3.2 Loose-leaf Categories

Loose-leaf categories are often called "notebook" categories because of the "Notebook" loose-leaf
category that is created automatically for new users of The Journal.

Entries in a loose-leaf category are not tied to a specific date (as they are in calendar categories).
Instead,  entries in a loose-leaf category are named documents, arranged by you, just like a loose-leaf
notebook.



The Journal86

© 1996-2014 by David Michael

Loose-leaf category entries can be arranged in any order (just click-and-drag in the entry tree), and
entries can have sub-entries (which can have sub-entries, which can have sub-entries, ...). Arrange
your entries by clicking on the entry in the tree "dragging" it where you want it. You can move entries to
be "in front of" other entries (hover the mouse over the entry icon) or a "child of" other entries (hover
the mouse over the name of the entry). The mouse cursor will display differently based on the action
that will be taken.

5.3.3 Shared Categories

Categories can be "shared" by users within a Journal Volume.

A shared category can be accessed by each user that links to it (and provides the optional sharing
password). All entries in the shared category are available.

Categories can be shared as either "read only" or "full access". A read only shared category allows all
entries in the category to be read, but those entries can only be updated by the user that owns the
category. The entries in a full access shared category, on the other hand, are treated just like any other
entries. They can be read, edited, deleted, or even re-arranged (in loose-leaf categories).

To see the available shared categories, click on the Category menu and choose "Shared
Categories..."

See Category Options: Sharing for more information.

5.3.4 Merging Categories

Click on the Category menu and choose "Merge Categories..."

This form allows you to merge two or more categories into a single category.

You can merge:
Loose-leaf categories into other loose-leaf categories.
Loose-leaf categories into calendar categories.
Calendar categories into other calendar categories.

You cannot merge a calendar category into a loose-leaf category (do it the other way).

You cannot merge into a read-only category.

NOTE: This operation cannot be undone. If you change your mind, you will have to restore the category
or categories from a previous backup.

Merge these categories

Select the category or categories you want to merge from. Hold down the CTRL key when you click on
a category so you can select more than one.

Delete categories after merging

Check this option to delete the categories once they've been merged.

Into this category
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Select the category you want to merge into.

5.3.5 Add-on Packages

Add-on packages are collections of categories that can be installed into The Journal.

E-books, articles, templates, and more can be added to The Journal with packages. Once a package is
installed, the categories in the package are available as shared categories.

Some add-on packages may create new categories for you automatically. For example, the 
Memorygrabber package for The Journal creates a "My MemoryGrabber" category for you to fill out.
The questions and prompts for the different parts of your life are typed in, so all you have to do is type
in the answers to quickly and easily create your memoirs.

To view the packages you have installed, click on the Tools menu and choose "Add-Ons..."

Add-ons Available

This is the list of packages that have are available but have not yet been fully installed.

Add-ons I am Using

This is the list of packages that you have fully installed.

Button: >>

Select an add-on package under "Add-ons Available" and click on this button to finish installing the add-
on. The install process usually will create one or more new categories with the content of the add-on.

Button: <<

Select an add-on package under "Add-ons I am Using" and click this button to stop using it. Those add-
on package categories that can be will be removed. Some of the categories you might have to delete
yourself using Category Properties...

Uninstall Add-on

This button removes the selected add-on package from The Journal.

5.3.6 Category Properties

Categories in The Journal are highly configurable.

You can see these options by right-clicking on the category tab (or clicking on the Category menu)
and choosing "Category Properties..." Then bring up the "Calendar" tab.

General
Calendar
Entry
Entry Text Style
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Security
Sharing

New Category

New calendar and loose-leaf categories can be created with this button. Options such as the category
name, the frequency with which the category will create entries (for calendar categories) and if the
newly created category should be a sub-category of an existing category can be chosen here.

Delete Category

When you click Delete, the highlighted category in the category tree will be deleted. You will be asked
to confirm this deletion before it actually takes place.

WARNING: This operation cannot be undone (if you make a mistake, you will have to restore the
category from a previous backup).

5.3.6.1 Category Properties: General

These options are available to all category types.

Category Name (Displayed on Tab)

This is the name of the category. The name of the category can be changed at any time.

Category Active (Tab Visible)

If this option is un-checked, no tab shows up for the category because it is considered "inactive". Use
this option to "hide" categories that are no longer as active as they were. Should you need to access
the entries in the category, it's a quick and simple matter to make the tab visible again.

Category is a Folder Only

This option is only available for categories that have sub-categories. By default, a Master Category
presents itself as a sub-category of itself. By setting the category as "Folder Only", though, this doesn't
happen.

Any category with sub-categories can be designated as a "folder only" category. These categories are
used to help you organize your categories and sub-categories.

NOTE: If a folder only category has entries, those entries aren't displayed. To access those entries, you
would need to un-check this option.

Show calendar

If checked, the category's calendar is visible. For calendar categories, this option defaults to On. For
loose-leaf categories, this option defaults to Off.
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Show entry tree

This option displays the category's "entry tree". This option is On by default for all category types.

Show day planner with active reminders

When this option is checked your active reminders for Tasks, Events, Appointments and Special Days
will displayed in the day planner above the entry editor.

You can choose to show reminders for the current day, the current week, or for the next 2 to 7 days.
And you can set the time scale of the planner for 1 hour, 30 minutes, 20 minutes, 15 minutes, 10
minutes or 5 minutes.

Only show if there are active reminders

When this option is checked the day planner will only display when there are active reminders.

Display start of week on

The category's calendar can be set to start on any day of the week, Sunday through Saturday.

Category sort order

The sort order option controls in what order the category tabs are displayed.

You can also click and drag categories in the list to re-arrange them.

5.3.6.2 Category Properties: Calendar

These options are only available to calendar categories.

Create a New Entry Every ...

A calendar category can automatically create a new entry for you every:
hour
2 hours
3 hours
4 hours
6 hours
8 hours
12 hours
day
week (on a particular weekday)
month (on a particular day: 1-31)
year
decade
century

Include time (or date) in entry
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In addition, the entry can include a time stamp (for hourly, daily, and weekly calendar categories), the
day (for monthly categories), the month (for yearly categories), and the year (for decade categories). If
this option is checked, the default stamp will be the current time and/or date, but you can choose any
time and/or date.

NOTE: The Journal doesn't save blank entries.

In any type of calendar category, you can also create a new entry at any time by pressing F9 (Entry
menu, Create New Entry sub-menu, and choose Create New Entry).

Round time to 5 minutes

If checked (the default), entry time stamps are rounded up to the nearest 5 minutes. Otherwise, the time
stamp is the current hour+minutes.

Display calendar folders for ...

Each type of calendar category (hourly, daily, etc) has a default set of "calendar folders" it displays in
the entry tree. You can customize which folders are displayed with this option.

For example, if "Years" is checked, in the tree to the left of the entry editor you will see the years that
you have created entries.

Actual entries are always displayed.

Display full entry date and time in tree

If checked (the default), in hourly, daily, weekly, and monthly categories:
If the display month folder (see above) is un-checked, the 2-digit month for the entry will be displayed
along with the 2-digit day.

Example:

If the display year folder is un-checked, the 4-digit year for the entry is displayed.

Example:

If un-checked, the above examples would look like this:

Display day of week for daily entries in tree



The Journal Reference 91

© 1996-2014 by David Michael

If checked, daily entries will display the abbreviated day of the week (Sun-Sat) in addition to the day of
the month.

Example:

Display calendar entries after loose-leaf entries in entry tree

If checked, any root-level loose-leaf entries will be listed in the entry tree *before* the calendar entries.

Automatically lock past entries

If checked, then past entries of the category are locked by default.

This setting can be overridden at any time to make changes to a particular entry. Just select the entry,
and press F4 (or click on the Entry menu and choose "Lock/Unlock Entry").

Even if this option is not checked, you can make particular past entries locked (read-only).Just select
the entry, and press F4 (or click on the Entry menu and choose "Lock/Unlock Entry"). "Locked" will
display in the status bar below the entry editor to show that this entry has been locked.

Show latest entry by default

If checked, the latest entry in the category is displayed when you first open the category. New, blank
calendar entries are not created automatically. To create a calendar entry, choose the date on the
calendar, or press F9.

5.3.6.3 Category Properties: Entry

These options are available to all category types.

Default Entry Template

The selected template will be inserted into new entries. For calendar categories, this template will be
inserted into new entries for the current day (or week or whatever). For loose-leaf categories, the
template will be inserted into all newly created entries.

Default Entry Type

This setting determines the default entry type of the category, and what kind of entry newly created
entries will be. In loose-leaf categories, this setting can be overridden to create an entry of any type.

Normal Document Entry

Document entries are formatted text documents, much like word processor files. Document entries can
have images, movies and other types of files inserted into them. It is recommended that calendar
categories use document entries.
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See Document Entries for more information.

External Object Entry

External object entries are essentially Windows data files stored in (or linked from) The Journal.

See External Object Entries for more information.

Image Entry

Image entries are graphic files (BMP, JPG, etc).

See Image Entries for more information.

Entry Tree/Editor Options

Display first line of entry in entry tree

If checked (the default), the first line of your entry is displayed in the entry tree (up to 50 characters).
You can see this by hovering your mouse cursor over the entry in the tree.

NOTE: If the first line of the entry is the same as the entry title, it will not be displayed.

Display entry word count in status bar

If checked, the word count of the entry is displayed on the status bar beneath the editor. As you add or
delete words, the count updates.

For calendar categories, this option defaults to off. For loose-leaf categories, it defaults to on.

Display last updated date in status bar

If checked, the date the entry was last updated is displayed on the status bar beneath the editor.

Save entry editor state between sessions

If checked, the position of the caret, including the selection of any text, and the scroll position of the
entry editor is preserved for the entry. The next time you bring up the entry--even if you've closed The
Journal and restarted--you will be exactly where you were.

For calendar categories, this option defaults to Off. For loose-leaf categories, this option defaults to On.

Use WYSIWYG formatting

If checked, the category's entries are displayed WYSIWYG ("what you see is what you get"). That is,
the entries are displayed exactly as they would print to the active printer.

Loose-Leaf Options

Loose-leaf entry default name format

This option controls the name given to new loose-leaf entries. By default, the loose-leaf entry name
format is:
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%c Entry

%c is replaced with the name of the category.
%date is replaced with the current date in short format.
%time is replaced with the current time in short format.
%d, %dd, %ddd, %dddd - current day
%m, %mm, %mmm, %mmmm - current month
%yy, %yyyy - current year

Automatically sort loose-leaf entries by name

If checked, loose-leaf entries are sorted alphabetically as they are created and renamed.

Printing Options

Edit Page Setup, Header, Footer

Use these settings to override the page setup, header, and footer created in User Preferences: Printing.

Default Page Setup, Page Header, Page Footer, and Entry Header

Use this setting to restore the page setup, page header, page footer, and entry header created in User
Preferences: Printing.

5.3.6.4 Category Properties: Entry Text Style

These options are available to all category types.

Entry Background Color

This is the default color used for the background of document entries.

Entry Background Image

This is the default background image used for entries in this category.

Edit Font and Text Settings

Every category can specify its own "default style" that defines the category's default font. If no default
style is given, then the default style setting from User Preferences: Styles is used.

See Styles for more information.

Default Settings

This button restores the background color and default style to those set in User Preferences: Styles.
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5.3.6.5 Category Properties: Security

These options are available to all category types.

Category Entries are Read Only (and no new entries)

When checked, this category and its entries cannot be edited or deleted. Also, no new entries can be
created.

Category Password

If you want this category to have a password, enter it here. You will need to enter the password again in
the "Confirm Password" field.

If the category already has a password, you will need to enter the existing password to change it or to
clear it.

Only Verify Password Once per Session

If checked, you will only need to enter the category's password once per journaling session. A
"session" starts any time The Journal prompts you for your user name password.

If this option is not checked, you will have to enter the password every time the category is selected.

5.3.6.6 Category Properties: Sharing

These options are available to all category types.

Lock Entries on Edit

If you are using The Journal over a network and/or sharing categories between users, and there is a
possibility that multiple users will be accessing and updating the entries of this category at the same
time, you will want to have this option checked. When a user edits an entry, that entry will be locked,
preventing other users from editing the entry at the same time.

Prompt for Lock Message

When "Prompt for Lock Message" is checked, all entries in the category are "Read Only" by default,
and you must use Entry | Edit Entry (hot-key: F4) and enter a lock message. This lock message is
displayed to any other users who attempt to edit the entry. Use this option along with "Lock Entries on
Edit" to further coordinate your editing with other users.

Category is Shared

If checked, this option allows other users within the Journal Volume to link to this category and access
its entries.

Read Only?

This option is only available if the category is shared. If checked, then other users can only read the
entries in the category. They cannot edit, delete, or re-arranged the entries in any way.
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Category Share Password

If you want this category to have a share password, enter it here. You will need to enter the password
again in the "Confirm Password" field.

If the category already has a share password, you will need to enter the existing password to change it
or to clear it.

The share password must be entered correctly by other users to link to the shared category.

Note that the share password is different from the category password described in Category Properties:
Security.

See Shared Categories for more information.

5.4 Database Maintenance

The Journal's entry database has proven very stable over the years, but it is always a good idea to
make regular backups.

The Journal automatically prompts you to make a backup about twice a week (every 3 days). If you
would like to backup more or less frequently, you can set this using the Backup Settings.

See Backup/Restore for more information.

Database Maintenance FAQ
How do I backup The Journal?
How do I restore from a backup?
How do I see what is in my backup file?

5.4.1 Backup/Restore

The Journal's Journal Volumes should be backed up regularly. For more protection, it is recommended
that you copy your backup file(s) to another computer or another location.

To backup The Journal, you have to login normally.

Backups can be made to any valid drive or folder on your PC, even network drives or external hard
drives connected by a USB.

Further, once the backup is completed, The Journal can automatically copy the backup file to separate
locations--even upload the backup file to an offsite FTP server.

It is possible to restore from a backup made with any previous version of The Journal since The Journal
2. (Restoring from a backup of The Journal 1.x, though, requires special instructions. Email DavidRM
Software.)

How do I backup The Journal?
How do I restore from a backup?
How do I see what is in my backup file?

mailto:support@davidrm.com
mailto:support@davidrm.com
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5.4.2 Backup Settings

Backup options can be set through the File menu, Maintanance sub-menu, and then selecting "Backup
Settings..." These Backup Settings are also available from the User menu by selecting "User
Preferences...", and then bringing up the "Backup/Restore" tab.

See User Preferences: Backup/Restore for the available backup settings.

5.4.3 Restore

To restore from a backup, click on the File menu, Maintenance sub-menu, and choose "Restore from
Backup..."

Backup Archive

This is the name of the backup archive (*.jbackup).

You can restore from a backup made by a previous version of The Journal (*.JBU or *.001). In this
case, a Journal Volume must be created especially for the restore and upgrade.

Backup Contents

This will list the Journal Volume that have been backed up into this archive, including the date of the
backup.

Restore Journal Volume

This command will restore the selected Journal Volume. Unless you pick an earlier date, the restore will
automatically use the most recent backup of the Journal Volume.

Restore into New Journal Volume

This command allows you to create a new Journal Volume and restore into that, to prevent possibly
overwriting an existing Journal Volume.

See also How do I restore from a backup?

5.4.4 Repair The Journal Databases

To repair The Journal's Journal Volumes bring up the Journal menu, the Maintenance sub-menu, and
choose Repair The Journal Databases...

The repair process analyzes The Journal's database tables, correcting any problems that may have
appeared due to system shutdown issues or Windows crashes. The repair process also optimizes the
tables and minimizes the amount of disk space required for all database tables.

In general, The Journal's database tables are quite stable. It is unlikely you will need to use the repair
process more than once or twice per year.

If you have a lot of entries (5,000+) this process could take a few minutes.
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Repair Journal Volumes

This button repairs and optimizes all Journal Volumes.

Repair System Database

This button repairs The Journal's System Database.

5.4.5 Clean Journal Volume folder

Click on the File menu, Maintenance sub-menu, and choose "Clean Journal Volume folder..."

This command removes all unnecessary or extraneous files from the folder of the current Journal
Volume.

The files deleted include:
*.Old - created by certain database updates.
All files left over from upgrading the Journal Volume from The Journal 5 or earlier.

5.5 Entries

Entries, organized by category, are the core of The Journal. Entries can be text documents, external
objects, or images.

Most categories use document entries, which can include images and other types of files, though any
entry type can be set as the default for the category.

Document Entries
External Object Entries
Image Entries

Entries FAQ
How do I import my entries from Evernote, Penzu, or WordPress?
How can I import my entries from another diary or journal program?
How do I insert images in my entries?
Can I insert digital photos in my entries?
How can I use tables in my entries?
How do I make my tables look like those in MS Word/WordPerfect/Etc?
How do I use topics in my entries?
How do I lock my entries so they can't be edited?
How do I post my entries to a blog?
How do I use templates in my entries?
How do I have a template automatically inserted in my entries?
How can I create my own templates?
Why can't I edit my past entries?
How do I create loose-leaf entries in my calendar category?

5.5.1 Document Entries

Document entries are formatted text documents, much like word processor files. Text can be entered
freely to any length. Any Windows font (TrueType, Type-1, etc) installed on your PC can be used in
your entries.
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Document entries can also include images (digital photos, clip art, calendar charms, etc.), media files
(audio and video), and even external objects like spreadsheets.

How do I insert images in my entries?
Can I insert digital photos in my entries?
How can I use tables in my entries?

5.5.2 External Object Entries

External object entries are essentially Windows data files stored in (or linked from) The Journal. If
possible, The Journal will use the standard icon for the file when displaying the entry in the date or entry
tree. Examples are: spreadsheets, word processor documents.

Double-clicking an external object entry will open the entry using the associated Windows application. If
possible, the application will be "hosted" inside The Journal.

External object entries can be "linked" to a file. When linked, the file is not stored inside The Journal.

External objects cannot be printed by The Journal. Instead, you will need to use the default application
for that external object to print it.

Loose-leaf entries can easily be dragged and attached as a sub-entry to any other entry, even a
calendar entry.

5.5.3 Image Entries

Image entries are graphic files (BMP, JPG, etc) that are stored in The Journal.

Images can be bigger than the visible region of the screen. Clicking and dragging will scroll the image.
The image can also be scaled using the "wheel" on your mouse.

Image entries are much more space efficient than embedding images in document entries because
they store the image in its native format.

When printing image entries, the image is scaled to fit the page.

NOTE: Image entries are included for backwards compatibility with earlier versions of The Journal. For
most users, document entries provide a more flexible and powerful way to organize images in The
Journal.

5.5.4 Create New Calendar Entries

In a calendar category, click on the Entry menu, Create New Entry sub-menu, Document Entry (hot-
key: F9).

How this form works depends on the type of calendar category.

Daily

You choose the day, and (optionally) the time of the entry.

Hourly

You choose the date and the hour. You can optionally set the minutes of the entry.



The Journal Reference 99

© 1996-2014 by David Michael

Weekly

You choose the week, and (optionally) the day of the entry.

Monthly

You choose the month, and (optionally) the day of the entry.

Yearly

You choose the year, and (optionally) the month of the entry.

Decade

You choose the decade, and (optionally) the year of the entry.

Century

You choose the century, and (optionally) the decade of the entry.

5.5.5 Saving Entries

The Journal automatically saves your entries in your Journal Volume, which is a database.

If you want to save your entries in a format that can be accessed by other software (like a word
processor), you have a couple of options:

"Save Entry As..." (on the File menu; hot-key: F12)
"Export Entries as Document..." (on the File menu, Export sub-menu)

Save Entry As...

The "Save Entry As..." command saves the currently active entry to your hard drive.

You can choose to save the entry in a variety of formats:
Rich Text Format (.rtf) - All the text of the entry is saved, with full formatting (font, bold, etc).
Inserted images and objects are saved into the file. Rich text files can be opened by MS Word,
WordPerfect, and almost any other Windows word processor. This is the default format.
Plain Text (.txt) - All the text of the entry is saved, but without formatting. Inserted images and objects
are not saved.
HTML (.html) - All the text of the entry is saved, with full formatting (font, bold, etc). Inserted images
and objects are saved in separate files.

Export Entries as Document...

Use the "Export Entries as Document..." command to save one or more entries to your hard drive.

You can select any number or entries (even entire categories) and save them to the same variety of file



The Journal100

© 1996-2014 by David Michael

formats described above. You can also save the entries in one, large file, or save each entry in its own
file.

For more information, see Export Entries.

5.5.6 Search Entries

Beyond searching for a word or phrase in a single entry, The Journal supports queries that can span all
categories and entries. Plus you can search for text (word, phrase, collection of words), and you can
search for topics.

You can search:
entry text
entry titles
image descriptions
reminder names and notes

Search Text

Enter the word, words, or phrase you want to search for here. Words in quotes "like this" are treated as
a single word.

Queries are not case-sensitive, so don't worry about uppercase and lowercase.

Where to Search
Search entry text - Look for the word(s) in the text of the entry (a normal search).
Search entry names - Look for the word(s) in the names of entries.
Search image/media/object descriptions - Look for the word(s) in the descriptions of images and
objects.
Search reminder names and notes - Look for the word(s) in the names and notes of reminders.

By default, the search will look in the entry text, entry names, image/media/object descriptions, and
reminder names and notes. Turn off one or more of these to narrow the scope of the search (for
example: to search only in image descriptions).

Text Search Options
Search for entire phrase - The search text is taken as a single phrase. The entire phrase must be
matched for the search to find anything.
Search for entries with any of the words (OR) - The search text is a collection of words (or quoted
phrases). If an entry contains any of these words, it will be listed. A "Match %" will be displayed,
indicating what percentage of the searched-for words are present in the entry.
Search for entries with all of the words (AND) - The search text is a collection of words (or quoted
phrases). An entry must contain all of the words to be listed as a match. The words don't have to be in
any particular order in the entry to match.
Advanced search (phrase is match query) - The search text is passed to the indexed search
engine as a match query. This allows you to use special keywords like NEAR.
Match whole words only - If checked, a word must be matched in full (no sub matches).

Match Queries

See Match Query Syntax for detailed information.
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Search Topics

Select the topic(s) you want to search for.

The topics you have used at least once in an entry are listed first, in alphabetical order. All other topics
are listed in alphabetical order following the ones you have used.

Topic Search Options
Search for entries with any of the topics (OR) - If an entry contains any of the selected topics, it
will be listed.
Search for entries with all of the topics (AND) - Only if an entry has all of the selected topics will it
be listed.
Display only topic text in search results - In the Search Results, when viewing an entry (or all
entries), only those parts of the entry tagged with the selected topic(s) will be displayed.
Include sub-topics in search results - If an entry has a sub-topic of a selected topic, the entry will
be included in the search results.

Search Options

You can limit the number of categories searched. By default, the search looks in all categories.

Search this date range only (for calendar categories)
Check this option to limit the search to calendar categories (like "Daily Journal"), and to further limit the
search to the specified date range.

Search recent entries first (for calendar categories)
Check this option to search from the most recent entries to the least recent entries.

Search active category only
Check this option to look only in the active category.

Search all categories
Uncheck this option to limit your search to the categories you select

Include sub-categories in search
If checked, the sub-categories of the selected categories will be search, as well as the selected
categories.

Force re-indexing of all entries in categories searched
If checked, all entries in the categories to be searched will be re-indexed. This completely rebuilds the
index used for fast searching, so it should not be done unless needed.

5.5.6.1 Match Query Syntax

The search text is passed directly to the indexed searching engine. Match queries can include OR and
AND and even NEAR. These are explained below.

NEAR

The NEAR operator may be used to search for entries that contain two or more words or phrases within
a specified proximity of each other. The NEAR operator must always be specified in upper case. The
word "near" in lower or mixed case is treated as an ordinary token. For example, the following query:

engineering NEAR consultancy
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matches rows that contain both "engineering" and "consultancy" in the same entry with not more than
10 other words between them. It does not matter which of the two terms occurs first in the entry, only
that they be separated by only 10 words or less. You may also specify a different required proximity by
adding "/N" immediately after the NEAR operator, where N is an integer. For example:

engineering NEAR/5 consultancy

searches for entries containing an instance of each specified word separated by not more than 5 other
words. More than one NEAR operator can be used in a sequence. For example this query:

reliable NEAR/2 engineering NEAR/5 consultancy

searches for entries that contain "reliable" separated by not more than two words from an instance of
"engineering", which is in turn separated by not more than 5 words from "consultancy". Phrases
enclosed in quotes may also be used as arguments to the NEAR operator.

OR

Similar to the NEAR operator, one or more words or phrases may be separated by OR. In this case,
only one of the specified words or phrases must appear in the entry. For example, the query:

hello OR world

matches entries that contain either "hello", or "world", or both.

Any part of the match query, whether or not it is part of a phrase enclosed in quotes, may have a '*'
character appended to it. In this case, the token matches all terms that begin with the characters of the
token, not just those that exactly match it. For example, the following query:

david*

matches all entries that contain "Davidson" and "David's", as well as those that contain "David".

Parentheses

Parenthesis may be used to overcome the built-in precedence of the supplied binary operators. For
example, the following search text:

(hello world) OR (simple example)

matches entries that contain both "hello" and "world", and entries that contain both "simple" and
"example".

AND

An AND operator may be explicitly specified. For example, the following query is handled identically to
the one above:

(hello AND world) OR (simple AND example)

As with the OR and NEAR operators, the AND operator must be specified in upper case. The word
"and" specified in lower or mixed case is handled as a regular token.

NOT
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The NOT operator requires that the query specified as its left-hand operator matches, but that the query
specified as the right-hand operator does not. For example, to query for all entries that contain the term
"example" but not the term "simple", the following query could be used:

example NOT simple

As for all other operators, the NOT operator must be specified in upper case. Otherwise it will be treated
as a regular token.

Precedence

The precedence of the match query operators, in order from highest to lowest, is:

NEAR (highest precedence, tightest grouping)
NOT
AND
OR (lowest precedence, loosest grouping)

It is possible to specify expressions enclosed in parenthesis as operands to the NOT, AND and OR
operators. However both the left and right hand side operands of NEAR operators must be either words
or phrases. Attempting the following match query will return an error:

journal NEAR (fantastic OR impressive)

Queries of this form must be re-written as:

journal NEAR fantastic OR journal NEAR impressive

5.5.7 Search Results

This form is brought up when a search is begun.

Found entries are displayed in a manner much like that used by search engines on the Web:

Daily Journal - Wednesday, September 08, 2004
... some search text here ...  

The first line is an entry link. Clicking on the link brings up the content of that entry, with the search text
(or search topics) highlighted.

The next line shows one example of the search text found, with some context both before and after.

If the Search Results form is ever hidden from view, you can bring it back by choosing Search Entries
on the Search menu, or by pressing the hot-key: Shift+Ctrl+F

Stop Search

Stops the current search (if it hasn't already completed).

New Search

Stops the current search and brings up the Search Entries form again.
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Results per Page

You can set the number of results shown per page, from 1 to 100.

Print/Print Preview

Print (or Print Preview) will print either the list of results currently displayed, or the entry selected.

Insert Page Break

To provide more control over the printing, you can insert page breaks. You can also remove the page
breaks you insert.

Show Page Breaks

Click on this command to see where the currently displayed text (result list or entry) will have page
breaks.

Hide Highlight

This command toggles the highlighting of search terms. This can be useful when printing the search
results, or saving them to a file.

Save to File

Click on this command to save the search results to a file on your computer.

Next Search Term

Click on this button (or press the hot-key F3) to move forward through the entry, highlighting each of the
search terms in turn. When you reach the end of the entry, Next Search Term will loop back to the
beginning.

5.5.8 Entry Report Wizard

To bring up the Entry Report Wizard, click on the Tools menu and choose "Entry Report Wizard..."

Click on the report you would like to see, and the wizard will guide you through the parameters.

It's possible to save reports with their settings for quicker access.

Daily/Weekly Entry Report

Use the Daily/Weekly Entry Report to collect all of the entries made in a given date range: a day, a
week, a month, a year, or any range at all.
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NOTE: This report is for calendar categories (like Daily Journal) only.

Example:
You have a project-specific calendar category called "Project Notes" where you track your daily
progress, meeting notes, and so on. On Monday, you want to print out a report of what you did the
previous week. So you:
1. Bring up the "Project Notes" category tab.
2. Click on the Tools menu, choosing Daily/Weekly Entry Report...
3. Select Last Week.
4. Click on See Report.

All of last week's entries in "Project Notes" are now compiled in proper order. You can review them and
then print the report.

Daily/Weekly Reminder Report

The Daily/Weekly Reminder Report is similar to the Daily/Weekly Entry Report, but only reminders
reminders that came due or were completed in the chosen date range.

New/Updated Entry Report

Use the New/Updated Entry Report report to see all of the entries that were created or modified in a
given date range: a day, a week, a month, a year, or any range at all.

Look for:
Newly created entries - Entries that were first created within the date range.
Edited/updated entries - Entries that were edited or otherwise updated within the date range.
Show body of entry in report - If checked, the body of the entries is included in the report. If it is
not checked (the default), only the entry headers are displayed. You can click on the entry headers
in the report to see the full entry.

Entry Index

The Entry Index is a report of all entries in a category or categories, arranged and indented for clarity.
Only the entry date or title is displayed.

The entry name is linked, so you can click on the entry name to see the actual entry.

Topic Usage Report

The Topic Usage Report provides a summary of how many entries contained each topic over the
selected date range.

5.5.9 Entry Report Results

When the Entry Report Wizard collects all of the appropriate entries, it uses this form to display the
results.

The entries are sorted by category, and then by entry date (for calendar entries) or by sort order (for
loose-leaf entries). The category name is displayed before the first entry from that category, and the
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entry name is displayed before each entry.

New Report

Discards the current report and brings up the report form again, so you can create another report.

Print/Print Preview

Print (or Print Preview) will print either the list of results currently displayed, or the entry selected.

Page Break

To provide more control over the printing, you can insert page breaks. You can also remove the page
breaks you insert.

Show Page Breaks

Click on this command to see where the currently displayed text (result list or entry) will have page
breaks.

Save to File

Click on this command to save the report to a file on your computer.

5.5.10 Delete Entries

Entries can be deleted either one at a time from the category's "entry tree", or in batches using the 
Delete Entries... command on the Entry menu.

Once an entry has been deleted, it cannot be recovered (except by restoring from a backup).

5.5.11 Lock/Unlock Entries

Entries can be "locked" to prevent editing. A locked entry will display "Locked" on the status bar below
the entry editor.

Press F4 to lock the active entry.

Press F4 again to unlock the active entry.

5.6 Export/Import & Syncing

The Journal supports the export and import of entries via several formats.

Supported Export Formats
Text Files (.TXT)
Rich Text Files (.RTF)
HTML Files (.HTM)
XML Files (.XML)
Journal Export Files (.JNX)
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Text files are simply text, such as files made with Windows Notepad. The only formatting in text files is
marking end of lines with carriage returns.

Rich Text files, also called RTF files, contain full text formatting information. Font, paragraph alignment,
colors, and so on, are all preserved. RTF files can be read by most Windows word processors.

HTML files are text files with "hypertext markup language" tags embedded. These tags control formatting
of the file when it displayed with a web browser, such as Internet Explorer. HTML files are only
supported when exporting.

XML is also a text format, so you can edit it in every ANSI text editors (for example Notepad). The
Journal has its own set of XML tags, but you can browse XML documents exported from The Journal in
every XML-compatibile Web Browser.

Journal Export (JNX) files provide a way to transfer categories and entries, with all formatting in the
entries, as well as other category and entry information, between different installations of The Journal.

Export/Import FAQ
How do I import my entries from Evernote, Penzu, Diaro, DayNotez, or WordPress?
How can I import my entries from another diary or journal program?

5.6.1 Export Entries as Document

The Journal supports a number of exporting options. You can export a single entry, an entire category,
or a collection of entries from multiple categories to a file or files that can be viewed or opened by a
word processor or Web browser.

Click on the File menu, Export sub-menu, and choose "Export Entries as Document..."

Select Categories/Entries to Export

Active Entry

Only the active entry will be exported.

Active Entry with All Sub-Entries

The active entry and all of its sub-entries will be exported.

Current Day (in all Calendar Categories)

The entry for the current date in all calendar categories will be exported. No loose-leaf entries will be
exported with this option.

Entire Journal (all categories, entries & reminders)

Your entire journal will be exported.

These Categories/Entries

Whichever categories or entries you select will be exported. Entire categories can be selected for
exporting, or groups of entries spanning several categories.



The Journal108

© 1996-2014 by David Michael

Export Type

Rich Text (.RTF) - Rich Text, or RTF, files include all text formatting and embedded images/objects.
RTF files can be read by nearly all Windows word processors.

Plain Text (.TXT) - Entries exported to plain text files are stripped of all formatting except line-breaks.
TXT files can be read by any text editor and all word processors.

HTML (.HTM) - HTML is the standard format of the World Wide Web. They can be edited by any text
editor, most Windows word processors, and, or course, they can be displayed with any Web browser.
Most text formatting is preserved, though not all. Embedded images are extracted to JPG files and linked
from the exported .HTM file.

Export Options

File Options:
Create a Single File for all Exported Entries - This option creates a single file for all exported
entries. Categories are given "headers" to separate their entries.
Create a File for each Exported Category - This option creates a file for each exported category.
Only entries exported from that category are included in its file.
Create a File for each Exported Entry - This option creates a file for each exported entry.
Depending on the number of entries exported, this option could result in a lot of files being created.

Include Category Name Header in export

By default, exports to RTF/TXT/HTM include the category name as a header before the first exported
entry for that category. Un-check this option to prevent this.

Include Entry Date/Name Header in export

By default, exports to RTF/TXT/HTM include the entry date/name as a header for each exported entry.
Un-check this option to prevent this.

Page Break (RTF export)
Between Categories
Between Entries

If checked, page breaks will be inserted between categories and/or entries in the RTF export file.

File Names

Category File Name

If the Create a File for each Exported Category option is used, this setting controls the name of the
export file.

To include the name of the category in the file name, use the "%c" flag.

Entry File Name
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If the Create a File for each Exported Entry option is used, this setting controls the name of the export
file.

To include the name of the category in the file name, use the "%c" flag. To include the name (or date)
of the entry, use the "%e" flag.

Include "Full Path" in Loose-Leaf Entry Names

If checked, loose-leaf entry names include their full "path" of parent entries.

Export Path Separator

If exported loose-leaf entries will include their full path, it is necessary to specify a replacement for the
backslash ( \ ) character in the path. The backslash ( \ ) is not allowed in Windows file names.

This option is also used with the File | Save Entry As... command.

Date Format

For categories with entries tied to a date, such as standard categories, this setting controls how the date
is formatted in the export file name.

5.6.2 Export Entries as File

The Journal supports a number of exporting options. You can export a single entry, an entire category,
or a collection of entries from multiple categories. The resulting export file can be used to easily transfer
entries to another copy of The Journal or, depending on the file type, other journaling or notekeeping
software.

Click on the File menu, Export sub-menu, and choose "Export Entries as File..."

Select Categories/Entries to Export

Active Category

All entries in the active category will be exported.

Reminders

All of your reminders will be exported.

Entire Journal

Your entire journal, all of your categories, entries and reminders will be exported.

These Categories/Entries

Whichever categories or entries you select will be exported. Entire categories can be selected for
exporting, or groups of entries spanning several categories.

Select Export File Type

The Journal Export File (.TJEXP) - The Journal Export Format is a proprietary format used only by
The Journal. It preserves not only all text formatting, but it also preserves all category and entry settings.
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TJEXP files are used primarily to transfer entries from one installation of The Journal to another.

The Journal XML (.TJXML) - The Journal's XML export format is similar to the TJEXP format, but uses
XML. Being XML, other software could access the data, so long as they can parse The Journal's tags.

NOTE: Unlike the TJEXP format, the TJXML format is limited to 2GB.

ATOM Publishing Format (.XML) - The ATOM publishing format is a simple, xml-based format used by
some blogs and other journaling software (such as Penzu).

NOTE: This format is limited to 2GB.

Export Options

Password Protect - If checked, you will be prompted for a password to lock the export file. This option
is only available for the TJEXP format.

Compress - If checked, the content of the export file is compressed when saved, resulting in a smaller
file. This option is only available for the TJEXP format.

5.6.3 Importing Entries

Click on the File menu, Import sub-menu, and choose "Import Entries..."

Importing Documents

Many document formats can be imported into The Journal:
Text files (.TXT)
Rich text files (.RTF)
HTML files  (.HTM;.HTML;.SHTML)
MS Word documents (.DOC)

Document files are imported into the currently selected entry. If the entry is not empty, the document
contents are appended to the existing entry. Only a single document can be imported at a time.

Importing Export Files

In addition to documents, The Journal can also import a wide variety of export files, including export
files created by other software, such as Evernote and Penzu.

The Journal export files (.TJEXP, .TJXML, .JNX, .JNL)
Evernote (.ENEX)
Penzu (.XML)
ATOM publishing format (.XML)
WordPress export (.XML)

As you can see, a number of export files use the .XML file extension. The Journal opens the XML file
and determines the type of export it contains.

The Journal export file types (.TJEXP, .TJXML, .JNX, .JNL) bring up the Import Entries form, allowing
you to choose which categories and entries to import. The other file formats prompt you for the
category you wish to import into and import all the entries in the file.



The Journal Reference 111

© 1996-2014 by David Michael

If the category you are importing into already has entries, The Journal will verify every entry before
importing it. If an entry already exists in the category, and the current entry is identical to the entry
being imported, the current entry is kept. If the entry being imported is different from the current entry,
though, you will be prompted for proper handling. You can choose to either import the new entry
(overwriting the existing entry), keep the current entry (discarding the import entry), or keep both
entries.

See also: Batch Entry Import and How do I import my entries from Evernote, Penzu, or WordPress?

5.6.4 Import Entries

This form is used for The Journal's export files (.TJEXP, .TJXML, .JNX, .JNL), as well as export files
from Evernote (.enex), Penzu (.xml), and WordPress (.xml).

Select Categories/Entries to Import

Check a category to import that category and all of its entries, including any sub-categories.

You can also expand a category to select one or more specific entries to import.

Entry Preview

When you click on an entry in the tree, the content of the entry is displayed here.

Import

If you have checked any categories or entries, only those categories and/or entries will be imported.

If you check nothing, all categories and entries in the export file will be imported.

For each category being imported, you will be prompted to use an existing category (if you already
have a category with the same name of the same type) or to create a new category. It is also possible
to skip a category during the import.

If the category you are importing into already has entries, The Journal will verify every entry before
importing it. If an entry already exists in the category, and the current entry is identical to the entry
being imported, the current entry is kept. If the entry being imported is different from the current entry,
though, you will be prompted for proper handling. You can choose to either import the new entry
(overwriting the existing entry), keep the current entry (discarding the import entry), or keep both
entries.

5.6.5 Importing Entries from Other Journal Software

Many people, myself included, have kept their personal journals using other software.

There are a couple of ways of importing these previously existing entries. Which method to use
depends on your circumstances: which software was used, how the entries are saved, etc.

Some software, such as Evernote or Penzu, can create export files that The Journal can read. See 
Importing Entries and How do I import my entries from Evernote, Penzu, or WordPress? for more
information. Most other software, though, will require you to use one of the processes described below.

Batch Export/Batch Import
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The most convenient method is to use the other software's export capability and The Journal's import
features.

1. Create a temporary folder on your hard drive.

2. Export your entries from the other software into individual text (.txt), rich text (.rtf), or HTML (.htm;.
html) files. Export to the temporary folder you created in #1. If the entries are for a particular day, make
sure the date is used in the name of the exported file. The best date format will use a 4-digit year, a 2-
digit month, and a 2-digit day.

Example:
1993-10-05.rtf (entry for 5 October, 1993)

3. Once you have the entries exported, start The Journal. On the File menu, Import sub-menu, choose
"Batch Entry Import..." to import the entries into The Journal.

4. Under "The entries to be imported are:" choose "Each in a separate file (one entry per file)".

5. Choose the category you want to import the entries into (like "Daily Journal").

6. Browse to the temporary folder where your exported entries are.

7. Set the "Specify Date Format" to match how the export named your entries.

Example:
yyyy-mm-dd.rtf

Then do the import.

See Batch Entry Import for more information.

Copy-and-Paste Method

If the software you were using does not support exporting files, but was a Windows program, then this
method will work. It's not the most efficient method, but it's the same way yours truly (the author)
"imported" 3 years of entries made in Microsoft Word documents (one document per month).

1. Launch both the original software and The Journal.

2. In The Journal, select the Category to receive the imported text. Then use the calendar and choose
the appropriate entry date, or create the new entry.

3. Use the Windows Taskbar (or Alt-Tab) to bring up the original software.

4. Select the text in the original software that you wish to import into The Journal, and then copy the text
to the Windows clipboard (Edit | Copy).

5. Use the Windows Taskbar (or Alt-Tab) to bring up The Journal and paste the text in the active entry
(Edit | Paste or Ctrl-V).

6. Repeat until all of the desired entries from the old software have been entered into The Journal.
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5.6.6 Batch Entry Import

Many journal software products support exporting your entries in that software to a collection of text (*.
TXT), rich text (*.RTF), or HTML (*.HTML) files. With the Batch Entry Import form (on the File menu,
Import sub-menu), you can import those files directly into The Journal.

Batch Entry Import can also import entries that are all in the same file in the following formats:
Simple CSV (comma-separated values) (Format: "Date/Time","Entry Text")
DayNotez CSV file
750words.com export file
Cumberland Diary export file
WordPress export file (.xml) - both posts and pages
Evernote export file (.enex)
Penzu export file (ATOM publishing format) (.xml)
Diaro export file (text entries only) (.xml)
Lotus Organizer CSV file
Orange Diary Pro CSV file

If you need support for another export file format, contact DavidRM Software: support@davidrm.com

WordPress NOTE: When importing a WordPress export file, if a post includes <img ... /> tags, The
Journal will attempt to download those images and insert them into the entry.

Evernote NOTE: The Journal will attempt to load most types of files attached to a note: images (PNG,
JPG, etc), applications (PDF's, docs, etc), and media files (audio & video).

Importing into a Calendar Category

To be imported into a calendar category, the entry files must all use a standard naming convention. The
date of the entry must be included in the file name. The best date format will use a 4-digit year, a 2-digit
month, and a 2-digit day.

If the entries you are importing have a timestamp, that should be specified, as well. Use the 24-hour
clock for the time stamp, 2-digit hour (00-23), a 2-digit minute (00-59), and (optionally) a 2-digit
seconds (00-59).

Example:
2001-05-01.RTF (entry for 1 May, 2001)

This would need a format of: YYYY-MM-DD

Example with a timestamp:
2007-08-16 16-24-00.RTF

This would need a format of: YYYY-MM-DD HH-NN-SS

NOTE: Dashes (-) were used instead of colons (:) in the timestamp, because colons aren't valid in file
names.

You can also import files with long (December) and short (Dec) month names in the name.

Example with long month names:
2006 October 26.RTF

To import those files, you would need to set the date format to: YYYY MMMM DD

mailto:support@davidrm.com
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MMMM = long month name
MMM = short month name

Importing into a Loose-Leaf Category

When importing into a loose-leaf category, no special naming convention is required. The name of the
imported entry file will be used as the name of the entry.

Remove file extension from imported files - Check this option to remove the file extension when
naming the entries.

5.6.7 Synchronizing The Journal

Keeping two (or more) installs of The Journal synchronized (in sync) is simple, and can be done a
variety of ways.

You can sync The Journal from any of the following:
A backup file created by The Journal (.JBACKUP).
A Journal Volume folder on an external hard drive.
A Journal Volume in The Journal.
An export file created by The Journal (.TJEXP, .TJXML, .JNX, .JNL).

In each case, the steps are the same:

1. Click on the File menu, Import sub-menu, and choose the appropriate "Sync from ..." command.

2. Select the Journal Volume, or browse to select the file or folder you're syncing from.

3. Select what you want to sync/import.

4. Map categories from the sync file to the categories in The Journal.

5. Review and resolve any conflicts in your entries, reminders, images, topics and text styles.

6. Run the synchronization.

NOTE: When syncing from a backup file, The Journal creates a temporary Journal Volume restores the
backup file into that Journal Volume. If the backup is from an earlier version of The Journal, this Journal
Volume will need to be upgraded before the syncing can happen. If that happens, you will see
notifications. When the syncing process is finished, this temporary Journal Volume is deleted. The
backup file is not affected or updated in any way.

Example 1. Syncing The Journal from Work to Home

You have The Journal installed on your laptop at work and your desktop at home, and you want to keep
them in sync.

NOTE: This process takes longer to describe than to actually do. So don't panic. :-)

1. On your work laptop, run The Journal and create a backup file. File, Maintenance, Backup The
Journal...
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2. Copy the backup file you created to a USB/Flash drive or email the file to your home address.

3. On your home desktop, run The Journal and log in.

4. Click on the File menu, Import sub-menu, and choose "Sync from Backup File..." Browse to select
the backup file. If your login has a password, you will be prompted for that. If you have more than one
login, you will be prompted which one to sync from.

5. The first step of the sync process is to choose what you want to sync:
Categories & Entries
Reminders
Topics
Images (entry backgrounds and calendar charms)
Text Styles

By default, all of these options are checked.

6. If you are syncing categories and entries, the next step is to "map" the categories in the backup to
the categories you already have. The Journal attempts to do this for you automatically. By default, if a
matching category exists, it is automatically mapped. If a category in the backup does not have a
matching category in The Journal, it will be set to be created and copied. You can change the mapping
of categories and/or you can choose *not* to import certain categories by un-checking them in the list.

7. Once the categories are mapped or set to copy, the sync process will analyze all the entries in the
mapped/selected categories for conflicts. Conflicts only happen if the same entry is in the backup file
*and* already in The Journal. In this case, The Journal inspects both the entry in the backup file and
the entry in The Journal. If the two entries are identical, there is no conflict. If the entries are different in
some way, how they are different is reported.

8. If there are entry conflicts, you will need to resolve them. What this means is that for each entry
conflict, you have to choose one of the following:

Import the entry from the backup file, overwriting the current entry; or
Keep the current entry (discarding the entry in the backup file).

NOTE: If the actual content of the entries have a conflict, you have an additional option. You can view
the two entries side-by-side and edit the current entry manually.

9. If you have any reminder conflicts, you will need to resolve those.

10. If you have any image conflicts, you will need to resolve those.

11. If you have any text style conflicts, you will need to resolve those.

12. The last step is the actual syncing. Up until now, and even now, you can choose to exit the sync-ing
process and nothing is changed or updated. Once you press "Sync", though, all of the changes begin
and cannot be interrupted.

NOTE: The first time you go through the syncing process is usually the longest and most involved. You
may to map categories and resolve a lot of conflicts. After that, though, you can usually just click Next,
Next, ... Sync and you're done.

To sync the work laptop from your home desktop, you do the same thing, but sending a backup file
from home to work.
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Example 2. Syncing The Journal from USB to Desktop

You have The Journal installed on a USB/Flash drive and your desktop at home. You normally keep the
USB drive with you so you can access The Journal from any Windows computer, but you also want all
the same categories and entries on your desktop at home.

1. Insert your USB drive into the desktop computer.

2. Run The Journal on your desktop computer and log in.

3. Click on the File menu, Import sub-menu and choose "Sync from External Journal Volume..." Browse
into the folder on your USB drive that has your Journal Volume. The default path is:
Z:\The Journal 6\The Journal Volumes\6\My Journal\

4. Follow steps 5-12 in Example 1 (above).

5.7 Images & Media

The Journal lets you include images of all sorts in your entries: digital photos, animated graphics, and
icons (like Calendar Charms). You can also set images as backgrounds for your entries, much like you
can with a Web page.

Beyond images, The Journal also lets you include audio and video files in your entries. Audio and video
files are called "media files".

Read more about using images in The Journal:

Using Images in Entries
Entry Background Images
Creating Your Own Borders
Calendar Charms
Creating Your Own Calendar Charms
Loading Images

Read more about using media files in The Journal:

Inserting Media Files into Entries
Playing Media Files

Inserting Objects into Entries

5.7.1 Using Images in Entries

Inserting Images

To insert images in your entries:

Click on this icon on the toolbar:

 
Or click on the Insert menu, and choose "Insert Image..."

You can also drag images from Windows Explorer and drop them into your entry.
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Resizing Images

When you first insert an image into your entry, the image is resized to fit the entry editor. Click and
drag on the edges of the image to resize it.

If you would prefer to view the image at full size, right-click the image and choose Toggle Image Full/
Fit Window.

You can also double-click the image to toggle full size and back.

Image Descriptions

Images can be given descriptions. These descriptions are displayed when you hover the mouse over
the image. Also, you can do searches of image descriptions.

To give an image a description, or to edit an image's description:

1. Click on the image to select it.

2. Click on the Edit menu, and choose Edit Image/Object Description (hot-key: Ctrl+Shift+D).

Searching Image Descriptions

To search through the descriptions of all images in The Journal:

1. Click on the Search menu, and choose Search Entries... (hot-key: Ctrl+Shift+F)

2. Enter the word or words you want to search for in Text to Search for.

3. Un-check: Search entry text, Search entry names and Search reminder names and notes (this
will force the search to look only in image descriptions).

4. Click on Search.

5.7.2 Doodling in Entries

The Journal includes a simple graphic editor so you can doodle in your entries, and even doodle on
other images. The doodler supports drawing lines and simple shapes, flood fill, and even typing text. The
doodler also has an undo and redo, though those only work within the current entry. If you select
another entry, the doodle is saved in its current state, with no further undo/redo possible.

Doodles in your entries look and act like normal images. You can print them. Copy-and-paste them.
Even change their layout properties (so text will wrap around them, for example).

Inserting a Doodle

To insert a doodle in your entry:
Click on the Insert menu and choose "Insert Doodle".

Click on the doodle to begin drawing.
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Click and drag on the edges of the doodle to resize it. NOTE: If you resize a doodle *smaller*, you will
lose the portion no longer visible. It is possible to undo a resize.

Move your mouse over the color selector (in the upper right corner) to see the full range of colors
available.

When you select a new doodling tool (paintbrush, shape, etc), the options for that tool appear above it.
After 5 seconds, the options will disappear to get out of your way. You can bring them back at any time
by clicking on the tool button again.

Doodling on an Image

Right-click on the image you want to draw on, open the Image sub-menu, then choose "Doodle on
Image".

Converting a Doodle to an Image

Right-click on the doodle, open the Doodle sub-menu, then choose "Convert Doodle to Image".

5.7.3 Entry Background Images

There are two primary types of entry background image: borders and backgrounds.

Borders are graphics that run along the borders (left, top, right, and/or bottom) of the entry editor.
Example:

Backgrounds are visible behind the whole entry, not just along the borders. Example:

Setting the Entry Background Image

To set the background of the current entry: Click on the Format menu, find the Background Image
sub-menu, and choose the background you want to use.

You can also set the entry background image to:
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Default - use the background image specified by the category (in Category Properties on the Entry
Text Style tab), or the global setting (in User Preferences on the Editor tab).
No Background Image - forces the entry to have no background image. This overrides the category
and global settings.

The Journal includes a number of entry background images, but you are not limited to those. You can
create your own.

Creating Your Own Borders

5.7.4 Creating Your Own Borders

Borders are simple to create, especially if you limit your borders to the left hand side of the entry.

1. Select or create a small pattern that repeats itself vertically (like the daisy on green pattern above).

2. Extend the image to the right with solid white (or other color) to a width of at least 1500 pixels. If you
have a high-resolution display, you might want to extend to 2000 pixels or more.

3. Save the image to a JPEG (.JPG) or a PNG (.PNG) file. Both JPEG and PNG images are
compressed, so they take up a lot less space in The Journal's database.

Loading Your Border Image

1. In The Journal, click on the User menu and choose User Images...

2. Click on Load Image, and browse to select your new image.

3. Set the image type to: Background Image

4. Set the "Position" to: Tile

5. To make sure that the entry text doesn't overlap the border pattern, click on Margin Offsets...

6. Un-check: Equal Values

7. In Left enter the number of pixels wide the pattern is (the daisy pattern above sets the left margin to
30).

And that's all there is to it!

Once you have added the image, you can make it a default background in your categories (in Category
Properties on the Entry Text Style tab), or apply it to specific entries (Format menu, Background
Image sub-menu).
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5.7.5 Creating Your Own Backgrounds

Creating your own backgrounds is at once simpler than borders and more complicated. Simpler
because if you use a digital photo then you don't have to worry about the image tiling (though you could
still do that), and more complicated because you have to make sure you can read text against the
background.

Here are some hints for creating your own background images:

Open Space is Good - If you are using a digital photo, pick one that has a lot of open space in the
middle of the image. Pictures of the sky and ocean or simple textures like wood are good examples.
You can have palm trees or other objects along the left side and/or bottom to set the location and the
mood, but try to keep the middle clear.

Keep it Simple - Expanses of sky and water are very simple backgrounds, making it easy to read
text against them. If you really must have that brook bubbling over many-colored rocks, then:

Experiment with Masking - Most image handling software (free example: Paint.NET) will allow you to
mask or "washout" images making them seem dreamier or more cloud-like. This can make it much
easier to read text over those images. Or: 

Experiment with Font Colors - Maybe if you switch away from dark/black fonts to lighter/white fonts
you will be able to read text shown over the image.

Use JPEG Images - You can use either Windows Bitmap file (*.BMP), PNG images (*.PNG), or
JPEG compressed files (*.JPG) for your backgrounds. JPEG files are usually much more compact
(especially if you are using a digital photo), so you should choose that format when you can.
Fortunately, most digital cameras create JPEG files automatically.

Also, check out the many free stock image sources on the Web, including:
http://www.sxc.hu
http://www.photoxpress.com

Loading Your Background Image

1. In The Journal, click on the User menu and choose User Images...

2. Click on Load Image, and browse to select your new image.

3. Set the image type to: Background Image

4. Set the "Position" to: Center

http://www.getpaint.net
http://www.sxc.hu
http://www.photoxpress.com
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5. If you want to adjust the text margins, click on Margin Offsets...

6. Check: Equal Values

7. Set the offset you want from the edges of the entry editor (most of the time, you will use values from
10-50).

And that's all there is to it!

Once you have added the image, you can make it a default background in your categories (in Category
Properties on the Entry Text Style tab), or apply it to specific entries (Format menu, Background
Image sub-menu).

5.7.6 Calendar Charms

Calendar Charms are small icons that you can use to mark special entries. Mark good days, mark bad
days, mark appointments, mark holidays, and more.

Calendar Charms are displayed on the calendar, as well as in the "entry tree". Every entry can be
marked with a Calendar Charm, in calendar categories and even in loose-leaf categories.

Calendar Charms can also be inserted into your entries as you type much like emoticons (or very small
clip art).

Setting (or Changing) an Entry's Calendar Charm

Menu: Entry | Entry Calendar Charm
Hot-key: Ctrl+F2

Removing an Entry's Calendar Charm

To remove the Calendar Charm from an entry, do this:

1. Bring up the Set Entry Calendar Charm form (Ctrl+F2).
2. Click on Clear.

Inserting a Calendar Charm in an Entry

Menu: Insert | Insert Calendar Charm
Hot-key: Shift+F2

5.7.7 Creating Your Own Calendar Charms

Calendar Charms can be single images, but are most often collections of small icons arranged in a grid.
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Here are some tips for creating your own Calendar Charms:

Grid layout - Arrange the icons in a simple grid (don't actually include grid lines), with every icon the
same size.

Think small - If you want to use the icons on the calendar (instead of just inserting them into your
entries), it's best if you limit your icons to 16x16 pixels or 24x24 pixels. Larger icons will be reduced
to fit the calendar, and they may not look as good.

Transparency - Calendar Charms are assumed to be transparent. If you use the PNG image format,
you can use the alpha channel to create transparency (and other special effects like anti-aliasing). If
you use BMP or JPEG images (or PNG images with no alpha channel), the color at pixel position
(0,0) will be made transparent when the icon is inserted or used on the calendar. The best
transparency colors are very bright and obviously not part of the image (like fuchsia in the example
above).

Use PNG Images or BMP images - When you create your Calendar Charms, save them as PNG
images (*.PNG)  or Windows Bitmap files (*.BMP). This way your images (and your transparency)
remain crisp.

Loading Your Calendar Charms

1. In The Journal, click on the User menu and choose User Images...

2. Click on Load Image, and browse to select your new image.

3. Set the image type to: Calendar Charms

4. Set the "# of Charms Across (X)" to: (the number of icons across)

5. Set the "# of Charms Down (Y)" to: (the number of icons down)

And that's all there is to it!

When you go to set an entry's calendar charm (hot-key: Ctrl+F2) or insert a calendar charm in an entry
(hot-key: Shift+F2), drop down the list of Calendar Charm Collection and choose your new charms
from the list.

5.7.8 Inserting Media Files into Entries

You can insert most types of audio and video files into your entries:
audio - wma, wav, mp3, mid, midi, ra, ram
video - wmv, mpg, mpeg, avi, mov, rm

Inserting Media Files

Click on this icon on the toolbar:

Or click on the Insert menu, and choose "Insert Media File (Audio/Video)..."
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You can also drag images from Windows Explorer and drop them into your entry.

An attached audio file shows this icon:

An attached video file shows this icon:

NOTE: Some media files are very large. Media files larger than 10 MB will cause your entries to load
and save slower. Media files larger than 50 MB may not perform well when stored in The Journal.

Also note: The Journal relies on Windows for media file playback. If you are using Windows XP, it's
possible that not all types of media file listed above will play.

Playing Media Files

To play a media file, doubleclick on its icon. This will start the Windows Media Player (or The Journal's
built-in media player if the Windows Media Player is not available).

5.7.9 Inserting Objects into Entries

Beyond images and media files, almost any kind of Windows file (like word processor documents,
spreadsheets, and more) can be inserted into an entry.

Click on the Insert menu and choose "Insert Object..."

Objects can be inserted as links to the files on your hard drive or network, or copied (embedded) into
the entry.

5.8 Journal Volumes

A Journal Volume is an "entry database" for The Journal. A Journal Volume can contain one or more
user logins and all of their categories and entries.

Journal Volumes can be placed on any available hard drive, internal or external or network attached, or
even removable thumb drives. Each Journal Volume must have a unique name.

The Journal supports multiple Journal Volumes, each in a unique folder. However, most users of The
Journal will only need a single Journal Volume.

By default, The Journal places all Journal Volumes in:
My Documents\The Journal Volumes\6\

If you are installing The Journal on a USB/external hard drive, the default path is relative to the installed
path:
.\The Journal Volumes\6\
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5.8.1 Journal Volume Properties

You can view or edit the properties of your Journal Volumes by clicking on the File menu, finding the
Journal Volume sub-menu, and choosing "Journal Volume Properties..."

General

Name - This is the name of the Journal Volume. This name is also the name of the folder where the
Journal Volume resides.

Auto-load when The Journal starts - If checked (the default), the Journal Volume is opened and
loaded when The Journal starts up. If this option is not checked, you can still open the Journal Volume
by clicking on the File menu, finding the Journal Volume sub-menu, and choosing "Open Journal
Volume..."

Exclude from automatic backups - If checked, the Journal Volume is not backed up during an
automatic backup (for example, when closing The Journal). This property does not affect manually
started backups.

The path to the Journal Volume is displayed, as is the date of the last backup (if any).

Security

No new users can be created in Journal Volume - While this option is checked, no new users can
be created in this Journal Volume.

Journal Volume is Read Only - Check this option to make the entire Journal Volume "read only". This
prevents the creation of new users, new categories, and new entries.

5.8.2 Delete Users

To remove a user from the current Journal Volume, you must be able to provide the user's password.
The user and all of her categories and all of her entries in those categories will be deleted.

Deleting a User

1. Click on the File menu, find the Journal Volume sub-menu, and choose "Delete User(s)..."

2. Choose the user login name to delete.

3. Enter the user's password.

4. Click on Delete. You will be asked to confirm the delete one more time before it actually happens.

NOTE: Once deleted, a user CAN NOT be recovered (except by restoring from a backup or syncing
from a backup).

5.9 Links

The Journal supports hypertext-style links in document entries.

The easiest way to use links in The Journal is to click on this toolbar icon:
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Or click on the Insert menu and choose Insert Link...

There are three types of link: entry links, file links, and Internet links. Entry links are links to another
entry in The Journal. File links are links to files on your PC, or on your local network. Internet links are
links to web pages or email addresses.

Similar to a web browser, The Journal allows links to have a "tag" that is displayed for the link. For
example, instead of displaying the entry link this way: entry:Daily Journal\\2008\12\07, the link could
have a tag such as "My Birthday Last Year".

The Journal supports both tagged and un-tagged links. Un-tagged links are usually typed in by hand.
The Journal detects these and highlights them as you type. You can click on the link and it behaves
normally.

Bookmarks are supported for linking to a particular location in an entry.

5.9.1 Entry Links

Entry Links are special "hyperlinks" in The Journal that allow "jumping" to another entry.

Entry links can be "tagged" to hide the link information behind more descriptive text. Entry links can also
point to bookmarks within the entry.

Linking to an Entry

The easiest way to link to an entry is to click on this toolbar icon:

Or click on the Insert and choose Insert Link...

This will bring up the Insert Link form:

Then click on the "Select Entry" button: 

And select the entry you want to link to:
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If an entry has bookmarks, those will be displayed beneath the entry in the tree.

5.9.1.1 Typing Out Entry Links

You can also type out entry links by hand (instead of using Insert Link on the Insert menu).

Typing out Links to Calendar Entries

To do that requires using the following format:

entry:Category Name\\Entry\Date
or:
entry:Category Name\\*

Category Name - the name of the category where the entry is located. If Category Name is omitted,
then the entry is assumed to be in the current category.

Sub-categories should be clarified by listing their parent categories first, separated by a backslash ("\").
If no path is given, then the first category with the given name is used.

Entry\Date - the date of the entry. The default format for entry dates in links is: YYYY\MM\DD (note the
use of backslashes instead of slashes).

Example:
entry:Daily Journal\\2009\07\18

Alternate Entry Date Formats

If you do not use the above format, then the date must be in a system-recognizable format. For users in
the US, the standard MM/DD/YY (or YYYY) format works (note the use of the forward slash in this
case). For users in the Europe, however, the format would (usually) be DD/MM/YY (or YYYY).

The date must consist of two or three numbers, separated by the character defined as the "date
separator" in your Windows Locale (in the US that's the slash / [forward slash] by default). The order
for month, day, and year is determined by the by your Locale as well (US default is m/d/y).

If the date contains only two numbers, it is interpreted as a date (m/d or d/m) in the current year.

NOTE: These are Windows Locale settings, and not related to the date format used in The Journal for
inserting dates.

Example:
entry:Daily Journal\\4/9/2001
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Current Entry Date - If an asterisk ( * ) is used in place of the entry date, then the entry link will jump
to the current entry date in the category.

Example:
entry:Daily Journal\\*

Typing out Links to Loose-leaf Entries

In a similar way, you can type in links to loose-leaf entries:

entry:Category Name\\Entry Name
or
entry:Category Name\\Entry\Path

Category Name - same as above.

Entry Name - the name of the entry. The entry name is not case sensitive. If a loose-leaf category has
multiple entries with the same name, then the first matching entry is used.

Entry Path - the name of the entry, including the names of any "parents" of the entry, separated by a
backslash ( \ ). For example:

entry:Notebook\\Recipes\English Muffins

"Notebook" is a loose-leaf category. "Recipes" is an entry with a sub-entry named "English Muffins".

Default Entry Link - If an asterisk ( * ) is used in place of the entry name or path, then the entry link
will jump to the current default entry in the category.

Typing out Links to Loose-leaf Attachments of Calendar Entries

The format for entry links to loose-leaf attachments (sub-entries) of calendar entries is a bit more
involved:

entry:Category Name\\Entry Date\\Attachment Name
or even:
entry:Category Name\\Entry Date\\Attachment\Path

Seriously: Just use Insert Link... ;-)

5.9.2 Bookmarks

Bookmarks in entries mark specific locations you can "jump" to, using the Go to Bookmark and Go to
Bookmark in Entry commands (on the Go menu) or with a link from another entry. Go to Bookmark
will take you to any bookmark in your journal. Go to Bookmark in Entry only takes you to bookmarks in
the current entry.

To insert a bookmark in an entry, click on the Insert menu and choose "Insert Bookmark..." You will
be prompted to give the bookmark a name. A gold star ( ) will mark the location of the bookmark in
your entry.

To remove a bookmark, right-click on the bookmark icon and choose Remove Bookmark (bookmark
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name). Or set the cursor to the beginning of the line with the bookmark, then click on the Insert menu
and choose "Remove Bookmark".

Bookmarks can make it easier to work with long document entries. Insert bookmarks at frequently
accessed locations, then use Go to Bookmark in Entry (on the Go menu) to jump from bookmark to
bookmark.

Bookmarks can also be used as link destinations. Entry links default to the top of the entry. By
specifying a bookmark, though, you can link to any line within the entry itself.

When WYSIWYG formatting is active, bookmarks are displayed as a dotted line across the page.

5.9.3 File Links

File links are links to files that on your PC or your local area network (LAN). When you click on a file
link, that file is opened.

The file link format is:
file://drive:\path\filename.ext

Examples:
file://C:\My Documents\Resume.DOC

If the file name or the path contains spaces, then you must use the Create/Edit Link form.

File links can be "tagged" to hide the link information behind more descriptive text.

When you click on the file link, the link is passed to Windows for activating. Whichever software you
have setup in Windows to open that kind of file will be opened.

5.9.4 Internet Links

Internet links are web page addresses, email addresses, and so on.

Supported Internet link formats are:
Web Pages (http://www.webpage.com, https://www.webpage.com, or www.webpage.com)
Email Addresses (mailto:davidrm@davidrm.com or davidrm@davidrm.com)

Also supported are FTP (ftp://), Gopher (gopher://), telnet (telnet://) and news (news://).

Internet links can be "tagged" to hide the link information behind more descriptive text.

5.9.5 Insert/Edit Link

The Insert/Edit Link form can be used for either entry links, file links, or Internet links.

The easiest way to create a link is to click on this toolbar icon:

Or click on the Insert and choose Insert Link... (hot-key: Ctrl+Shift+K)

This will bring up the Insert Link form:

http://www.webpage.com
https://www.webpage.com
http://www.webpage.com
mailto:davidrm@davidrm.com
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Link

This is the actual link information. For example:
entry:Daily Journal\\2009\07\18

Or:
http://www.davidrm.com

Link Tag

The link's "tag" is descriptive text that can be used to "hide" the actual link information. Only the tag is
visible, and clicking on the tag activates the link.

Using the examples above, valid tags would be:

Saturday, July 18, 2009

Or:

DavidRM Software Home Page

If no tag is specified, the link is inserted into the entry just as if it had been typed.

5.9.6 Typing out Links with Tags

You can type links that have a descriptive tag with this format:

[[link|tag]]

"link" can be either an entry link or an internet link. "tag" can be any single line of text (no ENTER).

After you type the closing ]], the typed out link will be converted to a tagged link.

Example:
[[http://www.davidrm.com/|DavidRM Software]]

5.10 Printing

The Journal supports a powerful collection of printing options. You can print a single entry, an entire
category, or a collection of entries from multiple categories.

Select Categories/Entries to Print

Active Entry
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Only the active entry will be printed.

Active Entry with All Sub-Entries

The active entry and all of its sub-entries will be printed.

Current Day (in all Calendar Categories)

The entry for the current date in all calendar categories will be printed. No loose-leaf entries will be
printed with this.

These Categories/Entries

Whichever categories or entries you select will be printed. Entire categories can be selected for
printing, or groups of entries spanning several categories.

NOTE: Only document entries and images can be printed by The Journal. External object entries cannot
be printed. You will need to use the native application of the external object to print it.

Headers & Footers

Print Page Header - If checked, all pages will include the header for either the category or user (if one
is specified).

Print Page Footer - If checked, all pages will include the footer for either the category or user (if one
is specified).

Print Category Header - If checked, the category name will be printed before the first entry in the
category.

Print Entry Header - If checked, all printed entries will be preceded by their entry name.

The page header and footer and the entry header are specified in User Preferences: Printing, or
Category Properties: Entry Text Style.

Page Breaks

Between Categories - If checked, a page break will be inserted after every category. NOTE: If no
pages breaks are to be inserted between categories, and there are multiple categories being printed,
then the page setups, headers, and footers for those categories will not be used. Instead the page
setup, header, and footer defined in User Preferences: Printing (if any) will be used.

Between Entries - If checked, a page break will be inserted after every entry. NOTE: If your entries
are short (less than one page), this option can result in a lot of paper being used.

Additional Options

Start Page Numbering With - By default, all printouts by The Journal begin with page number 1 (one).
If you would like the numbering to begin with a different number, you can specify that here. NOTE: If
you enter a "5", this option does not cause the printout to start at page 5. Rather, the first page of the
printout will be numbered "5" and the page numbers in sequence from there.
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Force Text to Black & White - If checked, all text is converted to black and white before printing.

5.10.1 Printing Headers and Footers

Headers and footers can be specified at the user level (see User Preferences: Printing) or at the
category level. If no header or footer is assigned to a category, then it uses the corresponding setting
of the user.

Headers and footers are functionally identical, and are configured using the same options. The only
difference between them is that one is printed at the top of the page (headers) and one at the bottom of
the page (footers).

Formatted text can be used in both headers and footers. This means you can use any TrueType font
you have on your PC, you can use bold, italic, etc., and you can specify that the text be aligned to the
left, right, or centered. An empty header or footer will not be printed.

With the use of Print Macros, the text of the header and footer can include pre-defined values such as
the page number, the category name, and so on.

When printing, the content of entries is printed within the margins set in the page setup (either at the
category level or the user level). The headers and footers, if selected, are printed within the space
above the top margin and below the bottom margin. If the header/footer is too large to fit that space,
then the margins are adjusted so the header/footer can be printed. Also, there is a minimum "gutter"
space between the bottom of the header and the top of the text (and the top of the footer and the bottom
of the text). This gutter is calculated based on the default font for the category.

Also, if the printer cannot print to the full size of the page, the margins may be adjusted automatically.

Default Header

<CATEGORYNAME/>

[Bolded category name print macro, default font, left aligned]

Default Footer

Page <PAGENO/>
Printed on <PRINTDATE/>

[Bolded page number print macro above the date printed, default font, both centered]

5.10.2 Print Macros

Print macros are used in the headers and footers. They are used as "place holders" for values that
replace them when the header or footer is actually printed.

Text formatting (font, bold, italic, etc.) that is consistent across the print macro within the header or
footer is applied to the result of the macro.

The print macros are only processed when used in a header or footer. Any macros included in an entry
are not processed, only printed.

Print Macros



The Journal132

© 1996-2014 by David Michael

<USERNAME/> - the "User Name" specified in User Preferences: Printing

<USERLOGIN/> - the user's login name

<CATEGORYNAME/> - the name of the category currently being printed

<ENTRYNAME/> - the name (or date) of the entry currently being printed

<PRINTDATE/> - the current date

<PRINTTIME/> - the current time

<PAGENO/> - the page number of the page being printed

NOTE: The <ENTRYNAME/> macro uses the name of the entry that is being printed whenever the new
page is started. If there are multiple entries printing on a single page, the name of the first entry printed
on the page will be used. This applies to both header and footer.

5.11 Reminders, Tasks & To-Do

With The Journal's reminders and tasks you can stay on top of your busy schedule.

You can create new reminders with a right-click on the date in the calendar above your entry tree (if
you’ve set it to be active in the category you’re viewing), or right-click the date in the day planner (if
you’ve set it to be active in the category you’re viewing) or go to the Tools menu and open the  New
Reminder sub-menu.

There are four types of reminder: appointments, events, tasks and special days.

Appointments

Appointments have both a date and a time, and you can choose to have The Journal popup a visual and
auditory prompt when it's time for the appointment, or up to 6 hours before hand so you can get an
early start.

Special Days

Special days are birthdays, anniversaries, and holidays that we all want to remember--but sometimes
those days sneak up on us, and even sneak past us.

Events

Similar to both special days and appointments, events can be daily, weekly, or monthly, and can even
occur at a particular time. The biggest difference between events and appointments is that events are
assumed to repeat on a regular basis (like the 2nd and 4th Wednesdays of each month, or every other
Friday).

Tasks

Tasks are a special kind of reminder. Like events, tasks usually repeat, either every day, every week,
etc. Tasks also have a status: active, done, skipped, canceled, or missed.
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5.11.1 Appointments

Appointments have both a date and a time, and you can choose to have The Journal popup a visual and
auditory prompt when it's time for the appointment, or up to 6 hours before hand so you can get an
early start.

You can create new appointment with a right-click on the date in the calendar above your entry tree (if
you’ve set it to be active in the category you’re viewing), or right-click the date in the Day Planner (if
you’ve set it to be active in the category you’re viewing) or go to the Tools menu, New Reminder sub-
menu, and choose New Appointment...

Date

You can click on the calendar to set the date of the appointment, select it from the dropdown calendar,
or type the date in by hand.

Time

You will need to type in the time of the appointment by hand. You can also optionally include an end
time for the appointment.

If you want an appointment without a specific time, use an Event instead.

Popup Reminder

By default, the reminder will popup at the correct time on the date of the appointment. If you would like a
popup reminder before hand, you can set that as well, up to 6 hours in advance.

You can also assign a particular sound file (*.WAV) to be played when the reminder pops up.

By default, appointments are one-time events. To create an appointment that repeats daily, weekly,
monthly, or even annually, create an event, or look in Advanced Reminder Options.

5.11.2 Events

Similar to both special days and appointments, events can be daily, weekly, or monthly, and can even
occur at a particular time. The biggest difference between events and appointments is that events are
assumed to repeat on a regular basis (like the 2nd and 4th Wednesdays of each month).

You can create new event with a right-click on the date in the calendar above your entry tree (if you’ve
set it to be active in the category you’re viewing), or right-click the date in the Day Planner (if you’ve set
it to be active in the category you’re viewing) or go to the Tools menu, New Reminder sub-menu, and
choose New Event...

This Date

You can click on the calendar to set the date of the event, select it from the dropdown calendar, or type
the date in by hand.

Events can also be set to happen every week on a particular weekday (Sunday-Saturday), every
weekday (Monday-Friday), on the weekend (Saturday & Sunday), or even every day. It's also possible
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to alternate, setting the reminder to be every other week or every other day.

More complex dates can also be set, including:
Any day (or two days) of the week.
Any weekday (or two weekdays) of the month.
Any day (or two days) of the month.
Any day (or two days) of the year.

Events set to a specific date are assumed to occur only once. Otherwise, events are assumed to
repeat. You can override both assumptions in Advanced Reminder Options.

Time

If you want to set a time for the event, you can type one in, as well as an end time for when the event
will conclude.

5.11.3 Tasks

Tasks are a special kind of reminder. Like events, tasks usually repeat, either every day, every week,
etc. Tasks have a status: active, done, skipped, canceled, or missed.

You can create new task with a right-click on the date in the calendar above your entry tree (if you’ve
set it to be active in the category you’re viewing), or right-click the date in the Day Planner (if you’ve set
it to be active in the category you’re viewing) or go to the Tools menu, New Reminder sub-menu, and
choose New Task...

Priority

You can give the task a priority, which is used when listing the tasks above the entry editor. The higher
priority tasks are listed first.

Task Status

You can set the task to be active, done, skipped, canceled, or suspended. The "missed" status is set
automatically. When you first create a task, it's set to "active".

Active - The task is considered in progress.

Done - The task is complete. If this is a recurring task, it will switch back to active automatically.

Skipped - The task is incomplete and has been skipped for the current period (day, week, month,
year). If this is a recurring task, it will switch back to active automatically.

Missed - The task was incomplete at the time of its due date and marked automatically as missed. If this
is a recurring task, it will switch back to active automatically.

Suspended - The task has been put on hold. If this task had been a recurring, it will not automatically
occur again.

Canceled - The task has been canceled. If this task had been a recurring, it will not automatically occur
again.
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The task keeps a history of its status (go to Advanced tab, then Status in the New Task or Edit Task).
This allows you to bring up a date and see those tasks for that date which were marked as done,
skipped, or canceled, as well as any tasks which were missed.

5.11.4 Special Days

Special days are birthdays, anniversaries, and holidays that we all want to remember--but sometimes
those days sneak up on us, and even sneak past us.

You can create new special day with a right-click on the date in the calendar above your entry tree (if
you’ve set it to be active in the category you’re viewing), or right-click the date in the Day Planner (if
you’ve set it to be active in the category you’re viewing) or go to the Tools menu, New Reminder sub-
menu, and choose New Special Day...

Birthday

For birthdays you can enter both the date of birth, and even the time of birth, if you so desire (and
know it).

If you know the year of birth, then the reminder for that birthday will be shown even when you're
reviewing past entries. If you don't know the year of birth, just use the current year, and the birthday will
show from this year forward.

For both birthdays and anniversaries, you can have the number of the birthday/anniversary displayed
with the reminder. Use "%yy" to display the simple year. Use "%yyth" to display the year like "1st",
"2nd", "17th".

Example:
My Birthday (%yy years old)

Displays as:
My Birthday (44 years old)

Example:
Jack Benny's %yyth Birthday

Displays as:
Jack Benny's 29th Birthday

Anniversary

Like birthdays, you can use the current year to be reminded from this year forward, or you can set the
actual year of the anniversary and see the reminder even in the past.

The default Calendar Charm for an anniversary is a bouquet of roses, but you can set that to any other
charm you wish, to remember anniversaries of all sorts.

See "Birthday" above for how you can display the year of the anniversary.

Example:
My %yyth Anniversary

Displays as:
My 20th Anniversary



The Journal136

© 1996-2014 by David Michael

Holiday

Holidays have a month and a day, and it's assumed you want to see the holiday every year, past or
future. If you want to set an effective date for a holiday, so that it doesn't show up before that date,
check out Advanced Reminder Options.

The drop down list of months includes information about some of the more common holidays, like New
Years, St. Valentine's Day, and Christmas. This information includes the month, day, and even a pre-
set Calendar Charm for that day.

5.11.5 Advanced Reminder Options

These advanced options are available for all types of reminders: special days, appointments, events and
tasks.

Name/Description

Every reminder needs a name. The name doesn't have to be unique, but it should convey the intent of
the reminder, since this is what you'll see most often.

For Birthday and Anniversary reminders, you use the %yy and %yyth macros to display the year of the
birthday/anniversary with the reminder. See Birthday in Special Days for more information.

Date/Time

Date - The date of the reminder can be a specific day, a repeating weekday or collection of days, or
some pattern of days within a week, month, or year.

Time - The time of the reminder can be a specific time ("Eye Exam @ 7:00pm"), a start and end time
("Interview @ 9:00am-10:00am") or any time during the day ("Our Anniversary"). If you want to have a
reminder popup at you, you have to specify a time for the reminder.

This Happens - A reminder can be a one-time occurrence, or it can occur every day, week, month, or
year.

Effective Date - The effective date determines when the reminder becomes active. For example, if you
create a reminder for your wedding anniversary, you can set the effective date to the date of your
actual wedding. Every year after that, your anniversary will show on the calendar. You can also set an
end date, after which the reminder will no longer occur.

Display

Calendar Charm - Every reminder can be assigned a Calendar Charm. Default charms are chosen for
the different types of reminders, but you can change them to be whatever you like.

Show Reminder on small Calendar - If checked, the reminder's Calendar Charm will be shown on the
category calendar. If the same date has multiple reminders, only the top 3 will be shown, overlapping,
on the calendar. Since the calendar can get cluttered very quickly, you might want to limit the number of
reminders that show on the calendar.
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Show Reminder

NOTE: The "Show Reminder" options listed here only apply when the day planner option is turned Off
(in Category Properties...).

Show Reminder above Entry - If checked, the reminder will be listed above the entry editor. You can
double-click the reminder when it's listed above the entry like this, and edit it.

That Day Only - If checked, the reminder will show above the entry only on the actual due date.

N Days Before - If checked, then the reminder will show above the entry for the specified number of
days before the due date. Use this option to get advance warning of a reminder coming due.

Until Completed/Canceled - If checked, the reminder will always show above the entry, until you
cancel (or delete) the reminder, or mark it as done.

Popup

Popup Reminder when Due - If checked, and if the reminder has a specific time it's due, a reminder
will popup in The Journal.

Popup Reminder N Minutes Before - If checked, a popup reminder will happen the specified number
of minutes before the due time. The popup will include an option for you to be reminded again.

Play Sound on Popup - The default sound is the Windows "beep". You can specify any sound file (*.
WAV) you want to be played when the reminder pops up.

Status

Priority - A reminder can be given a priority from 1 (highest) to 100 (lowest). This priority determines
how the reminder is sorted when listed above the entry editor.

"Done" Charm - You can specify a different Calendar Charm to display when the reminder is marked
as done. The default is to use the same charm all the time.

"Skipped/Missed" Charm - You can specify a different Calendar Charm to display when the reminder
is marked skipped, or is missed.

Status History - This is a listing of the reminder's status history. Most non-task reminders will show the
date they went active, and the date (if any) that they were completed. Task reminders, though,
especially recurring tasks, will accumulate a sequence of active, done, skipped, and missed statuses.
You cannot edit this information.

Categories

All Categories - If checked (the default), then the reminder is displayed, on the calendar, above the
entry, or both, in all categories.

Active Category Only - If checked, the reminder will be displayed only in the category active at the
time you created the reminder.
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These Categories - If checked, you can specify which categories to display the reminder in. Note that
in loose-leaf categories, like "Notebook", you can see reminders on the calendar for other days, but
you will only be able to see above the entry reminders for the current date.

Notes

You can enter text of any length in the reminder notes, just like a normal entry.

5.11.6 Day Planner

The day planner is your always there reference for all your reminders and can be set to display in any
of your categories above the entry editor (see "Show day planner with active reminders" option in
Category Properties). You can display your reminders just for today or for up to a week in advance. 

All your reminders in this period can be editing, deleted or new ones created in the day planner, by
right-clicking the reminders themselves.

The day planner can be scrolled or vertically expanded or reduced to give you a view of the reminders
set at particular times, if necessary.

5.11.7 View All Reminders

The "View All Reminders" form provides a list of all of your reminders, active, done, canceled, etc. The
reminders are categorized by their type: Appointment, Event, Task, or Special Day. The "All" tab can be
used to view all of your reminders of all types.

From this form you can edit, copy or delete reminders. Click on the reminder, then click on the button
to "Edit", "Copy" or "Delete" the reminder.

5.11.8 Daily/Weekly Reminder Report

Use the Daily/Weekly Reminder Report to view all of the reminders completed, canceled, skipped or
missed in a given date range: a day, a week, a month, a year, or any range at all.

Example:
You have various tasks that you want to perform daily. Each week you want to print out a report of how
you did the previous week. So you:
1. Click on the Tools menu, choosing "Daily/Weekly Reminder Report..."
2. Select Last Week.
3. Click on See Report.

All of the reminders that were completed, canceled, skipped or missed over the past week are listed.
You can review them and then print a report, if you want.

Show all Reminders from:

There are 6 pre-set date ranges you can use: Today, Yesterday, This Week, Last Week, This
Month, and Last Month.

If you need a specific date range, click on This Date Range and set the From and To dates
appropriately.

Look In:
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You can have the report created from the Active Category or All Calendar Categories. Or you can
choose These Categories and select the specific categories to look in. Only reminders that are tied to
those categories (or are global reminders) will be reported.

5.11.9 Exporting Reminders

If you need to transfer your reminders from one install of The Journal to another, do this:

1. Click on the File menu, Import sub-menu, and choose "Export Entries as File..."

2. Select "Reminders" from the list.

3. Select Export File Type: The Journal Export File (.TJEXP)

4. Export to a file.

5. In the other install of The Journal, click on File, Import, Import Entries...

6. Click on Import.

If you need to move your reminders from The Journal to another program, however, you will need to
use a CSV file.

The Journal supports exporting your reminders and tasks into a simple CSV (comma-separated values)
format that can be imported by other scheduling software, such as Outlook, Sunbird, Mozilla, etc.

Reminders are exported as discreet events. That is, properties such as weekly and monthly recurrence
are not exported. Instead, the reminder will be exported once for each time the reminder would occur
within the specified date range.

Start Date & End Date

These dates provide the range of reminders and task to export.

Which Reminders

Special Days - If checked, special days will be included in the export file. Un-check this option to
prevent special days from being exported.

Appointments/Dates - If checked, appointments/dates will be included in the export file. Un-check this
option to prevent appointments/dates from being exported.

Events - If checked, events will be included in the export file. Un-check this option to prevent events
from being exported.

Tasks - If checked, tasks will be included in the export file. Un-check this option to prevent tasks from
being exported.

5.11.10 Importing Reminders

Reminders can be imported from any software that supports the simple CSV file format used by The
Journal. This format was created some time back by other software manufacturers, and has become
something of a universal format.
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Reminders are imported as single events with a specific due date and time.

Some information exported from scheduler/planner software, such as required attendees, meeting
location, and so on, has no corresponding type of information in The Journal. However, in order to be
provide some degree of available of that information, they are imported and added to the "Notes" of the
reminder.

5.11.11 Export/Import CSV Format

The first line of the CSV file includes all field names in quotes. The data, one record per line, is all string
data.

Fields
[<<]   "Subject"      [>>]
[<<]   "Start Date"      [>>]
[<<]   "Start Time"      [>>]
[<<]   "End Date"      [>>]
[<<]   "End Time"      [>>]
[<<]   "All day event"      [>>]
[<<]   "Reminder on/off"   [>>]
[<<]   "Reminder Date"   [>>]
[<<]   "Reminder Time"   [>>]
   "Meeting Organizer"   [>>] (into Notes)
   "Required Attendees"   [>>] (into Notes)
   "Optional Attendees"   [>>] (into Notes)
   "Meeting Resources"   [>>] (into Notes)
   "Billing Information"
   "Categories"
   "Description"      [>>] (into Notes)
   "Location"      [>>] (into Notes)
   "Mileage"
   "Priority"      [>>] (into Notes)
   "Private"
   "Sensitivity"
   "Show time as"

[<<] Exported by The Journal.
[>>] Imported by The Journal.s

5.11.12 Missed Reminders

The Missed Reminders report is run automatically when you log into The Journal. This report displays
reminders that were missed or had their due dates/times pass since the last time you logged in.

5.11.13 To-Do Items (Checkboxes)

The Journal supports simple to-do items. They look a bit like task reminders, but they are created on-
the-fly in your document entries.

When to Use a To-Do Item

If you have a one-off chore you need to do today or in the next few days, a to-do item is perfect.
Create the to-do item, and check it when you're done.

For a recurring chore, something that happens every week or every month, a reminder (either a task,
event or an appointment) would be a better choice.



The Journal Reference 141

© 1996-2014 by David Michael

To Create a To-Do Item

Click on the Insert menu and choose "Insert To-Do Item (Checkbox)".

That will insert a checkbox into your entry. Whatever you type after the checkbox will be the description
of the to-do item.

The to-do item can be either active (un-checked) or done (checked).

To-do items are specific to the category where you create them, so each category will have its own to-
do list.

Seeing Active To-Do Items

Right-click on your category tab and choose "Category Properties..." On the "General" tab, check
the option: "Show active to-do items"

All active (un-checked) to-do items for the category will be displayed above the entry editor. NOTE: To-
do items for the current entry are not displayed.

Managing To-Do Items

You can check or un-check to-do items in the list. When you do, the state of the to-do item (checkbox)
is reflected in the entry where the to-do item was created. NOTE: If the entry is locked (read only) you
will be prompted to force the update or not.

You can also right-click a to-do item in the list and cancel it. The to-do item will remain un-checked in its
entry, but it will no longer show up as an active to-do item. To make the to-do item active again, go the
entry, then check and un-check it.

To-Do Item Report

The Entry Report Wizard (on the Tools menu) includes the "To-Do Item (Checkbox) Report".

This report will show you active items, done items, or both. You can run the report for any date range
on the active category (or all categories).

5.12 Security

The Journal's security is designed to be as complete as possible while still offering a high level of
convenience. Also, The Journal's security is scalable, so you only have to use as much as you need.

Security Features and Options:
Password protection
Entry encryption
Hide hot-key
Lock on minimize/hide
Auto-hide on idle
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The Journal also offers Extended Security, which must be purchased separately. Extended Security
provides more control over the login process, as well as makes The Journal's entry database that much
more difficult to "hack".

5.12.1 Levels of Security

Not everyone wants or needs the same level of security. The Journal's standard settings provide a
medium-to-high level of security, but if you want more security, or if you want the security features to
stay out of your way, The Journal can support you.

The level of security you will want to set is based on the level of threat you perceive and/or wish to
protect against. See the explanations for the different levels of threat that face an electronic journal in
the Levels of Threat help topic.

No Security

The Journal can support a near-lack of security if you want it to. With the Auto-Login option you can
have The Journal automatically log you in when it starts. See Auto-Login for more information.

The Journal also allows you to have a "blank" password.

Normal Security

By default, a user must be created with a password. This password has to be entered before that user's
categories and entries can be accessed.

All entries in The Journal are compressed and encrypted before they are saved.

The Journal can be quickly "hid" (minimized) with this hot-key: Ctrl+J

The Journal also has a "global" hot-key that you can use from any application under Windows: 
Ctrl+Alt+J

Additional Security

The Journal can be "locked" when minimized or hidden.

The Journal can automatically hide itself, locking itself if that option is also set, after a specified period
of "idleness". So if you get up and walk away from your PC, forgetting to hide and lock The Journal, it
will automatically do this for you.

See User Preferences: Security for more information.

Extended Security

For the Truly Paranoid, The Journal's Extended Security features provide a logical "next step" for The
Journal's built-in security. See Extended Security for more information.

5.12.2 Choosing a Good Password

Having a password is hardly useful if you don't pick a good one. Here are some guidelines for choosing
a good password (submitted by Bernard Beam):
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6-10 characters in length (don't always pick the same length).
Use mixed-case alphanumeric (a B c D ... 1 2 3 ...).
Try not to have more than 2 alpha characters in a row.
Try not to have more than 3 numeric characters in a row.
Don't use the correct spelling of a word.
When using numbers, use them for more than just substitutes for letters (1 for 'l', 3 for 'e', etc.).
Don't use the same password for multiple applications or purposes.
Change your password every 30-60 days.

In other words, "password1" is a particularly poor choice for a password. ;-)

A helpful mnemonic device is to select a phrase you will remember and use it as an acronym, for
example the phrase "I never forget to brush my gums" can create the password (In42bmg).

See Change User Password for more information.

5.12.3 Levels of Threat

All journaling software, including The Journal, faces the same kinds of "threats" to their security. These
threats range from "casual" access by novices to focused attacks by malicious hackers.

Casual or low level threats account for probably 90%-95% of the security issues faced by journaling
software. Fortunately, thwarting these requires very little effort from the developer. Medium level threats,
however, are a significant step up from low level threats, both in the training and technical knowledge
required to present these threats, and in the effort required to thwart them.

If a the journaling software can stop low level threats and medium level threats, then it has protected its
users from about 99% of potential "hackers".

High level threats represent dedicated hackers. They have the know-how and the tools necessary to
analyze the data and the program, finding weaknesses in one or the other to exploit.

Very high level threats are (mostly) limited to large corporations and governments. Unfortunately, there's
very little that can be done to thwart threats of this level.

Low Level Threats

Casual access to journal entries via the software.

This threat is simply someone starting up the software either by double-clicking its icon on the Windows
desktop or by selecting it from the Start menu, and then perusing your entries.

This is an easy threat to thwart: Simply require a password.

"Over the shoulder" reading of entries.

If you are working in your journal, and someone walks up behind you, they will often look at your
computer screen. This is more out of habit than deliberate attempt to see what you're doing, but it's still
a threat.

Most Windows programs have a minimize button on their main title bar, so you can minimize the
program quickly. Or you can click on the Windows taskbar and overlay another application's form.
Another option is to provide a "hot-key" combination that quickly "hides" the journal program (like The
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Journal's Ctrl+J hot-key).

Medium Level Threats

Intentional access of journal database files.

This threat requires a bit more understanding of computer software. Simply put, the hacker opens up
Windows Explorer and takes a look at the files used by the journal software. If he recognizes the
database software that is being used, it's a simple matter of downloading the necessary system utilities
and opening up the database.

To thwart this, the journal software can either use a non-standard or proprietary database format, or
encrypt all revealing information, storing nothing "in the clear".

Password "hacking" from personal information.

The hacker acquires a few pertinent personal details about you and attempts to guess your password
based on that. Most people choose very poor passwords, using the names or birthdays of loved ones--
or even their own name and birthday.

Thwarting this threat is more the responsibility of the user than the software. Choose passwords that are
not simple words, and that have little or no personal significance. If possible, incorporate one or two
non-alphanumeric characters into your password. See Choosing a Good Password for more tips about
passwords.

High Level Threats

Analysis of data stored in database.

In addition to using the standard database software to examine the user and entry information, the
hacker goes one step further and looks at the raw data that is stored using either a "hex viewer" or
another piece of specialized software. This type of analysis completely eliminates any advantage that
the developer might have gained by using a proprietary database format. In addition, simple encryption
schemes will be obvious and, therefore, quickly cracked.

Analysis of program code.

With sophisticated "debugging" and "tracing" software, the hacker examines the inner workings of the
software, looking for a way to bypass the entire security system of the software.

"Security by obscurity", which works well for low and medium level threats, is useless to combat high
level threats. The software developer has to anticipate this kind of analysis of both data and code.

The nature of journaling software, where you have to be able to get out what you put in, exposes certain
points of attack. An analysis of these points of attack is beyond the scope of this article, however.
Suffice it to say that it is vitally important for the software developer to be aware these inherent
weaknesses and do everything possible to make it difficult to exploit those weaknesses.

Very-High Level Threats

Advanced analysis of program code and data.
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At this level, you are now dealing with hackers who have lots of time, top-of-the-line tools, and probably
a good amount of funding. The software can be pulled apart and all of its "parts" identified by function.
And every bit of data can be extracted and run through state-of-the-art cryptography software.

At this level of threat, there's nothing anyone can really do for you. Any claims to the contrary should be
treated with extreme skepticism.

How Does The Journal Stack Up?

So how does The Journal stack up against these different threats?

Against low level and medium level threats, The Journal is more than adequate. The Journal offers
password protection and quick-hide hot-keys, as well as automatic hiding after periods of idleness.
Also, The Journal compresses and encrypts all entry information, and no potentially sensitive
information is stored "in the clear" in the database.

The Journal would give a high level threat a good run for his money, I believe, though it would eventually
succumb. The Journal's Extended Security, however, raises the bar significantly higher, possibly
beyond the resources most high level threats could bring to bear on the problem.

If you are facing a very-high level threat, then neither The Journal nor any other journaling software
currently available will be able to help you. In fact, at this level of threat, it's probably a bad idea to
commit anything to electronic form, as nearly all electronic data can be retrieved.

Fortunately, the individuals with the skill and resources sufficient to pose high and very-high threat levels
have other things to do than hack someone's journal, unless of course you are an international diplomat,
William "Bill" Gates, or have stored National Secrets on your computer. In these cases, your best bet is
to contact the CIA and inquire (politely) about top-of-the-line electronic systems security items.

All in all, The Journal represents an amazingly secure environment. And if you require an additional
level of security, The Journal's Extended Security can give you that.

5.12.4 Security Details

Here are the high-level details of The Journal's security algorithms.

Passwords

Passwords in The Journal are never stored in the database without being "hashed".

Passwords are hashed with the MD5 algorithm produced by RSA Data Security, Inc. This is a one-way
hashing algorithm, making it nearly impossible to guess the password from the hashed value.

Encryption

By default, entries stored in The Journal are compressed before they are encrypted. The compression
removes redundant information from the entry, making the encryption somewhat more secure.

Compression of entries uses the LZH5 compression algorithm (a Lempel-Ziv-Huffman algorithm)
programmed by South Pacific Information Services Ltd. This is very similar to the compression used by
the LHarc utility.
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Encryption of entries uses the Twofish block cipher designed by Bruce Schneier.

Encryption keys are created using the intervals between certain keyboard and mouse events. The event
intervals are measured in 1/1,000,000ths of a second over a period of time and provide a reasonable
amount of "entropy" to keep them from being predictable.

5.12.5 Extended Security

If you need a higher level of security than The Journal normally provides, then the Extended Security
option may be what you're looking for. The Journal's Extended Security must be purchased separately.

User Extended Security

A login name that uses Extended Security is significantly more secure than normal. See the Levels of
Threat topic for more information.

NOTE: A login with Extended Security active cannot have its password reset. If you lose your password,
there is absolutely nothing that can be done to recover it.

Extended Security: Global Options

5.12.6 Extended Security: Global Options

These options are only available if The Journal's Extended Security has been purchased.

Use Extended Security for User Name

When checked, this option adds an additional layer of security to that user's categories and entries.

NOTE: A login with Extended Security active cannot have its password reset. If you lose your password,
there is absolutely nothing that can be done to recover it.

Automatic Login Failure

With Extended Security, you can specify that all login attempts fail after a certain number of
consecutive failures.

For example, if someone is attempting to guess a user's password, then after the specified number of
failures, The Journal automatically fails all other attempts. The Journal doesn't even check the password
entered. The failure message is displayed, and The Journal prompts for the password once again.

This option functions regardless of whether Extended Security is turned on for a particular user. Setting
any non-zero (0) number of tries activates this option.

In addition, when this option is set to any value besides zero (0), the user will be shown the number of
unsuccessful login attempts when he logs in.

Minimum Wait Time (in minutes)

Once the automatic failure option has activated, the user will have to wait the specified minimum of
minutes before The Journal stops automatically failing attempts.
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5.13 Styles

The Journal styles allow you to assign pre-defined font and paragraph settings to a block of text.

The Journal automatically creates the following styles for you:

Heading 1, Arial 14pt bold, 12pt before-spacing, 3pt after-spacing

Heading 2, Arial 12pt bold-italic, 12pt before-spacing, 3pt after-spacing

Heading 3, Arial 12pt italic, 12pt before-spacing, 3pt after-spacing

These styles can be edited or even deleted. They are provided primarily as an example of what styles
are capable of.

You can create as many styles as you like.

If you change a style that is already in use, the change will be visible in any existing entries.

See Style Options for more information.

Apply Default Style

You can quickly apply the default style to a block of text by using the hot-key: Ctrl+<spacebar>

Or you can click on the Format menu and choose "Apply Default Style".

Apply Default Style (retain formatting)

Select a block of text, then click on the Format menu and choose "Apply Default Style (retain
formatting)".

This command sets the block of text to the default style, like Apply Default Style. But any text formatting,
like bold, italic, and so on is retained.

5.13.1 Creating New Styles

To create new text styles, click on the Format menu and choose "Styles..."

This brings up the User Preferences form on the "Styles" tab.

You can see your existing styles listed (with details) under "User Styles".

Click on "New" to create a new style.

You can also select a style in the list and click on "Copy". That creates a copy of the style that you can
then "Edit".

The many options available for styles are described here.
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5.13.2 Edit Styles

To edit your text styles, click on the Format menu and choose "Styles..."

This brings up the User Preferences form on the "Styles" tab.

You can see your existing styles listed (with details) under "User Styles".

Click on the style you want to edit, and then click on the "Edit" button.

The many options available for styles are described here.

Editing Standard Styles

You can also edit The Journal's built-in "standard" styles. The standard styles are:
Bullet style - the style for bullets.
Date style - the style used with the Insert Date command.
Entry Link Style - how entry links are displayed.
Internet/Email Link Style - how internet/email links are displayed.
Numbered list style - the style for numbered lists.
Outline style - the style for outline mode.
Time style - the style used with the Insert Time command.

You can see these styles in the list by checking the "Show Standard Styles" option (below the "User
Styles" list).

Changes to these styles will be reflected throughout your categories and entries.

It is recommended that you copy a standard style and then edit the copy.

5.13.3 Style Options

Style Name

Every style must have a unique name. You cannot change the name of the standard styles.

Style Hot-Key

Up to 10 styles can be assigned a hot-key. The available hot-keys are Ctrl+1, Ctrl+2, up to Ctrl+0.

Character: Font

The font setting determines which font is used for the style. This setting also determines the font's point
size, color, and any special effects (like bold, italic, etc) that are applied to the font.

Character: Background Color

The background color of the style determines the color that will be behind the text.



The Journal Reference 149

© 1996-2014 by David Michael

Style Options: Paragraph
Style Options: Override Options

5.13.4 Style Options: Paragraph

These style options affect the paragraph settings.

Apply Style to Paragraph Settings

This option must be checked for the style to affect the paragraph settings.

Edit Right-to-Left

If checked, the paragraph style is for right-to-left editing.

Background Color

The color to be displayed "behind" the entire paragraph (not just the text).

Style Options: Paragraph: Alignment & Indents
Style Options: Paragraph: Spacing
Style Options: Paragraph: Numbering/Bullets

5.13.5 Style Options: Paragraph: Alignment & Indents

Alignment

This setting determines whether the text affected by the style is aligned to the left, center, right, or
"block". The "default" alignment does not affect the alignment of the text when applied.

Apply Style to Indentation

This option must be checked for the style to affect the paragraph indentation.

Left and Right

These settings affect the indentation from the left and right margins of the entry.

These values can be specified in inches (" or in), centimeters (cm), or "points" (pt). Whichever form is
entered, the value is converted to the standard form (inches for US, centimeters for Metric).

Special

This indentation can be applied to the first line of the paragraph (First Line) or the following lines
(Hanging).

NOTE: If this setting is used on a style that also sets bullets or numbering (see below), this value
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overrides the "numbering indent" for lines after the first line of the paragraph.

5.13.6 Style Options: Paragraph: Spacing

Line Spacing

Line spacing for a paragraph can be single, 1.5, or double. This affects how the text is displayed, as
well as how it is printed.

Apply Style to Paragraph Spacing

This option must be checked for the style to affect the before and after spacing of a paragraph.

Before and After

These settings affect the line spacing before and after the paragraph.

These values can be specified in inches (" or in), centimeters (cm), or "points" (pt). Whichever form is
entered, the value is converted to the points.

5.13.7 Style Options: Paragraph: Numbering/Bullets

Apply Style

This option must be checked for the style to use numbering or bullets.

Bullet/Numbering Type

None: No numbering or bullets on the paragraph.
Bullet: Standard bullet list.
Numbers: Numbered list (1, 2, 3, ...)
Letters: Lower-case letters (a, b, c, ...)
Letters: Upper-case letters (A, B, C, ...)
Roman: Lower-case Roman numerals (i, ii, iii, ...)
Roman: Upper-case Roman numerals (I, II, III, ...)

HTML-Style Bullets

If checked, the bullets will use different characters for each indent level, like HTML.

Numbering Style

Partial Parenthesis: 1) 2) 3) ...
Period: 1. 2. 3. ...
Full Parenthesis: (1), (2), (3) ...
None: 1 2 3 ...

Indent
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This setting affects the indentation of the first line, after the bullet or number, and the rest of the
paragraph.

These values can be specified in inches (" or in), centimeters (cm), or "points" (pt). Whichever form is
entered, the value is converted to the standard form (inches for US, centimeters for Metric).

5.13.8 Style Options: Override Options

Use Default Font, Size, & Color

These settings forces the style to use the current category's default font, font size, and font color,
regardless of the style's font settings or font currently active in the entry.

Use Active Font, Size, & Color

These settings forces the style to use the current entry's active font, font size, and font color, regardless
of the style's font settings.

Blend with Active Font Effects (Bold, Italic, etc.)

This setting "blends" the style's font settings for bold, italic, underline, and strikeout with those of the
currently active font.

Apply No Font Formatting

This setting forces the style to always use the currently active font. This setting is useful for only
applying paragraph and numbering changes.

HTML Style

If checked, text with this style applied will export (to HTML only) '&', '<', '>', and multiple spaces as they
are.

This option is most often used when posting to blogs. Some blogs support special HTML-like tags. To
have those tags "passed through" to the blog as they are, apply a style with this option.

5.14 Tables

The Journal entries can include tables with a variable number of rows and columns. More than simple
grids, each table cell can contain formatted text with any number of paragraphs, including images and
even other tables. Tables can be nested to any depth. Further, table cells can be merged together to
create larger cells, both horizontally and vertically.
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Tables in The Journal follow the HTML model. In this model, every cell in a table has its own distinct
border on all four sides. In addition, the table as a whole has a border, distinct from the cells in the
table. You can change this default look, however, and make the tables appear to have a single line
border between cells.

Tables and cells can also have background images, and these background images can be centered,
tiled, stretched.

The contents of table cells can be aligned vertically (to the top, bottom or middle of the cell), as well as
horizontally (left, right, and centered).

Another advantage of the HTML table model is that widths of columns are calculated based on the widths
of individual cells. Widths of cells (and the table as a whole) can be defined as percentage of the visible
editor, or a specific number of pixels. The height of cells can be set to match the content of the cells, or
can be set to a specific number of pixels.

And, of course, you can change the width and height of the table and cells with the mouse.

5.14.1 Using Tables

There are many uses for tables! One of those is demonstrated in the sample template: "Food Log".

Uses for tables:
Arranging information in an easy-to-reference grid.
Controlling text and image layout.

Adding a Row to a Table

To add a row to a table (like the Food Log):
1. Click on a cell in the last row of the table.
2. Click on the Table menu, Insert sub-menu, and choose Insert Row Below.

Merging Table Cells

To merge table cells together:
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1. Select the table cells you want to merge.
2. Click on the Table menu and choose Merge Cells.

Using Tables for Text Layout

You can use tables to control the layout of text and pictures. For example, you can use a table to put
text beside a picture.

1. Click on the Table menu, Insert sub-menu, and choose Insert Table...
2. Number of Columns: 2
3. Number of Rows: 1
4. Size Table Manually: 100 percent
5. Click on the left table cell.
6. Insert the image.
7. Use the mouse to resize the left table cell to fit the image.
8. Click on the right table cell.
9. Enter the text to be beside the image.

Hiding a Table's Borders

1. Click on the table.
2. Click on the Table menu and choose Table Properties...
3. Click on Table Border...
4. Border Type: None
5. Click on Cell Borders...
6. Border Type: None

5.14.2 Insert Table

Number of Columns

The number of cells across the table (left-to-right).

Number of Rows

The number of cells down the table (top-to-bottom).

Table Layout

Autosize - The table is created as wide as the entry editor, with all columns the same size.
Size Table to Fit Window - The table is created as if you had entered "Size Table Manually" as "100%
percent".
Size Table Manually - You can set the table width to be a set number of "Pixels" or a "Percent" of the
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entry editor window.

Table Properties...

Click here to adjust the properties the table will be created with: fill color, cell padding, borders, and so
on.

Remember Table Size & Properties for New Tables?

If checked, the current settings are remembered for the next time you insert a table.

5.14.3 Table Properties

To set or change a table's properties:
1. Click on any cell of the table.
2. Click on the Table menu, bring up the Select sub-menu, and choose Select Table.
3. Click on the Table menu and choose Table Properties...

Width

A table's width can be set one of 3 ways:
As a percentage of the width of the document entry editor ("Percent").
As a specific number of screen pixels ("Pixels").
Using the mouse to click-and-drag the table wider or narrower ("Manual").

Fill Color

Tables can be either "Transparent" (showing the color of the entry), or any color of your choice. The
table's fill color is the default fill color of all of the table's cells (though each cell can have its own color;
see Table Cell Properties).

Cell Padding

Cell padding is the amount of space (in screen pixels) between the border of the table cell, and the
contents of the cell.

Cell Spacing

Cell spacing is the amount of space (in screen pixels) between the border of the table and the border of
the cells. It is also the amount of space between the individual cells.

Cell spacing can be broken down into vertical spacing between the table border and the cells, horizontal
spacing between the table border and the cells; and vertical and horizontal spacing between individual
cells. You can adjust these values by clicking on More... on the Table Properties form.

Image...
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A table can have a background image that is shown "behind" the table cells. The image can be tiled,
centered, or stretched.

Table Border...

You can set the color and highlight color of the table's border. You can turn off the border completely,
or have it displayed as sunken, raised, or flat.

Cell Borders...

You can set the color and highlight color of the table's cell borders. You can turn off the cell borders
completely, or have them displayed as sunken, raised, or flat.

Keep Table on a Single Page

The table will not be printed on multiple pages.

Count of Heading Rows

If the table is printed on two or more pages, these first rows of the table will be repeated as a header on
all pages.

See also:
How do I make my tables look like those in MS Word/WordPerfect/Etc?

Table Row Properties
Table Cell Properties

5.14.4 Table Row Properties

To set or change the properties of a row of a table:
1. Click on a cell in the row you want to change.
2. Click on the Table menu, bring up the Select sub-menu, and choose Select Row.
3. Click on the Table menu and choose Table Properties...
4. Bring up the Row tab.

Vertical Alignment

The vertical alignment of a table row can be set to either top (the default), center, or bottom.

This setting can be overridden at the cell level.

See also:
Table Properties
Table Cell Properties
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5.14.5 Table Cell Properties

To set or change the properties of a row of a table:
1. Click on a cell in the row you want to change.
2. Click on the Table menu, bring up the Select sub-menu, and choose Select Cell.
3. Click on the Table menu and choose Table Properties...
4. Bring up the Cells tab.

Preferred Width

This is the preferred width for the cell(s), in pixels or percents of table width. Cells can be wider than
this value, if required to display its contents without overlapping.

Height at Least

This is the minimum height for the cell(s), in pixels. Cells can be taller than this value, if required to show
all its contents.

Fill Color

This is the background color of the cell(s). This overrides the fill color of the table.

Image...

A table cell can have a background image that is shown "behind" the cell. The image can be tiled,
centered, or stretched to fit the cell.

Vertical Alignment

The vertical alignment of a table cell can be set to either top (the default), center, bottom, or default. If
set to default, the cell uses its row's vertical alignment.

See also:
Table Properties
Table Row Properties

5.15 Templates

Templates allow you to use standard forms or blocks of text in your entries. Writing and journaling
prompts, worksheets and forms, and "boilerplate" text are all possible with templates.

A template is either "simple" or "enhanced". Simple templates are inserted without any processing,
exactly as they were created. Any loose-leaf entry can be a simple template. Template entries are
displayed in the entry tree with a red "T" ( ) beside their name.

See Simple Templates and Creating Simple Templates for more information.

Enhanced templates provide many more options. Enhanced templates can be used to "create" entry text
that is then inserted into the current entry. An enhanced template can have one or more "sections" that
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can be selected (at random or in sequence). An enhanced template can use other templates (simple or
enhanced) or even files external to The Journal.

See Enhanced Templates and Creating Enhanced Templates for more information.

Inserting a Template

Inserting a template is the same, whether it is simple or enhanced. You choose Insert Template from
the Insert menu (or from the right-click context menu) and then select the template you want. The
selected template is then added to the current entry.

Default Entry Template

Each category can have a "default entry template".

The default entry template will be inserted into new entries. For calendar categories, this template will be
inserted into new entries for the current day (or week or whatever). For loose-leaf categories, the
template will be inserted into all newly created entries.

To set the default entry template for a category:

1. Right-click on the category tab and choose "Category Properties..."

2. Bring up the "Entry" tab.

3. Select the "Default Entry Template" from the list of available templates.

5.15.1 Simple Templates

Any loose-leaf entry can be a simple template.

When a simple template is inserted with Insert Template, the entire template entry is copied. All text
formatting is preserved.

To have an entry appear as a template in the Insert Template list, first select the entry. Then click on
the Entry menu, and choose Template Entry.

See Creating Simple Templates for more information.

5.15.2 Enhanced Templates

Enhanced templates are much more than just a text entry.

An enhanced template can have multiple "sections". When the template is inserted, only a single section
is selected and inserted into the entry. Which section is selected depends on how the template is setup.
It could be a random section, or the next section in the sequence.

With an enhanced templates ability to pull in other templates, simple or enhanced, they significantly
extend the "boilerplate" features of templates.

In addition, enhanced templates can use "scripting", such as VBScript or JavaScript, to provide even
more power. Scripting can prompt the user for information, or control the text that is ultimately returned.

Example uses of enhanced templates:
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Writing exercises, either in sequence or random
Journaling exercises
Inspirational quotes
Auto-generated notes and letters
Role-playing game (RPG) charts and tables

See also:
Creating Enhanced Templates
Enhanced Template Tags
Enhanced Template Script Variables

5.15.3 Enhanced Template Tags

<TEMPLATE {{METHOD="method"} {SCOPE="scope"}} {USE="useLanguage"}
{UNFORMATTED} {GLOBALVARSPACE="spaceName"}></TEMPLATE>

This tag must be the first non-whitespace of an extended template.

A single entry can include only one template.

Text in the document that is external to (follows) any defined templates is ignored.

METHOD specifies the default access method of the template. If unspecified, the default access method
is "sequence". Valid default access methods are "sequence" and "random".

SCOPE specifies how the "sequence" default access method stores the current point in the sequence.
Valid default scopes are "global" and "category". If no scope is specified, then "global" is used.

USE specifies the default "scripting language" used by <DECLARE> and
<EXECUTE> tags. If not specified, the default scripting language is "VBScript". Other supported
scripting languages are "JavaScript", "PerlScript", and "PythonScript". VBScript and JavaScript are
usually available so long as you have Internet Explorer 4 or higher installed on your PC. The availability
of PerlScript and PythonScript is beyond the scope of this document. Generally, you will need to
download and install special software to use those.

If UNFORMATTED is specified, the selected section of the template is forced to be unformatted. This
overrides any formatting specified in the section.

GLOBALVARSPACE creates a "named" set of global variables. This named set of global variables is
then available to any other template that uses it, as well. That is, global variables can then be used to
store data between templates.

<INCLUDE {ENTRY="entryName" {CATEGORY="entryCategoryName"}
{UNFORMATTED}}/>

<INCLUDE {FILE="fileName" {UNFORMATTED}}/>

<INCLUDE {URL="urlText" {UNFORMATTED}}/>

An included entry is specified external to any sections. By convention, included entries are generally
listed after any <DECLARE>'s with defined functions.
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CATEGORY is used to include entries in other categories. If not specified, the entry must be within the
current category.

Any <DECLARE>'s in the included entry are treated as though they were declared in the including
template.

<SECTION>'s in included entries are added to the template according to their order in the included
entry. Included entries can be specified before, after, between, and so on, sections that are in the "top
level" template.

If an included entry includes other templates (and so on), the sub-includes will be handled recursively.

Duplicate entry includes, at the top level and within a <SECTION>, will be ignored.

<INCLUDE FILE...> is used to pull text (with or without formatting) into a template or <SECTION>. The
file is assumed to be text or text-with-markup. If no path is specified, the file will be looked for in the
active folder and then the default Windows path.

If the file has a .TXT extension, it is assumed that it will be unformatted text.

If the file has a .RTF extension, it is assumed to be rich text. If UNFORMATTED is specified, the file will
be included without formatting.

<INCLUDE URL...> is used to pull the contents of a URL into a template or <SECTION>. The URL can
specify a Web page, or an image.

<INCLUDE> can be used externally to <SECTION>'s, as well as within <SECTION>'s. The inserted text
will replace the entire <INCLUDE ... /> tag.

<INCLUDE>'s external to a <SECTION> will be processed every time the template is accessed.
<INCLUDE>'s internal to a <SECTION> will only be processed if that <SECTION> is selected.

If the included file causes incorrect formatting, or otherwise causes an error, accessing the template
will cause an error.

<DECLARE {USE="useLanguage"}></DECLARE>

The <DECLARE> tag is used to define functions, procedures, and "global" variables that can be called
or accessed in other parts of the template.

<DECLARE>'s must be external to any <SECTION>'s. Thus, it is convention to place all <DECLARE>'s
at the beginning of the template.

An error in a DECLARE, for instance a syntax error in declaring a function or variable, will halt the
template.

Standard functions and procedures can be declared in a template with no sections. This template can
then be included in other templates. This allows a certain amount of "code re-use".

Variables declared in a <DECLARE> can be accessed by any <EXECUTE> in the template. However,
the value of the variable is not maintained from one <EXECUTE> to another.

If a template includes different <DECLARE>'s with different USE attributes, then each different scripting
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language will have its own "run state". Elements declared for one scripting language will not be available
for use in other scripting language <DECLARE>'s or <EXECUTE>'s.

<EXECUTE {USE="useLanguage"}></EXECUTE>

The <EXECUTE> tag allows the template to perform some processing as part of processing.

<EXECUTE>'s external to a section will all be executed prior to accessing any section of the template.
Template-level <EXECUTE>'s can return a block of text that is embedded in the template. Thus, these
<EXECUTE>'s can selectively add <INCLUDE>'s, <DECLARE>'s, and so on to the template.

<EXECUTE>'s can also be used inside sections. In that case, the <EXECUTE> is considered to have a
string-type result value (called "Result") that will be inserted into the section when the script is finished.
The text formatting of the initial <EXECUTE> tag will be applied to the inserted text. The inserted text will
replace everything between and including the <EXECUTE> and </EXECUTE>. Processing of the
template will begin again at the first position replaced. Thus, a <EXECUTE> could create further tagging
to be processed.

There are global variables that can be accessed from any <EXECUTE>, and any changes to those
variables are kept. These globals can hold just any kind of data. "Global[nn]", where nn specifies an
index into the global array.

An error in an EXECUTE, for instance a syntax error, will halt the template.

<SECTION {ID="id"} {BACKGROUNDIMAGE="userImageName"}></SECTION>

The section's ID can be a single integer, or a range of integers. A range is specified as "nn-mm", and
includes the values nn and mm. mm must be greater than or equal to nn. By convention, sections are
arranged in ID order, least to greatest.

If no ID is specified for a section, then it is given an automatic ID relative to its position in the list of
sections in the template, based on the last ID specified. So if the first section ID was given as 100, the
next would automatically be 101, and so on.

It is possible for "blank" spots to occur in a template, where there is no section tied to a particular ID. If
one of these blank sections is accessed by ID, nothing is returned.

Specifying a section which duplicates an earlier ID, or overlaps with a range specified for an earlier
section, will cause an error when accessing the template.

The section's BACKGROUNDIMAGE attribute overrides the template entry's background image (if there
is one). The background image must have been loaded into User Images (User menu, User Images...).
NOTE: You must use the full image name, including any extension (example:
BACKGROUNDIMAGE="journalpage.jpg").

If no user image by the given name exists, no image is used.

<SELECT ENTRY="entryName" {CATEGORY="entryCategoryName"}
{{METHOD="method"} {SCOPE="scope"} {DATA="data"}} {UNFORMATTED}/>

The SELECT tag can only be used within a section.
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CATEGORY is used to select templates in other categories. If not specified, the template must be within
the current template's category.

METHOD specifies the how the template picks a section to return. If unspecified, the default access
method is "sequence". Valid access methods are "sequence", "id", and "random".

"random" access uses each sections ID range to determine that sections chance of being selected. So
a section with a wide ID range has a better chance of being selected than a section with a single ID.

SCOPE specifies how the "sequence" access method stores the current point in the sequence. Valid
scopes are "global", "template", and "category". Default scope is "template".

"global" scope means that current sequence value is stored for the template being called. "template"
scope means that the sequence value is stored for the calling template and the template being called.
"category" means that the sequence value is stored for the calling category and the template being
called.

The DATA attribute is used by the "id" access method.

If UNFORMATTED is specified, then any formatting in the returned section is ignored.

<DATE {FORMAT="dd/mm/yy"}/>
<ENTRYDATE {FORMAT="dd/mm/yy"}/>
<TIME {FORMAT="hh:nn:ss"}/>

The text formatting of the date or time tag will be used on the inserted text.

DATE inserts the current system date. ENTRYDATE uses the date of the entry where the template is
being inserted into. In loose-leaf categories, ENTRYDATE functions the same as DATE.

If no FORMAT is specified, the Windows default setting for the date or time will be used.

The FORMAT's available include:

d, dd   Day of the month, example: 3, 03
ddd   Short day name, example: Tue
dddd   Long day name, example: Tuesday
m, mm   Month number, example: 6, 06
mmm   Short month name, example: Jun
mmmm   Long month name, example: June
yy   Short year, example: 03
yyyy   Long year, example: 2003
h, hh   Hour of the day, example: 7, 07
nn   Minutes of the time
ss   Seconds of the time
am/pm  Adds "am" or "pm" to the time.

&lt; - replaced with '<' during section access.

&gt; - replaced with '>' during section access.

&quot; - replaced with '"' (double quote) during section access.
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<LITERAL VALUE="string"/>
The literal quoted string is embedded in the template section replacing the LITERAL tag.

5.15.4 Enhanced Template Script Variables

The Journal provides some variables that can be used within the <DECLARE> and <EXECUTE> tags.

Result

If an <EXECUTE> is used inside a section the <EXECUTE> is considered to have a string-type result
value (called "Result") that will be inserted into the section when the script is finished. The text formatting
of the initial <EXECUTE> tag will be applied to the inserted text. The inserted text will replace everything
between and including the <EXECUTE> and </EXECUTE>. Processing of the template will begin again
at the first position replaced. Thus, a <EXECUTE> could create further tagging to be processed.

Globalnn

"Globalnn", where nn specifies an index 1-1000 into the global array. Example variable names are:
Global1, Global23, Global456, etc.

There are global variables that can be accessed from any <DECLARE> or <EXECUTE>, and any
changes to those variables are kept. These globals can hold just about any kind of data.

Normally, global variables are cleared after each use of a template. Specifying a GLOBALVARSPACE,
though, in the <TEMPLATE> tag, creates a set of global variables that are available from one use of a
template to the next, and even available to other templates. The variables in a GLOBALVARSPACE are
available until the user logs out of The Journal.

RandomValue

The "RandomValue" variable is read-only. RandomValue is a random floating-point value where:
0 < RandomValue < 1

This variable is provided because the random functions of some scripting languages are inadequate.

5.15.5 Creating Simple Templates

Any loose-leaf entry can be a simple template.

Creating a Simple Template

Here are the steps to create a simple template:

1. Create a loose-leaf entry to be the template (press F9, or Entry menu, Create New Entry sub-
menu, Document). The "Templates" category can be used for this, or any other loose-leaf/notebook
category you choose. Name the entry "My Template".

2. Enter the text to use for the template. Here is some example template text (between the "- - - - -"):

- - - - -
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Today I accomplished:

This made me happy today:

This made me angry today:

- - - - -

3. Now, to mark the entry as a template, click on the Entry menu, and choose Template Entry. The
entry's icon in the entry tree will now show a red "T" ( ).

Using "My Template"

1. Bring up the current date in your "Daily Journal" category, and scroll to the end of the entry, if
necessary.

2. Click on the Insert menu, and bring up the Insert Template sub-menu. Choose "My Template".

This will insert the text of "My Template" into the active entry.

5.15.6 Creating Enhanced Templates

This section will provide a short tutorial in creating enhanced templates.

Like a simple template, an enhanced template must be a loose-leaf/notebook entry marked as a
template. However, while a simple template consists of whatever text is in its entry, an enhanced
template must be properly constructed using the enhanced template tags.

An enhanced template can have one or more "sections", any one of which can be chosen when the
template is inserted. A specific section can be chosen, or one can be chosen at random, or in
sequence, depending on how the enhanced template is used.

Enhanced templates can "include" sections from other templates or even other entries in other
categories. Combined with the ability to execute ActiveScript scripting commands, enhanced templates
are a powerful feature of The Journal.

In the "Templates" category that is created for you automatically, there are a small number of enhanced
templates. Those provide some examples of what can be done. Feel free to refer to those as you read
on, to see how they work and how they are structured.

Next: Enhanced Template Basics

5.15.6.1 Enhanced Template Basics

Enhanced templates use HTML- and XML-style "tags". These tags define the template itself, the sections
within the template, and handle scripting. The following example shows the simplest form of an
enhanced template:

<TEMPLATE>
<SECTION>Template text is here, as a section.</SECTION>
</TEMPLATE>
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The <TEMPLATE> and <SECTION> Tags

As you can see in the example above, an enhanced template begins with a <TEMPLATE> tag, and ends
with a </TEMPLATE>. The <TEMPLATE> must be the first text in the entry. Any text that follows the </
TEMPLATE tag is ignored.

The <SECTION> and </SECTION> tags mark the actual text to provide when the template is inserted. If
you were to create an enhanced template from the above example, when you inserted the template, you
would get:

Template text is here, as a section.

This may seem like a long way around to get to something that can be easily handled with simple
templates--and it is. So now we will talk about a couple useful things you can do with enhanced
templates.

Some Useful Tags: <DATE/> and <TIME/>

Suppose you want a way to quickly log when you eat, and what you eat. You don't want to create a
whole new category for this, preferring to just enter the information in your normal "Daily Journal"
entries. Here's a template that you can insert when you need it:

<TEMPLATE>
<SECTION>
Food Log for <DATE FORMAT="mm/dd/yy"/> @ <TIME FORMAT="hh:nn">
Food/Description      Servings   Calories
</SECTION>
</TEMPLATE>

When you insert this template, the <DATE/> tag will be replaced with the current date, using the format
specified, and the <TIME/> tag will be replaced with the current time, again using the format specified.
Here's an example:

Food Log for 06/03/03 @ 07:47pm
Food/Description      Servings   Calories

Then you could type in the name of the food you ate, and then tab over to fill in the number of servings
and the calories.

The "FORMAT=..." part of the tags is called an attribute. Attributes usually take the form of:

ATTRIBUTENAME="Attribute Value"

That is, the name of the attribute is specified in all caps, followed by an equal sign (=), and then the
value of the attribute, enclosed in double quotes.

To see all of the available FORMAT options for <DATE/> and <TIME/>, click here.

NOTE: Typically, tags and attributes are entered in ALL CAPS, but this is only a convention. Enhanced
template tabs and attributes can be either lowercase, UPPERCASE, or MixedCase.
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Next: Enhanced Template Sections Part 1

5.15.6.2 Enhanced Template Sections

You have been shown the basic structure of an enhanced template, using <TEMPLATE></TEMPLATE>
and <SECTION></SECTION pairs, and even how to use attributes to modify a tag like <DATE/>. We
will now talk about enhanced template sections in more detail.

Multiple Sections

As we have already covered, the <SECTION> and </SECTION> tags mark the actual text to provide
when the template is inserted. Unlike a simple template, however, where the entire entry is used every
time, an enhanced template can have more than one section, and which one is used can be determined
a couple of different ways. For example:

<TEMPLATE METHOD="random">
<SECTION>How are you today?</SECTION>
<SECTION>What's up?</SECTION>
<SECTION>How are you feeling today?</SECTION>
<SECTION>Have you won the lottery yet?</SECTION>
<SECTION>Do you know where your towel is?</SECTION>
<SECTION>What's the weather like?</SECTION>
<SECTION>How is work?</SECTION>
</TEMPLATE>

This enhanced template, when inserted, will randomly choose from one of the above questions. Only
one of them will be used each time the template is inserted.

Note the METHOD attribute of the <TEMPLATE> tag. This attribute specifies how the template will
choose from the available sections. There are two possible METHOD's:

random      Choose a random section
sequence   Choose the next section in sequence

If the METHOD attribute had been set to "sequence" instead of "random", then the first time you
inserted the template, you would get:

How are you today?

The second time you would get:

What's up?

And so on. The sequence will repeat once it reaches the last available section.

While the example given is somewhat contrived, it's not too different from the various Writing Prompt
templates in the "Templates" category.

Section Formatting
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A section will pull the text, with whatever font or formatting it may have, from the end of the <SECTION>
tag to the beginning of the </SECTION> tag. So if the section text has bold, or italic, or even different
fonts, this will be inserted, as well. This includes paragraph formatting, like indentation and hard
returns.

The example above, with the different greetings, for instance, will insert the greeting at the current
cursor position in the active entry. Afterward, the cursor will be position immediately after the last
character in the greeting. If, instead, you wanted a blank line after the greeting, you would need to add
that to the section, like this:

<SECTION>How are you today?
</SECTION>

If you wanted two blank lines after the greeting, you would do this:

<SECTION>How are you today?

</SECTION>

And, maybe you want a blank line before the greeting, to separate it from the preceding text. In which
case, you would do this:

<SECTION>
How are you today?

</SECTION>

You can override the formatting of all sections by using the UNFORMATTED attribute of the
<TEMPLATE> tag. This will force the text of the sections to be treated as simple text, with no formatting
such bold, italic, or whatever. Paragraph formatting will also be stripped off, though not hard returns/line
breaks used to separate paragraphs. This is how the above example would be changed:

<TEMPLATE METHOD="random" UNFORMATTED>
...

Next: Enhanced Template Scripting

5.15.6.3 Enhanced Template Scripting

With an understanding of enhanced template sections, we now turn our attention to one of the more
powerful aspects of enhanced templates: scripting. With scripting, you can create sophisticated
functions and use them when processing the enhanced template.

Warning: This discussion of scripting in enhanced templates assumes that you are familiar with basic
programming techniques. This is not a tutorial about any particular scripting language. It only shows
how scripting can be used in The Journal.

Enhanced templates can use ActiveScript languages such as VBScript, JavaScript, and so on. Any
ActiveScript language that is installed on your computer can be used.
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Within a Section or Outside of a Section

Scripts in enhanced templates can be either inside of a section (between the <SECTION></SECTION>
tags) or outside of any section. The biggest difference between those two cases is:

1. Script within a section is only executed when that section is selected. The results of the script, if any,
may be added to the text of the section when it is inserted into the active entry.

2. Script that is external to any section is executed every time the enhanced template is processed,
before any section is selected.

The <EXECUTE> Tag

Script commands are always bracketed by the <EXECUTE> tag, and it's trailing </EXECUTE>.
Everything between those tags is considered to be part of the script.

The default scripting language is VBScript. You can override this with the USE attribute. For example:

<EXECUTE USE="JavaScript">
// JavaScript commands here...
</EXECUTE>

If you specifiy a language with the USE attribute, that language must be available. Otherwise, the script
will not run. For simplicity, VBScript will be used in the examples given in the rest of this tutorial.

Global Script Variables

For script that is executed outside of a section, the only way to hold onto any results is with the global
variables provided.

There 1000 global variables available, and they can contain just about any type of value you choose
(number, string, etc.). You access them within your script commands like so:

<EXECUTE>
...
Globalnn='This String'
...
</EXECUTE>

Or:

<EXECUTE>
...
if Globalnn >= 18 then
...
</EXECUTE>

Where "nn" is some number from 1-1000. Thus, you could have "Global1" or "Global23" or "Global456"
and so on.
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The Result Variable

The Result variable is a local variable available only to <EXECUTE>'s that are inside of a section. The
Result variable can be assigned a value, either a string value or any value that can be easily converted
to a string (like a number). The value of Result is then inserted into the section's text, replacing the
entire <EXECUTE> </EXECUTE> script.

For example, this section:

<SECTION>
Hello, my name is <EXECUTE>Result="David"</EXECUTE>!
</SECTION>

Would look like this when inserted:

Hello, my name is David!

An Example with Scripting

Let's say you want a simple writing exercise that uses a random letter. You could do it like this:

<TEMPLATE>

<EXECUTE>
if Int(RandomValue * 2) > 0 then
  Global1="begins"
else
  Global1="ends"
end if
</EXECUTE>

<EXECUTE>
Global2=Chr(65+Int(RandomValue*26))
</EXECUTE>

<SECTION>
Write about a word that <EXECUTE>Result=Global1</EXECUTE> with the letter:
<EXECUTE>Result=Global2</EXECUTE>

</SECTION>

</TEMPLATE>

This template randomly selects either "begins" or "ends", and then randomly selects a letter from A-Z.
These values are stored in the global variables Global1 and Global2, respectively. The section then
combines those variables with some text to create the writing exercise. Examples of the templates output
are:

Write about a word that ends with the letter: X

Write about a word that begins with the letter: E
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The "RandomValue" variable used in the above scripts is a global variable available in enhanced
templates. It returns a random value (x) where: 0 < x < 1

Next: Enhanced Template Scripting Part 2

5.15.6.4 Enhanced Template Scripting Part 2

Even with only what we've shown you so far, scripting is obviously a powerful feature. There is more,
however. In this topic, we discuss two more tags that take scripting to the next level.

Warning: This discussion of scripting in enhanced templates assumes that you are familiar with basic
programming techniques. This is not a tutorial about any particular scripting language. It only shows
how scripting can be used in The Journal.

The <DECLARE> Tag

The <DECLARE> tag is much like the <EXECUTE> tag, in that it contains script code. Unlike the script
in <EXECUTE>'s, however, script in <DECLARE>'s is not run. Instead, the procedures and functions
declared are available to be called from within a <EXECUTE>.

You can have more than one <DECLARE></DECLARE> in an enhanced template. If you do have more
than one, they are consolidated and treated as a single collection.

One example of using <DECLARE> comes from role-playing games (RPG's). In RPG's many things are
based on the roll of a die. The die can have 4 sides (a d4), 6 sides (a d6), 8 sides (a d8), and so on. If
you wanted to create a template that would generate RPG items, you would be calculating random
numbers frequently. Rather than duplicate that script every time you need it, it is more useful to create it
once:

<TEMPLATE>

<DECLARE>  
function RollDie(typeDie)  
  RollDie=Int(RandomValue*typeDie)+1  
end function  

function RollDice(typeDie,count)  
  total=0  
  for dd=1 to count  
    total=total+RollDie(typeDie)  
  next  
  RollDice=total  
end function  
</DECLARE>  

<SECTION>You find <EXECUTE>Result=RollDie(6)</EXECUTE> gold dubloons and
<EXECUTE>Result=RollDice(6,3)</EXECUTE> silver coins.</SECTION>

</TEMPLATE>  

So now you can create a collection of common function and procedures with your enhanced template.
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But what if you want to use the same functions and procedures in other enhanced templates?

The <INCLUDE> Tag

The <INCLUDE> tag allows you to access entries within The Journal, or even files outside of The
Journal, and "include" them as part of the enhanced template.

Thus, you could create a loose-leaf entry called "Dice Functions" that contains this:

<DECLARE>  
function RollDie(typeDie)  
  RollDie=Int(RandomValue*typeDie)+1  
end function  

function RollDice(typeDie,count)  
  total=0  
  for dd=1 to count  
    total=total+RollDie(typeDie)  
  next  
  RollDice=total  
end function  
</DECLARE>  

Then you could simply "include" that entry in those enhanced templates where you need those
functions:

<TEMPLATE>

<INCLUDE ENTRY="Dice Functions">

<SECTION>You find <EXECUTE>Result=RollDie(6)</EXECUTE> gold dubloons and
<EXECUTE>Result=RollDice(6,3)</EXECUTE> silver coins.</SECTION>

</TEMPLATE>

Much more compact, and much easier to maintain.

Next: Enhanced Templates Wrapup

5.15.6.5 Enhanced Templates Wrapup

Hopefully this short tutorial has shown you some of what is possible with The Journal's enhanced
templates.

With multiple sections to provide some variability, and scripting to add power, enhanced templates can
be amazingly versatile and useful.

Again, check out the enhanced templates that are provided in the "Templates" category. See how they
do what they do, and feel free to tinker with them.

Learn more here:

Enhanced Template Tags
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Enhanced Template Script Variables

5.16 Topics

Topics provide another powerful way to organize your thoughts in The Journal. You can set a topic to
the text of entry, either as you type it or afterward. You can set as many topics within an entry as you
wish, or even tag an entry with as many topics as you want. You can then search entries with a topic or
topics and review them. Searching by topic can be a lot faster than searching for a word, phrase, or
collection of words.

The Journal creates a list of more than 60 topics and sub-topics for you, including:
Business
Dream
Family
Feelings
Finances
Friends
Health
Hobbies
And more!

Of course, you can add topics of your own and delete the ones you don't need.

Each topic can be given its own highlight color, to make it easier to see, and you can assign hot-keys to
up to 10 topics for ease of use.

When reviewing your entries, topics can be displayed (either one at a time or all at once) or hidden
entirely.

Using Topics
Apply Topic
Editing Topics
Searching Topics

5.16.1 Using Topics

You can use topics either as you type in your entries, or apply them afterward as you review your
entry.

Tagging an Entry with a Topic

Click on the Topic menu and choose "Tag Entry with Topic..." (hot-key: Ctrl+Shift+G). This applies
the topic or topics that you check to the entire entry.
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Using Topics while Making Your Entry

You can also apply topics as you make your entry.

Select the topic you want from the drop-down list on the toolbar.

Once you do that, the name of the topic is inserted (as "[Topic Name]" on a line of its own), the topic's
highlight color is made visible, and then whatever you type will be automatically assigned that topic.
(NOTE: The topic highlight color isn't printed.)

You can switch to a new topic (or no topic) at any time by selecting the appropriate choice from the
topic list. The hot-key for "Apply <No Topic>" is: Shift+Ctrl+Q Also, if you triple-space after a
paragraph (hit ENTER three times), then you turn off the active topic.

Applying Topics to Your Entry

To apply topics to text after you have entered it, first select the text you want to tie to the topic, then
choose the topic from the list.

A given block of text can have any number of topics assigned to it. The marked text will show up in
searches for any of the applied topics.

Viewing Topics
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Topics that have already been tagged to the entry or applied to the entered text are displayed in the
status bar below the entry:

Topics applied to entered text are listed first, and shown with [brackets]. Topics that are tagged to the
entry are listed next.

By default, blocks of text that have a topic are displayed with their hightlight color. This highlight isn't
printed. It only serves to show the text with topics. You can change this so that text with topics applied
does *not* show the highlight color. Click on the Topic menu and choose "Edit Topics..." Un-check
the option "Default to 'Show all Topics' in Editor".

5.16.2 Apply Topic

Click on the Topic menu and choose "Apply Topic..."

Or, to apply a topic to the entire entry:

Click on the Topic menu and choose "Tag Entry with Topic..."

Topics that have already been applied to the entry will show as checked.

Check or un-check the topics you want to apply.

"Clear all Topics" will un-check all topics in the list.

5.16.3 Editing Topics

The Journal creates a list of more than 60 topics and sub-topics for you, but you can change the
topics, delete topics you don't need, and add topics of your own.

To edit your topics, click on the Topic menu and choose "Edit Topics..."

Any topic that you have used is shown as bold in the list of topics.

For explanation of all the available topic options, check out User Preferences: Topics.

5.16.4 Merging Topics

Click on the Topic menu and choose "Merge Topics..."

This form allows you to merge two or more topics into a single topics. Any entries that have the merged
topics will be updated.

NOTE: This operation cannot be undone. If you change your mind, you will have to restore from a
previous backup.

5.16.5 Searching Topics

Searching by topic can be a lot faster than searching for a particular word or phrase. Because an entry
knows which topics have been used, it does not have to examine the entire entry.

To search by topic:

1. Click on the Topic menu and choose "Search Entries by Topic..."
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2. Check the topic(s) you want to search for. NOTE: The topics you have used at least once in an entry
are listed first, in alphabetical order. All other topics are listed in alphabetical order following the ones
you have used.

3.Click on "Search".

5.17 User Interface

User Interface FAQ
How can I customize the look of The Journal (change the skin)?
How do I customize the toolbars?
What is the hot-key (keyboard shortcut) for...?
How do I make The Journal 6 look like The Journal 4?

5.17.1 Customizing the User Interface with Skins

The Journal supports full customization with 170+ pre-installed skins.

The quickest way to change the skin is to click on the View menu and choose "Change Skin/
Theme..."

You can also change the skin--or turn off skinning--of The Journal in "User Preferences..." (on the
User menu), on the "Global" tab. Note that if you turn skinning off (or back on), that you will need to
close and restart The Journal.

In User Preferences you can test a skin without losing your present settings. On the "Global" tab,
browse for a skin (…), and select Open. Then click on Test. If you’re happy with your selection, click
OK, then Apply at the bottom of the Global tab.

5.17.2 Customizing the User Interface Font

You can select the font, font style (regular, italic, bold or bold italic) and size of font you would like to
use in the user interface. This can be useful for those with difficulties seeing small fonts or to change
the style of the The Journal.

Click on the User menu and choose "User Preferences...", and bring up the "Global" tab. Click on
the button Edit User Interface Font.

This font will be used in all areas of the user interface, but it is not the font selected for your Journal
entries.

5.17.3 Customizing the Menus & Toolbars

The Journal supports full customization of the main menu and all toolbars.

Right-click on the menu or toolbar that you want to customize, and choose Customize.

Click on the Commands tab to see the list of available commands.

Under "Categories:" are groups of commands that roughly correspond to the menus of the same
name. For example, the commands available under "Format" are those on the "Format" menu.

Once you select a category, you can click on the menu or toolbar command under "Commands:" and
drag it where you want it to appear on the menu or toolbar.
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5.17.4 Keyboard Shortcuts (Hot-Keys)

Ctrl+Tab Move to next category tab  
Ctrl+Shift+Ta
b

Move to previous category tab  

F1 Context-sensitive help  
F2 Rename selected entry  
Ctrl+F2 Add a Calendar Charm to selected entry  
F3 Repeat last find  
F4 Lock/Unlock active entry (prevent/allow editing)
F5 Go to today's entry in category (Calendar Categories only)  
Ctrl+F5 Go to date (Calendar Categories only)  
Ctrl+Shift+F5 Go to a random entry in the current category (Calendar Categories only)  
F6 Set date for all active categories (Calendar Categories only)  
F7 Go to previous entry in category  
Shift+F7 Go back 1 month (Calendar Categories only)  
Ctrl+F7 Go back 1 year (Calendar Categories only)  
F8 Go to next entry in category  
Shift+F8 Go forward 1 month (Calendar Categories only)  
Ctrl+F8 Go forward 1 year (Calendar Categories only)  
F9 Create new entry  
Shift+F9 Create new root entry
F10 Create new sub-entry
F12 Save Entry as...  
Ctrl+F12 Export Entries...  
 
Ctrl+F Find text in entry  
Ctrl+Shift+F Search entries  
Ctrl+G Replace text in entry  
 
Ctrl+<spacebar> Apply default text style to selected text  
Ctrl+Shift+<spaceba
r>

Apply default text style to selected text, retaining formatting

Ctrl+Delete Delete word  
Ctrl+B Toggle Bold On/Off  
Ctrl+U Toggle Underline On/Off  
Ctrl+I Toggle Italics On/Off  
Ctrl+<dash> Toggle Strikeout On/Off  
Ctrl+[ -1 font size  
Ctrl+] +1 font size  
Ctrl+M Indent paragraph  
Ctrl+Shift+M Unindent paragraph  
Ctrl+H Hanging indent  
Ctrl+Shift+L Toggle bulleting  
Ctrl+Shift+N Toggle numbering  
Shift+F10 Bring up entry context menu  
Ctrl+Shift+D Add/edit description of selected image  
Ctrl+Shift+Y Edit layout properties of selected image  
Ctrl+L Align paragraph left  
Ctrl+R Align paragraph right  
Ctrl+E Center paragraph  
Ctrl+Shift+K Block justify paragraph  
Ctrl+= Subscript  
Ctrl+Shift+= Superscript  
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Ctrl+Shift+H Edit the current paragraph as right-to-left (for Middle Eastern users)  
 
Ctrl+D Insert Current Date at cursor  
Ctrl+T Insert Current Time at cursor  
Ctrl+Shift+A Insert Entry Date (date of the active entry) at cursor  
Ctrl+Shift+I Insert Current Timer at cursor  
Ctrl+Shift+<dash> Insert line at cursor  
Ctrl+K Insert Link
Ctrl+Shift+X Insert To-do (CheckBox) 

Ctrl+Shift+B Backup The Journal  
Ctrl+Shift+S Spell checker  
Ctrl+Shift+R Thesaurus  

Ctrl+J Hide (and optionally Lock) Journal  
Ctrl+Alt+J Activate The Journal (if running)  
 
Ctrl+Shift+J Open Journal Volume  
Ctrl+Shift+U Switch user (login in as a different user)  
 
Ctrl+Shift+T Shift focus to date tree  
Ctrl+Shift+E Shift focus to entry  
Ctrl+Alt+C Toggle calendar On/Off  
Ctrl+Alt+T Toggle date tree On/Off  
Ctrl+Alt+I Toggle countdown timer and stopwatch On/Off  
 
Alt+Up Move Entry Up  
Alt+Down Move Entry Down  
Alt+Shift+Up Promote Entry  
 
Ctrl+Z Undo changes  
Ctrl+Y Redo changes  

Ctrl+Shift+P Apply topic
Ctrl+Shift+G Tag entry with topic
Ctrl+Shift+Q Set selected text to "<No Topic>"

International Characters  
 
Acute accent: Á, É, Í, Ó, Ú, Ý, á, é, í, ó, ú, ý  
Ctrl+Shift+<apostrophe> <letter>  
 
Circumflex: Â, Ê, Î, Ô, Û, â, ê, î, ô, û  
Ctrl+Shift+  ̂<letter>  
 
Grave accent: À, È, Ì, Ò, Ù, à, è, ì, ò, ù  
Ctrl+` <letter>  
 
Tilde accent: Ã, Ñ, Õ, ã, ñ, õ  
Ctrl+Shift+~ <letter>  
 
Umlaut accent: Ä, Ë, Ï, Ö, Ü, Ÿ, ä, ë, ï, ö, ü, ÿ  
Ctrl+Shift+<colon> <letter>  
 
Slashed characters: Ø, ø  
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Ctrl+/ <letter>  
 
Cedilla: Ç, ç  
Ctrl+<comma> <letter> 

Compound characters: ß, Æ, Œ, æ, œ
Ctrl+Shift+& s = ß
Ctrl+Shift+& a = æ
Ctrl+Shift+& o = œ

5.17.5 Keyboard Shortcuts (Hot-Keys) Alphabetically

Ctrl+A Select All (entire entry)  
Ctrl+Shift+A Insert Entry Date (date of the active entry) at cursor
Ctrl+B Toggle Bold On/Off  
Ctrl+Shift+B Backup The Journal
Ctrl+C Copy selection to clipboard
Ctrl+Alt+C Toggle calendar On/Off  
Ctrl+D Insert Current Date at cursor  
Ctrl+Shift+D Add/edit description of selected image  
Ctrl+E Center paragraph  
Ctrl+Shift+E Shift focus to entry  
Ctrl+F Find text in entry  
Ctrl+Shift+F Search entries  
Ctrl+G Replace text in entry  
Ctrl+Shift+G Tag entry with topic
Ctrl+H Hanging indent  
Ctrl+Shift+H Edit the current paragraph as right-to-left (for Middle Eastern users)  
Ctrl+I Toggle Italics On/Off  
Ctrl+Shift+I Insert Current Timer at cursor  
Ctrl+Alt+I Toggle countdown timer and stopwatch On/Off  
Ctrl+J Hide Journal
Ctrl+Shift+J Open Journal Volume  
Ctrl+Alt+J Activate The Journal (if running)  
Ctrl+Shift+K Block justify paragraph  
Ctrl+K Insert Link
Ctrl+L Align paragraph left  
Ctrl+Shift+L Toggle bulleting  
Ctrl+M Indent paragraph  
Ctrl+Shift+M Unindent paragraph  
Ctrl+Shift+N Toggle numbering  
Ctrl+Shift+O Toggle outline  
Ctrl+P Print
Ctrl+Shift+P Apply topic
Ctrl+Shift+Q Set selected text to "<No Topic>"
Ctrl+R Align paragraph right  
Ctrl+Shift+R Thesaurus  
Ctrl+S Save all changes  
Ctrl+Shift+S Spell checker  
Ctrl+T Insert Current Time at cursor  
Ctrl+Shift+T Shift focus to date tree  
Ctrl+Alt+T Toggle date tree On/Off  
Ctrl+U Toggle Underline On/Off  
Ctrl+Shift+U Switch user (login in as a different user)  
Ctrl+V Paste from clipboard  
Ctrl+Shift+V Paste Special from clipboard  
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Ctrl+W Count words in entry or selected text
Ctrl+Shift+W Count words in the active entry plus the words in all sub-entries
Ctrl+X Cut selection to clipboard  
Ctrl+Shift+X Insert To-do (CheckBox) 
Ctrl+Y Redo changes  
Ctrl+Shift+Y Edit layout properties of selected image
Ctrl+Z Undo changes  

Ctrl+Tab Move to next category tab  
Ctrl+Shift+Ta
b

Move to previous category tab  

Ctrl+<spacebar
>

Apply default text style to selected text  

Ctrl+Shift+<spacebar
>

Apply default text style to selected text, retaining formatting  

Ctrl+Delete Delete word  
Ctrl+Shift+Inser
t

Paste from clipboard as text 

Ctrl+<dash> Toggle Strikeout On/Off  
Ctrl+Shift+<dash> Insert line at cursor  
Ctrl+[ -1 font size  
Ctrl+] +1 font size  

Ctrl+= Subscript  
Ctrl+Shift+= Superscript  
 
Alt+Up Move Entry Up  
Alt+Down Move Entry Down  
Alt+Shift+Up Promote Entry  
Alt+Left Back  
Alt+Right Forward  

F1 Context-sensitive help  
F2 Rename selected entry  
Ctrl+F2 Add a Calendar Charm to selected entry  
F3 Repeat last find  
F4 Lock/Unlock active entry (prevent/allow editing)
F5 Go to today's entry in category (Calendar Categories only)  
Ctrl+F5 Go to date (Calendar Categories only)  
Ctrl+Shift+F5 Go to a random entry in the current category (Calendar Categories only)  
F6 Set date for all active categories (Calendar Categories only)  
F7 Go to previous entry in category  
Shift+F7 Go back 1 month (Calendar Categories only)  
Ctrl+F7 Go back 1 year (Calendar Categories only)  
F8 Go to next entry in category  
Shift+F8 Go forward 1 month (Calendar Categories only)  
Ctrl+F8 Go forward 1 year (Calendar Categories only)  
F9 Create new entry  
Shift+F9 Create new root entry
F10 Create new sub-entry
Shift+F10 Bring up entry context menu  
F12 Save Entry as...  
Ctrl+F12 Export Entries...  
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International Characters  

Acute accent: Á, É, Í, Ó, Ú, Ý, á, é, í, ó, ú, ý  
Ctrl+Shift+<apostrophe> <letter>  
 
Circumflex: Â, Ê, Î, Ô, Û, â, ê, î, ô, û  
Ctrl+Shift+  ̂<letter>  
 
Grave accent: À, È, Ì, Ò, Ù, à, è, ì, ò, ù  
Ctrl+` <letter>  
 
Tilde accent: Ã, Ñ, Õ, ã, ñ, õ  
Ctrl+Shift+~ <letter>  
 
Umlaut accent: Ä, Ë, Ï, Ö, Ü, Ÿ, ä, ë, ï, ö, ü, ÿ  
Ctrl+Shift+<colon> <letter>  
 
Slashed characters: Ø, ø  
Ctrl+/ <letter>  
 
Cedilla: Ç, ç  
Ctrl+<comma> <letter>

Compound characters: ß, Æ, Œ, æ, œ
Ctrl+Shift+& s = ß
Ctrl+Shift+& a = æ
Ctrl+Shift+& o = œ

5.17.6 Language

To change the user interface language, click on the View menu, Language sub-menu, and choose the
language.

Currently available languages:
English (United States) (default)
English (United Kingdom)
Chinese (People's Republic of China) [*]
German
Russian [**]

[*] This language shouldn't be used except on Asian-language versions of Windows.
[**] This language works best on Cyrllic-language versions of Windows.

NOTE: The Journal uses Windows Regional settings for many things, like month names, days of the
week, and so on. Thus, those types of text are *not* affected by choosing a different language.

5.17.7 Journal.INI

Under Windows Vista, the user-editable Journal.INI file can be found here:
C:\Users\WinUser\AppData\Roaming\The Journal 5\

Under Windows XP, this is the path:
C:\Documents and Settings\WinUser\Application Data\The Journal 5\
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[GlobalOption]

The [GlobalOption] section provides access to the following settings:

GOShowSplashScreen

If true (=1), show the "splash screen" when starting The Journal. If false (=0), do not show the "splash
screen" when starting The Journal.

GOForceRepair

If true (=1), force The Journal to repair all Journal Volumes. This option is automatically reset to false
(=0) after the forced repair is completed.

GOInterfaceFontSize

If set to any positive value, that value is used as the font point size used in the entry date tree and
category tabs.

The default font point size is 8. If you would like to increase the font size used, try:

GOInterfaceFontSize=10

GONoCtrlAltHotKeys

If true (=1), this option turns off the keyboard shortcuts in The Journal that use Ctrl+Alt key
combinations. Currently, this only affects the Toggle Calendar (Ctrl+Alt+C) and Toggle Tree (Ctrl+Alt+T)
hot-keys.

Some international users (e.g., from Poland) were having problems with the Ctrl+Alt+C hot-key. It
prevented them from using a particular accented character.

GOAlwaysChooseRunAnotherTJSet

If true (=1), then the user has chosen to always either run another instance of The Journal, or to always
*not* run another instance, bringing up the active instance.

GOAlwaysChooseRunAnotherTJ

If true (=1), then the user can run The Journal as many times as he wants, each time opening a new
instance of The Journal.

If false (=0), then The Journal will be limited to a single running instance.

5.17.8 Command Line Options

-v Specify Journal Volume

You can specify a Journal Volume to open when you start The Journal. The format is:

journal6.exe -v VolumeName

Example: journal6.exe -v Home

If the Journal Volume name includes spaces, then the name must be in quotes.
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Example: journal6.exe -v "My Journal"

NOTE: When this command line parameter is present, only the specified Journal Volume is opened.
Other Journal Volumes, even those specified as auto-load, will not be opened. You can open those
Journal Volumes manually with File menu, Journal Volume sub-menu, "Open Journal Volume..."

-repair Force Database Repair

If this command line option is present, The Journal will repair all Journal Volumes when starting. The
format is:

journal6.exe -repair

5.17.9 Miscellaneous Forms

This section describes the options and commands available on The Journal's forms.

5.17.9.1 Calendar Charms

Click on the Entry menu and choose "Entry Calendar Charm..." (hot-key: Ctrl+F2)

Or click on the Insert menu and choose "Insert Calendar Charm..." (hot-key: Shift+F2)

To choose a Calendar Charm:

1. Select the Calendar Charm Collection.

2. Click on the Charm you want, by clicking on it or using the arrow keys.

3. Click on Select.

To Remove a Calendar Charm:

1. Click on Clear.

2. Click on Done.

See also: Calendar Charms

5.17.9.2 Category Statistics

Click on the Category menu and choose "Category Statistics..."

This form shows the following information for the active category:
# of Entries - the total number of entries in this category
Security Level - whether the category requires a password or not
Shared? - whether the category is shared; if so, whether it's shared read only or full access
Access - whether the category is read only (no new entries, no editing of entries) or full access
Parent Category - if the category is a sub-category, this is the name of its parent category
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5.17.9.3 Change User Password

Click on the User menu and select "Change User Password..."

You will need to enter your current password (unless you have a blank password) to create a new
password. When your current password has been verified, you will be asked to confirm your new
password.

The Journal allows passwords of any length.

See Choosing a Good Password for tips on how to make your password as secure as possible.

Using a Blank Password

The Journal allows you to have a "blank" password if you want. If you do not want a password, but still
want The Journal to "prompt" you to login, a blank password will do that.

When you set your password, just leave the new password blank. Do not type anything.

See also: How do I reset my lost password?

5.17.9.4 Choose an Action

You will be presented with the "Choose an Action" form in a variety of situations. The most frequent
cases are:

You cancel out of a user login prompt and there is no other user logged in.
The Journal is unable to find or open an expected Journal Volume.

The currently active Journal Volume, if any, is displayed.

You must choose one of these actions to proceed:

Open Another Journal Volume

You will be presented with a list of available Journal Volumes. Choose the Journal Volume you want to
open.

Log in to the Current Journal Volume

This choice will take you back to the user login. There you can choose a user name and enter the
password to log in.

Create a New Journal Volume

This choice will lead you through the steps necessary to create a new Journal Volume, which you can
then open and log into.

Restore from a Backup
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If you need to restore from a backup, click on this button.

Close The Journal

The Journal will close.

5.17.9.5 Choose Category to Import Into

When importing entries from an export file, you will be prompted to choose the correct category to use
for the import.

You can only choose a category that is the same type (calendar or loose-leaf) as the category that is
being imported.

You can also create a new category to receive the import, or you can tell The Journal to auto-create the
category. The automatic creation creates the new category based on the import category (same type,
name, and so on).

5.17.9.6 Clipboard Viewer

Click on the Edit menu and choose "Clipboard Viewer..."

The Journal's Clipboard Viewer provides a powerful tool for managing and using the Windows
clipboard. You can edit the clipboard contents, or paste them into the currently active entry.

With the "Auto-Paste to Active Entry" option, you can have anything that is copied to the Windows
clipboard automatically pasted into the active entry. This means you can rapidly collect information from
various applications and web pages without having to switch back and forth between The Journal and
the source of the information. Just select what you want, and copy it to the clipboard.

5.17.9.7 Countdown Timer

Click on the View menu and choose "Timer" (hot-key: Ctrl+Alt+I).

The Journal's countdown timer can be used in a variety of ways:
Many writing and journaling exercises want you to "just write" for a set period of time, like 10 minutes.
For your current writing project, you want to write for an hour every day.
For any project where you want to work for a period of time, the countdown timer can be set for a
matter of seconds, or even hours.

NOTE: When you use the countdown timer, the stopwatch is disabled. And vice versa. You cannot use
both the countdown timer and the stopwatch at the same time.

Time Remaining

You can set the countdown timer to any time from just 1 second to many hours. You type in the
duration you want, and hit ENTER.

Setting durations:

mm   Will set the timer for mm minutes.
:ss   Will set the timer for ss seconds.
mm:ss   Will set the timer for mm minutes and ss seconds.
hh:mm:ss   Will set the timer for hh hours and mm minutes and ss seconds.
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While the timer is counting down, you can insert the current timer value into your entry by clicking on
the Insert menu and choosing Insert Timer Count.

When the timer reaches 00:00:00, a sound is played to alert you. You can set the sound in User
Preferences.

 Start

Will start the countdown timer. If you have paused the timer, it will resume from its last count.

 Pause

Will pause the countdown timer.

 Reset

Reset stops the countdown timer, resetting it to 00:00:00.

5.17.9.8 Delete Users

Click on the File menu, Journal Volume sub-menu, and choose "Delete User(s)..."

You can only delete users within the active Journal Volume.

You will need to enter the password of any users you want to delete.

NOTE: Deleting a user also deletes all categories and entries for that user. Once deleted, a user cannot
be recovered. You would need to restore from a backup.

5.17.9.9 Edit Auto Replace Strings

Click on the User menu and choose "User Preferences..." Bring up the "Editor" tab.

You can use the auto-replace feature to simplify your typing. You can create simple strings that are
automatically replaced with more complex text as you type them.

Auto-Replace Strings

This is the list of all auto-replace strings you have created. To edit an auto-replace string, click on it in
the list. To create a new auto-replace string, click on New Auto-Replace.

Replace

This is the sequence of characters that is to be replaced with the text in With. Each replacement string
must be unique.

With
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This is the text that is automatically inserted when you type the string in Replace within an entry. This
text can be one or more lines long, and can be either formatted or unformatted.

Use Formatting

Check this option to apply formatting to the With text.

5.17.9.10 Edit Header/Footer

This form is used to edit both headers and footers for users and categories.

Headers and footers are functionally identical, and are configured using the same options. The only
difference between them is that one is printed at the top of the page (headers) and one at the bottom of
the page (footers).

Formatted text can be used in both headers and footers. This means you can use any TrueType font
you have on your PC, you can use bold, italic, etc., and you can specify that the text be aligned to the
left, right, or centered. An empty header or footer will not be printed.

With the use of Print Macros, the text of the header and footer can include pre-defined values such as
the page number, the category name, and so on.

See User Preferences: Printing and Printing Headers and Footers for more information.

5.17.9.11 Edit Symbol Replace Strings

Click on the User menu and choose "User Preferences..." Bring up the "Editor" tab.

Some symbols are awkward, if not impossible, to type using normal keyboards. The Journal's Symbol
Replace feature can help work around this limitation by associating simple sequences with special
characters.

Examples:
(c) : ©
(tm) : ™
'e : é
:-) : J

To create a new Symbol Replace sequence, simply click on New. Then type in the sequence of
characters, choose the font, and choose the symbol.

Replace

This is the sequence of characters that is to be replaced with the symbol. Each replacement string must
be unique.

Symbol Font

This is the Windows TrueType font that contains the desired symbol.

Symbol and WingDings fonts contain many command symbols, such as © and J

Special Roman characters, such as é and ä, are genearlly supported by any normal Windows
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TrueType font (such as Arial). For these characters, it is recommended that you use the "<Default>"
font option.

Symbol

Once you have selected the desired Symbol Font (or <Default>), simply choose the character you
want.

5.17.9.12 Enter Registration Keys

Click on the Help menu and choose "Enter Registration Keys..."

Use this form to enter the Registration Keys you received when you bought The Journal.

The Registration Keys are in the form:

Key 1: YOUR NAME
Key 2: XXODDSTUFFHEREXX

Entering Your Registration Keys

Your Registration Keys are case-sensitive, so they must be entered exactly as sent to you. The easiest
way to do this is:

1. Select both Registration Keys from the email you were sent and copy them to the Windows clipboard
(hot-key: Ctrl+C).

2. In The Journal, click on the Help menu and choose "Enter Registration Keys..."

5.17.9.13 Entry Statistics

Click on the Entry menu and choose "Entry Information & Statistics..."

Entry Statistics

This form shows the following information for all entries:
Date Created - the date this entry was originally created
Date Last Modified - the date of the last modification to the entry
Date Last Printed - when the entry was last printed
Total Editing Time - the number of minutes spent editing the entry (this is measured as the time from
beginning an addition/modification to the time the entry was saved) *
Revision Number - the number of times the entry has been modified (all changes on a single date
count as 1 revision)

* For some entries imported from The Journal 3, the total editing time reported may be incorrect.

Word Count

For document entries, it also displays:
Words - how many words are in the entry
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Characters (no spaces) - how many non-whitespace characters are in the entry
Characters (with spaces) - how many total characters are in the entry
Paragraphs - the number of individual paragraphs in the entry (empty paragraphs are not counted)
Lines - the number lines displayed (this number varies as you resize The Journal)

Entry Changes Log

This tab displays a summary of every time the entry was edited or otherwise changed. The name of the
user who made the change is included in the log.

NOTE: Changes/edits that happen within 30 minutes of each other are consolidated into a single
change.

Clear History - Clicking this button clears all of the current history for the entry, and inserts a history
item about the clear. NOTE: This cannot be undone.

5.17.9.14 Find Text...

Click on the Search menu and choose Find Text... (hot-key: Ctrl+F)

Search for text in the current entry.

NOTE: To search in multiple entries across categories, use Search Entries instead.

Text to Find

Enter the word or phrase you want to search for here.

Options

Search entire entry - search for the text in the whole entry. If this option is un-checked, the search will
start from the current cursor position in the text, and continue down to the bottom of the entry.

Case-sensitive - the case (uppercase or lowercase) of the text to find must match exactly.

Whole words only - no partial-word matches.

5.17.9.15 Get Web Page

Click on the Tools menu and choose "Get Web Page..."

Use this form to GET a page from the Web, with all images, and archive it in the active entry.

While most HTML formatting is supported, some formatting options are not supported (example: CSS
style sheets are not pulled). Also, characters from some languages may not be imported properly (this
will be fixed in a future update).

NOTE: The HTTP GET operation may take a few minutes, as it tries to download all of the images on the
page.
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5.17.9.16 Go to Date

Click on the Go menu and choose "Go to Date..." (hot-key: Ctrl+F5)

Choose the date you want The Journal's calendar set to.

Type in the date by hand, or use the "drop-down" calendar.

When interpreting typed-in dates, The Journal uses the Windows setting for date format.

5.17.9.17 Handle Dropped File

This form pops up when you drag and drop a Windows file onto an entry.

Insert this file into Current Entry

The dropped file will be inserted into the current entry, if possible.

Replace Current Entry with this file

The dropped file will replace the current entry.

Add this file under Current Entry

The dropped file will be added as a sub-entry under the current entry.

Add this file as an Entry

The dropped file is added as an entry at the same level as the current entry.

5.17.9.18 History...

Click on the Go menu and choose "History..."

This form contains a list of all the entries you have opened during this journaling session.

You can select any of those entries listed and then click on "Go to Entry". Or you can double-click a
listed entry to open that entry.

5.17.9.19 Login

This is the primary login form of The Journal. Before you can do anything in The Journal, you have to
login.

If you need to login to another Journal Volume, press Cancel and then choose Open Another Journal
Volume.

If you want to create a new user, click on Create New User.

User Name
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Select your user name from the list of users.

Password

Enter your password.

See also: How do I reset my lost password?

5.17.9.20 Paragraph

Click on the Format menu and choose "Paragraph..."

Use this form to edit the settings of the current paragraph (or selected paragraphs).

Alignment

Left - The text of the paragraph is lined up on the left margin.
Center - The text of the paragraph is centered on each line.
Right - The text of the paragraph is lined up on the right margin.
Block - The text of the paragraph is lined up on both the left and right margins.

Indentation

Indentation is specified in inches or centimeters, depending on whether you use the US or metric
systems. Values can be entered in inches (in), centimeters (cm), or points (pt).

Left - Indentation from the left margin.
Right - Indentation from the right margin.

First Line - Indentation of the first line of the paragraph.
Hanging - Indentation of the lines in the paragraph after the first.

Spacing

Before and After spacing are measured in points (pt), but can also be entered as inches (in) or
centimeters (cm).

Line Spacing - Line spacing is either single (default), 1.5, or double.
Before - Spacing before the paragraph.
After - Spacing after the paragraph.

5.17.9.21 Paragraph Borders & Shading

Click on the Format menu and choose "Paragraph Borders & Background..."

Use this form to add (or remove) borders and shading to the current paragraph (or all selected
paragraphs).

Color
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This is the color of the border drawn around the paragraph.

Width

The width, in screen pixels, of the border lines.

Internal Width

This is the spacing between lines (centers of lines) in the border (for double and triple borders).

Offsets...

You can control the spacing between paragraph contents and border. Larger positive values increase
the spacing. Negative values force border to be inside of paragraph contents.

Border Type

You can set the border to be: no border, a single line border, a double line border, a triple line border, a
double line border with the inner line thicker, or a double line border the outer line thicker.

Fill Color

This is the color of paragraph background.

Padding...

You can control the display of the background colored area relative to paragraph contents (the distance
between limits of paragraph contents and limits of colored area). Larger positive values increase the
hanging. Negative values force the color to be inside of paragraph contents.

5.17.9.22 Replace Text...

Click on the Search menu and choose Relace Text... (hot-key: Ctrl+G)

Search and replace text in the current entry.

Text to Find

Enter the word or phrase you want to search for here.

Replace With

Enter the word or phrase that the found text will be replaced with.

Options
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Case-sensitive - the case (uppercase or lowercase) of the text to find must match exactly.

Whole words only - no partial-word matches.

Prompt on replace - you will be prompted before each replacement so you can choose whether this
text should be replaced.

5.17.9.23 Reset Login Password

Lost passwords cannot be recovered. But they can be reset.

When you are prompted for your password for your login name or category, type:
//resetpassword

That will bring up this form.

NOTE: Users who have activated Extended Security cannot have their passwords reset. That's one of
the features of Extended Security.

Password Reset Code

Enter the password reset code you received here.

Request Reset Code

Clicking here will start your email program to request a password reset code from DavidRM Software.

Email DavidRM Software and request a password reset code.

5.17.9.24 Select Entry

This form is used by Insert/Edit Link to select the entry to link to.

Select the entry you want from the list of active categories and their entries.

5.17.9.25 Stopwatch Timer

Click on the View menu and choose "Timer" (hot-key: Ctrl+Alt+I), then click on "Stopwatch".

The Journal's stopwatch timer can be used to track how long you have been working on a particular
project.

NOTE: When you use the stopwatch, the countdown timer is disabled. And vice versa. You cannot use
both the stopwatch and the countdown timer at the same time.

Time Elapsed

Time Elapsed displays the time since you started the stopwatch, in hours, minutes, and seconds (hh:
mm:ss).

While the stopwatch is running, you can insert the current elapsed time into your entry by clicking on
the Insert menu and choosing "Insert Timer Count".

mailto:support@davidrm?subject=I need a Password Reset Code for The Journal
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 Start

Will start the stopwatch. If you have paused the timer, it will resume from its last count.

 Pause

Will pause the stopwatch.

 Reset

Reset stops the stopwatch, resetting it to the starting time (00:00:00).

5.17.9.26 Unlock Form

When The Journal is "locked", either by minimizing or by using the "Hide Journal" hot-key (Ctrl+J),
you must enter your password to regain access.

5.17.9.27 User Images

Click on the User menu and choose "User Images..."

The Journal allows you to load images for use as backgrounds to document entries or as Calendar
Charms.

Images

This is the list of all images currently loaded by the user. Each user login in The Journal has its own list
of images.

Load Image...

Click this button to load a new image.

NOTE: Every image must have a unique file name.

Delete Image

Delete the currently selected image.

Description

You can add a description to the image. This description is shown, along with the filename, whenever
you need to choose a background image for an entry or a Calendar Charm collection.

Image Type
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An image is either a background image or a Calendar Charm collection.

Background Image Options

Position

A background image can be either tiled across the entry, centered in the middle of the entry, or
stretched to fit the entry editor.

Margin Offsets

Click on this button to adjust the margins used with background image, for example to prevent text from
displaying on the border of the image.

Calendar Charm Options

Calendar Charm images are often collections of same-sized images arranged in a grid (but without
visible grid lines).

# of Charms Across (X)

The number of charm images across the image.

# of Charms Down (Y)

The number of charm images down the image.

5.17.9.28 User Statistics

Click on the User menu and choose "User Statistics..."

NOTE: If you have a lot of categories and/or a lot of entries, it make take a few seconds for the totals to
be tallied.

This form shows the following information for the current user:
# of Categories (Active) - how many active categories this user has (includes active sub-categories)
# of Categories (Total) - the total number of categories this user has, active or inactive
# of Entries (Active) - the number of entries in all active categories
# of Entries (Total) - the number of entries in all categories, active or inactive

5.17.9.29 Word Count

Click on the Tools menu and choose "Word Count..." (hot-key: Ctrl+W).

This form displays the following statistics for the entry or the selected text:
Words - how many words are in the entry or selected text
Characters (no spaces) - how many non-whitespace characters there are
Characters (with spaces) - how many total characters are in the entry or selected text
Paragraphs - the number of individual paragraphs (empty paragraphs are not counted)
Lines - the number lines displayed (this number varies as you resize The Journal)
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5.18 User Preferences

Each user of The Journal can customize The Journal to fit her own tastes and preferences.

General
Global
Editor
Topics
Styles
Reminders
Date/Time
Links
Spell Checker
Printing
Backup/Restore
Security

5.18.1 User Preferences: General

Measurement System

The Journal supports either the US system (inches, etc.) or the Metric system (centimeters, etc.). The
Journal automatically uses the measurement system settings active in Windows. If you wish to change
it, use this option.

Display Start of Week on

Your calendar can be set to start on any day of the week. Your Tasks, Events, Appointments etc will
also use this day of the first day of the week. NOTE: You can override this at the category level.

Display Week Numbers on Calendar

If checked, the week number is displayed on the small calendar.

NOTE: If the start-of-week is set to Monday, the week number is calculated according to ISO 8601.

Start New Entry Date After

This is the time after which The Journal considers a new entry date to have begun in daily entry
calendar categories. The default is midnight (12:00 am or 00:00).

Arrange Category Tabs on the Right

If checked, all your category tabs will appear vertically on the right-hand side of the entry editor. This is
useful if you need more vertical space on your screen (useful for small screen netbooks for example).

Show Category Type on Tab
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If checked, the tab for each category will include a picture (icon) representing the type of category.

Show Entry Date/Name above Entry Editor

If checked, the date or title of the entry will be shown below the category tabs.

If you are using a lower-resolution setting and need more screen "real estate", un-check this option.

Keep All Active Calendar Categories on the Same Date

If checked, this option keeps all calendar categories on the same entry date. That is, if the date is
changed in the current calendar category, the same date is set for all other active calendar categories.

Show Journal Volume tabs (global option)

If checked, open Journal Volumes will have tabs down the left side of The Journal's window. You can
use these tabs to quickly switch between Journal Volumes.

Note: This is a global option and affects all users.

Show User Name tabs (global option)

If checked, all users you have opened in the Journal Volume will have tabs with their name along the
bottom edge of The Journal's window. You can use these tabs to quickly switch between open users.

Note: This is a global option and affects all users.

Prompt for entry name when creating new loose-leaf entries

If checked (the default), when you do a Create New Entry (hot-key: F9) or Create New Sub-Entry (hot-
key: F10) to create a new loose-leaf entry, you will be prompted for the name of the entry.

Edit Custom Colors

Use this option to set up to 16 custom colors that will be available wherever The Journal allows a color to
be set or selected.

5.18.2 User Preferences: Global

These options affect all users in all Journal Volumes on this computer.

Auto-Save Every nn Minutes

When checked and the number of minutes is selected, this option specifies when The Journal will
automatically save all changes.
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Auto-Minimize if idle for nn Minutes

When checked and the number of minutes is selected, this option specifies when The Journal will
automatically minimize if it has received no input from the user.

Display/UI

Show "splash screen" on Startup

Un-check this option if you do not wish to see The Journal's opening screen when starting The Journal.

Show icon in the Windows system tray

If this option is checked, The Journal will minimize to the Windows "system tray" (in the lower-left
corner, by the time display) instead of the taskbar. When The Journal is not minimized, The Journal will
still have a button on the Windows taskbar.

Minimize on Close

If this option is checked, The Journal will not close when you click on the "x" (Close Window) button in
the upper right corner of The Journal window. Instead, The Journal will minimize.

To force The Journal to close, click on the Journal menu and choose "Exit The Journal".

Minimize when The Journal loses focus

If this option is checked, any window that is placed in front of The Journal will prompt The Journal to
minimize.

Keep The Journal "on top"

If set, this option keeps The Journal as the top-most Windows application. The Journal will be "on top
of" any other programs also running.

Disable Ctrl+Alt Hot-keys

If checked, this option turns off the keyboard shortcuts in The Journal that use Ctrl+Alt key
combinations. Currently, this only affects the Toggle Calendar (Ctrl+Alt+C), Toggle Tree (Ctrl+Alt+T),
and Toggle Timer (Ctrl+Alt+I) hot-keys.

International character hot-keys override topic hot-keys

If checked (the default), then the international hot-keys for circumflex accented characters (  ̂over the
letter) and combined characters (like the German double S, ß) are active.

If un-checked, topic Ctrl+Shift+6 and Ctrl+Shift+7 are available as topic hot-keys.
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When The Journal is inactive, mouse-click only activates

If checked (the default), when The Journal is visible but inactive (for example, behind another program),
clicking on The Journal *only* activates it. That is, brings The Journal to the top.

If un-checked, when The Journal is brought to the top, the user interface element under the mouse is
also clicked.

The Journal Hide/Unhide Global Windows Hot-Key Active

If this option is checked, The Journal can be activated (as long as it is running) regardless of where
you are in Windows, and what other applications may be running.

To set the global hot-key for The Journal, click on the hot-key entry. Then hold down the keys you want
to use for the hot-key.

The Journal's default hot-key is: Ctrl+Alt+J

If you change the hot-key, you will want to test to make sure that none of your other Windows
applications are using the same one.

Countdown Timer Completed Sound

This is the sound played when the countdown timer reaches 00:00:00. This can be any sound (.WAV)
file on your computer.

Skinning

Turn on Skinning

When checked, this option will give you the option of choosing from 170+ pre-installed skins. These can
be selected by clicking Browse (…), and tested without losing your previous skin settings.

Note that if you turn skinning off (or back on), that you will need to close and restart The Journal.

Toolbar, Menu and Entry Tree Icons

You can choose whether to use The Journal's default (current) set of icons for the toolbars, menus and
entry tree, or use those from a previous version, either The Journal 4 or The Journal 5,.

Disable shadows under forms when skins are active

If checked, the shadow displayed "under" The Journal's main form and dialogs is disabled. This also
disables any transparency in the form caption.

Edit User Interface Font
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Use this option to control the font, font type (regular, italic, bold, bold italic) and font size used in all
areas of The Journal’s main user interface. For example, if you want to use a larger font size, to make
the tabs and tree easier to read, you can do that here.

5.18.3 User Preferences: Editor

Editor Options
Image Options

Editor Options

Default Tab Width

The default tab width is either 0.50 inches (US) or 1 cm (Metric). If you want it to be some other value,
you can specify that here.

When selecting, auto-select entire word

When using the mouse to select text in an entry, this option causes the selection to always pick up full
words.

When pasting, Rich Text Format has priority over HTML Format

If checked, when pasting from the clipboard, Rich Text Format (if available) has priority over HTML
Format.

When pasting as Plain Text, preserve images

If checked, when using Paste as Plaint Text, if the text on the clipboard contains images, those will be
pasted, as well as the text.

Insert URL when pasting from Web pages

When you copy and paste text and images from a Web page, the URL is inserted immediately following
the pasted text/images.

Auto-Replace while Typing

If active, this option causes specified sequences to be replaced by text. The replacement text can be
either formatted or unformatted.

Edit Auto-Replace Strings

This button brings up the Edit Auto-Replace Strings form so you can edit, add, or delete auto-replace
strings.

Auto Symbol Replace while Typing
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If active, this option causes specified sequences to be replaced by a symbol. For example, '(c)' would
be replaced by '©'.

Edit Symbol Replace Strings

This brings up the Edit Symbol Replace Strings form where you can edit, add, or delete symbol
replacement strings.

Symbol replacements are designated by:
string to replace (Example: :-) )
font to pull the symbol from (Example: WingDings)
symbol to replace with (Example: J)

Show special characters in editor

When checked, this option causes spaces, paragraph and soft-hyphens to be displayed.

Use alternative editor formatting

When checked, this option causes the editor to use a slightly slower but sometimes more accurate
method of formatting text on screen.

Use this option if you see improperly line breaks or other formatting issues.

Force Bidirectional Editing

This option forces The Journal to use bidirectional editing even when the Windows default is left-to-
right.

You will need to close and restart The Journal after changing this setting.

NOTE: Activating this option disables "block justify" formatting display. Block justified text will still print
correctly, but it will not be displayed with block justification in the entry editor.

Scroll Speed in Editor

This number determines how fast the entry editor scrolls when you spin the mouse wheel. The possible
values are 1 (slowest) to 99 (fastest).

NOTE: This setting has no effect on the WYSIWYG editor scroll speed.

Auto-Correction Options

Replace i with I - When checked, all instances of a singularly typed ‘i' will be replaced with ‘I’.' This
option is  On by default for English-language versions of Windows, and Off for non-English-language
versions of Windows.
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Capitalize the first word of a sentence - When checked, the first letter of a word that begins a
sentence will be capitalized. 

Image Options

Default Editor Background Image

This is the image that is used as the background for all entries. This setting can be overridden at both
the category level (see Category Options: Entry Text Style) and at the entry level. Images must be
loaded using the User Images form (on the User menu).

Default Layout for Inserted Images

This setting is used when inserting images. You can change the default to be any of the following:
bottom to base line of text (default)
middle to base line of text
top to line top
bottom to line bottom
middle to line middle
left side
right side

Insert large images as thumbnails

If true, images with a width or height larger than the specified number of pixels are displayed scaled to
that size.

NOTE: The scaling is display only. The image is not resampled. The image can be viewed at smaller or
larger sizes by clicking on a corner and dragging.

Automatic Image Resizing

For most journaling and scrapbooking purposes, images, especially digital photos, don't need to be
stored at their full size. However, having to reduce the images before putting them in The Journal can
be inconvenient. This feature makes it possible to have your images automatically resized when you
insert them.

Resizing can be fully automatic, you can have The Journal prompt you, or you can select to have no
image resizing.

The images are resized according to their largest dimension. If the image's width is greater than its
height, then the width is used to scale the image. If the height is greater than the wide, then the height is
used.

The image is resampled during the resize, so that the quality of the image remains high. The resampling
uses the Lanczos resampling algorithm with a 6x6 cell size.

Default Image Type

To improve save/load times of entries with images, The Journal automatically converts inserted and
pasted images to either JPEG or PNG formats. The JPEG format allows for the best compression, but at
the cost of some information. For most photos, JPEG is the best choice.
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The PNG (portable network graphic) format doesn't compress most images as small as JPEG, but PNG
has the advantage of losing no pixels and doesn't cause the subtle color shifts sometimes seen in JPEG.

This setting only affects images when they are first inserted or pasted. After that, the images aren't
changed, regardless of this setting.

5.18.4 User Preferences: Topics

Default Topic Highlight Color

Topics are displayed with a highlight color that distinguishes them. This is the default highlight color
used by all topics. This color can be overriden by each topic, so that special topics get more a
distinctive color. This color can also be set to "Transparent", which displays no highlighting in the entry
editor.

Default to "Show all topics" in Editor

If checked (the default), then any text in an entry that has one more topics applied to it will display with
that topic's highlight color. If not checked, topic highlight colors aren't displayed. However, the topics in
the entry are still listed below the editor:

Insert Topic Name

If checked (the default), then the topic name is inserted any time a new topic is selected. How the topic
is inserted is controlled by the Topic Name Format option.

NOTE: This option has no effect when you select a block of text and then apply the topic.

Topic Name Format

The default topic name format is: [%topic]

The "%topic" variable is replaced by the name of the topic.

Topics

This is the list of all the topics you have defined. The Journal automatically creates nearly 100 topics for
you. You can add new topics, delete topics you don't want, and edit topics that need changing.

Topics that you have used in an entry are indicated in bold text.
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You can make a topic a sub-topic by clicking and dragging it to the topic you want it to be under, then
dropping it.

Topic Name

Every topic, including sub-topics, must have a unique name.

Highlight

To make it easier to distinguish topics used in an entry, you can set the highlight color. If you do not set
a color, then the default topic highlight color is used.

Hot-Key

Up to 10 topics can be assigned a hot-key. Giving a topic a hot-key makes it even easier to apply that
topic. The available hot-keys are Shift+Ctrl+1, Shift+Ctrl+2, up to Shift+Ctrl+0. (NOTE: Shift+Ctrl+6 and
Shift+Ctrl+7 are only available if the global option "International character hot-keys override topic hot-
keys" is un-checked.)

New Sub-Topic

This button creates a new sub-topic of the currently selected topic.

Delete Topic

Deletes the selected topic.

5.18.5 User Preferences: Styles

Edit Default User Text Style...

The default user text style defines the font and background color used in newly created categories, as
well as those categories still tied to the default settings.

User Styles

The Journal allows you to create as many pre-defined styles as you want. These styles can be used in
entries in any category.

Some styles are automatically created for you when you first start using The Journal. These can be
changed or even deleted, if you like.

Show Standard Styles

The Journal uses certain "standard" styles. Such styles are the default user text style, the bullet style,
and the numbered list style. Check this option if you would like to see those styles.
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These styles can be edited and copied, but they cannot be deleted.

See Styles for more information.

5.18.6 User Preferences: Reminders

Click here for more information about reminders.

Report Missed Reminders

If checked (the default), then every time you log in, The Journal will see if you missed any reminders
since the last time you logged out.

Include Reminders When Printing/Exporting Entries

NOTE: This option only applies to entries in calendar categories, like "Daily Journal".

If this option is checked, then when you print or export entries from calendar categories, any reminders
that were active, completed, missed, skipped or canceled on that date will also be printed or exported.

Display reminders/events from MS Outlook in The Journal

If checked, The Journal will display your reminders/events from your default MS Outlook calendar.

5.18.7 User Preferences: Date/Time

"Insert Date" Format

This is the format that is used for dates inserted with the Insert | Date (Ctrl+D) command.

Use the following codes for the date format:
yyyy - 4 digit year (1996)
yy - 2 digit year (96)
mmmm - full month name (August)
mmm - three-letter abbreviation of month (Aug)
mm - 2 digit month (08)
m - 1-2 digit month (8)
dddd - full day name (Friday)
ddd - three-letter abbreviation of day (Fri)
dd - 2 digit day (09)
d - 1-2 digit day (9)

Edit "Insert Date" Style

The formatting of the inserted date text can be specified with this option.

See Styles for more information.
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Entry Date Header Format

This format is used to display the date above calendar entries.

See "Insert Date" Format above for formatting codes. Commas or any punctuation, or spaces can be
added or deleted to suit the format of date you would like to display

Force month and day names to English (global option)

When this option is checked names of months and days will be converted to English. This applies to the
calendars and planners as well as the Insert Date and Insert Time commands.

Note: This is a global option and affects all users.

"Insert Time" Format

This is the format that is used for dates inserted with the Insert | Time (Ctrl+T) command.

Use the following codes for the time format:
hh - 2 digit hour (02:00)
h - 1 digit hour (2:00)
nn - 2 digit minute (2:03)
n - 1 digit minute (2:3)
ampm - 12-hour clock, AM/PM (2:00 PM)
am/pm - 12-hour clock, am/pm (2:00 pm)
a/p - 12-hour clock, a/p (2:00 p)

Edit "Insert Time" Style

The formatting of the inserted time text can be specified with this option.

See Styles for more information.

5.18.8 User Preferences: Links

Auto-Highlight Links

If checked, then Internet links/URLs (web page addresses, email addresses, etc) and entry links will be
highlighted as they are typed in.

Clicking links opens a New Browser

If checked, a new browser window is opened when Internet links are clicked on. If not checked, then
the most recently opened browser window is used. In either case, if no browser window is open, one is
opened.

Edit Internet/Email Links Style

The formatting used to display Internet links/URLs can be specified with this option.
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See Styles for more information.

Edit Entry Link Style

The formatting used to display entry links can be specified with this option.

See Styles for more information.

5.18.9 User Preferences: Spell Checker

Check spelling as you type

This option performs "live" spell checking if activated. Misspelled words will be marked with a distinctive
underline (see Spelling errors underline color below). Marked words can be right-clicked on to bring up
a list of suggestions to correct the misspelling.

Spelling errors underline color

This option specifies the color used when marking misspelled words when performing "live" spell
checking.

Correct spelling errors as you type

This option performs "auto-correction" of designated misspellings. For example, "teh" is automatically
corrected to "the".

The Journal includes a list of commonly misspelled words and their automatic corrections. Plus, you
can add new auto-corrected words to your custom spell check dictionary.

5.18.10 User Preferences: Printing

User Name

This option defaults to your login name for The Journal. If you would like your full name to appear on
entry printouts (using the <USERNAME/> macro), enter that here.

Edit Default Page Setup

The default page setup is used when printing entries from any category that does not specify its own
page setup. You can specify the default page orientation (portrait or landscape), as well as the margins
to be used.

Edit Default Page Header and Footer

The header and footer specified here are used when printing any category that does not specify its own
header and footer.

Edit Default Entry Header
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The entry header specified here is used when printing entries from a category that does not specify its
own entry header.

See Printing for more information.

5.18.11 User Preferences: Backup/Restore

Backup Path

This is the folder or drive path where the backup will be located. You can select your own destination to
removable media or any folder on your hard drive by selecting Browse (…)

Always backup when closing The Journal

When checked, The Journal will do a backup whenever you close the software.

This option overrides the "Prompt for backup every nn days" option.

Backup Journal Volumes every nn day(s)

When this option is checked and the number of days is selected, The Journal will backup your Journal
Volumes before closing. The default is every 3 days.

Append date & time to backup archive

If checked, the backup file name will be automatically appended with the current date and time.

Keep only the nn most recent backups per Journal Volume

Once the number of backups for a Journal Volume reaches this number, then the oldest backup is
deleted to make room for the new one.

This applies to the backup path you set above, and to all paths you have The Journal copy your
backups to (but not to FTP servers).

Copy backup archive to these locations

This feature allows you to automatically create identical backup copies in additional locations by
selecting Browse (….), selecting a location, and then clicking "Add".

You can also have The Journal automatically FTP your backup file to an offsite location. To do that, you
have to input the FTP information in this format:

ftp://userLogin:userPassword@ftp.host.com/remote/path/

Or, if you use anonymous login to the FTP server (not recommended):

ftp://ftp.host.com/remote/path/
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Finally, it's also possible to upload with FTPS, assuming your server supports FTPS:

ftps://userLogin:userPassword@ftp.host.com/remote/path/

5.18.12 User Preferences: Security

Automatically log in this user (bypass password)

If you would like to automatically log you in when you launch The Journal, set this option. You can also
set (or clear) this option by clicking on the User menu and choosing Auto-Login.

You must confirm your password to activate this option. If you have a blank password, just hit
ENTER.

NOTE: This feature effectively bypasses The Journal's built-in security features, so only activate this
feature if you are the only person using your computer.

In past versions of The Journal, Auto-Login was called "Single User Mode".

Lock on Minimize/Hide (prompt for password on restore/un-hide)

This setting, if active, "locks" The Journal when minimized or it is hidden, whether with the auto-hide
option or the "Hide The Journal" hot-key (Ctrl+J).

Compress Entries

If checked (the default), all entries are compressed as they are saved. This keeps the Journal Volume
as small as possible, and adds a bit more security.

NOTE: The Journal overrides this setting for entries that have media attachments or a large (or a large
number of) JPG or PNG images. This is because most media files and JPG and PNG images are
already compressed, and trying to compress them further slows down loading and saving without
gaining any significant benefit.

Encrypt Entries

If checked (the default), all entries are encrypted as they are saved. If compression is also turned on,
that happens prior to encryption.

Why you might turn off compression and/or encryption: If you are not worried about the security
of your entries, then you might turn off these options to speed up loading and saving of entries.

NOTE: Turning off either does not affect entries that already exist. Only entries that are added or
modified will use the new settings.

See Extended Security: Global Options for more information.
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Levels of Security     142

Levels of Threat     143

license     14

linked categories     86

linking to an entry, how to     125

Links     76, 124

links to files     128

links, email     128

links, entry     125

links, file     128

links, internet     128

links, Web page     128

links, with bookmarks     127

Loading Your Background Image     120

Loading Your Border Image     119

Loading Your Calendar Charms     121

Lock Entries on Edit     94

lock entry     106

Lock on Minimize/Hide     207

Login     188

Loose-leaf Categories     85

lost password, resetting a     61

Lotus Organizer csv file import     113

- M -
Make The Journal 6 look like The Journal 4     70

Mark past entries read-only     89

Master Category     88

Measurement System     194

measurement, metric     194

measurement, US     194

media     76

media files     116

media files, inserting     122

media files, playing     122

menus, customizing     174

merge two or more categories     86

Merging Categories     86

metric     194

Minimize on Close     195

Minimize when The Journal loses focus     195

Missed Reminders     140

MS Outlook reminders     203

- N -
network, how do I use The Journal on a     62

new computer, moving The Journal to a     62

new features in The Journal 6     38

New/Updated Entry Report     104

No new users can be created in Journal Volume    
124

Normal Document Entry     91

Notebook     44

notebook categories     85

- O -
objects, inserting     123

only one instance of The Journal     179

Only show if there are active reminders     88

Only Verify Password Once per Session     94

options, backup     206

options, date/time     203

options, editor     198

options, entry link     204

options, general     194

options, global     195

options, internet/URL links     204

options, link     204

options, printing     205

options, reminder     203

options, security     207

options, spell checker     205

options, style     202

options, topic     201

order form     19

- P -
Packages     87

packages, add-on     87

Paragraph     189

paragraph borders     189

Paragraph Borders & Shading     189
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paragraph color     189

paragraph shading     189

Paragraph: Alignment & Indents: Alignment     148

Paragraph: Alignment & Indents: Apply Style to
Indentation     148

Paragraph: Alignment & Indents: Left and Right     148

Paragraph: Alignment & Indents: Special     148

Paragraph: Apply Style to Paragraph Settings     148

Paragraph: Numbering/Bullets: Apply Style     148

Paragraph: Numbering/Bullets: Bullet/Numbering Type
    148

Paragraph: Numbering/Bullets: Indent     148

Paragraph: Numbering/Bullets: Numbering Style    
148

Paragraph: Spacing: Apply Style to Paragraph
Spacing     148

Paragraph: Spacing: Before and After     148

Paragraph: Spacing: Line Spacing     148

password hashing     145

password, category     94

password, changing     69

password, changing your     182

password, choosing a good     142

password, how to reset my     61

password, I don't want a     207

password, removing     69

password, resetting a     61

password, tips for a good     142

password, user     207

Penzu, importing entries from     66

Penzu, importing from     110

photos     116

photos, inserting     55, 116

pictures     116

pictures, inserting     116

preferences, backup/restore     206

preferences, date/time     203

preferences, editor     198

preferences, general     194

preferences, global     195

preferences, link     204

preferences, printing     205

preferences, reminder     203

preferences, security     207

preferences, spell checker     205

preferences, style     202

preferences, topic     201

preferences, user     194

pricing, The Journal     18

Print Loose-leaf Entry Index Indented     205

Print Macros     131

Printing     58, 129

Printing Entries     46

Printing Headers and Footers     131

printing, headers & footers     185

printing, margins     131

printing, page setup and margins     131

product license information     14

Prompt for backup every nn day(s)     206

Prompt for backup when closing The Journal     206

Prompt for entry name when creating new loose-leaf
entries     194

Prompt for Lock Message     94

Prompt on repeated word     205

- Q -
Quantity Pricing     18

- R -
read only, make an entry     106

read only, make category     94

read only, make Journal Volume     124

read only, past entries marked as     89

registration keys, entering     186

Reminders & Tasks     132

Reminders to Show Above Entry     203

reminders, # to show above entry     203

reminders, advanced options     136

reminders, anniversary     135

reminders, appointment     133

reminders, birthday     135

reminders, category options     136

reminders, date     133

reminders, date/time options     136

reminders, display options     136

reminders, event     133

reminders, export/import format     140

reminders, exporting     139

reminders, importing     139

reminders, missed     140, 203

reminders, moving to another install of The Journal    
139

reminders, notes     136
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reminders, popup options     136

reminders, printing/exporting     203

reminders, reporting     138

reminders, special day     135

reminders, status options     136

reminders, task     134

reminders, view a list of all     138

remove bookmark     127

removing password     69

Repair All Journal Volumes     96

Repair Journal Volume     96

Repair System Database     96

Repair The Journal Databases     96

Replace Text...     190

Report Missed Reminders     203

report, new/updated entries     104

report, topics used     104

reports, types of entry     104

Reset Login Password     191

Resizing Images     116

Restore     96

restore a category from a backup file     67

Restore Journal Volume     96

Reverting to The Journal 4     71

rich text (RTF), export entries as     107

- S -
Save Entry As...     99

Save entry editor state between sessions     91

Saving Entries     99

script variables, enhanced template     162

Scroll Speed in Editor     198

search and replace text     190

Search Categories     100

Search Entries     100

Search Results     103

Search Text     100

Searching Image Descriptions     116

Searching Topics     173

Security     141

Security Details     145

Security Overview     141

security, extended     146

security, levels of     142

security, overview of The Journal's     141

security, threats to     143

Select Categories/Entries to Export     107

Select Categories/Entries to Print     129

Select Entry     191

Select Export Format     107

Setting the Entry Background Image     118

Setting Up a Blogger (Google) Blog     83

Setting Up a Custom Blog     83

Setting Up a WordPress Blog     82

settings, backup     206

Shared Categories     86

shortcuts, keyboard     175

Show calendar     88

Show Category Type on Tab     194

Show day planner with active reminders     88

Show Entry Date/Name above Category Tabs     194

Show entry tree     88

Show Journal Volume tabs     194

Show latest entry by default     89

Show special characters in editor     198

Show Standard Styles     202

Show The Journal "splash screen" on Startup     195

Show The Journal in the Windows system tray     195

Show User Name tabs     194

Simple Templates     157

skin, changing the     174

skin, how do I change the     61

skinning, turn off     195

skinning, turn on     195

sound, countdown timer completed     195

sound, reminder popup     136

Spacing     189

spacing, line     189

spacing, paragraph     189

special day reminders     135

Special Days     135

Special Thanks     16

spell checker     205

Spelling errors underline color     205

stamp entries with time     89

standard styles, editing     148

Start New Entry Date After     194

Stopwatch     191

style     76

Style Name     148

Style Options     148

Style Options: Override Options     151

Style Options: Paragraph     149
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Style Options: Paragraph: Alignment & Indents     149

Style Options: Paragraph: Numbering/Bullets     150

Style Options: Paragraph: Spacing     150

Styles     147

styles, create new     147

styles, editing     148

styles, standard, editing     148

Suggest from main dictionaries only     205

supported blogs     79

Supported Export Formats     106

switch language     179

synchronizing The Journal     66

Syncing The Journal     114

Syncing The Journal from USB to Desktop     114

Syncing The Journal from Work to Home     114

system database     76

- T -
tab setting     198

Table Cell Properties     156

Table FAQ     152

Table Properties     154

Table Row Properties     155

Tables     151

tables, inserting     55, 153

tables, making tables look like MS Word     55

tables, using     152

tabs     83

tabs, calendar     84

tabs, category     83

tabs, daily entry     84

tabs, loose-leaf     85

tabs, notebook     85

tagging an entry with a topic     171

task reminders     134

Tasks     134

template    

creating a simple     162

template, inserting a     156

Templates     156

Templates Overview     156

templates, enhanced     157, 163

templates, enhanced tags     158

templates, enhanced, basics     163

templates, inserting     55

templates, overview of     156

templates, simple     157

text, export entries as     107

The Journal 4 icons, how to use     70

The Journal 4, going back to     71

The Journal 4, reverting to     71

The Journal 6, new features     38

The Journal Hide/Unhide Global Windows Hot-Key    
195

The Journal Order Form     19

The Journal Pricing     18

theme, changing the     174

theme, how do I change the     61

timer, countdown     183

timer, stopwatch     191

TJ4 icons for menus and toolbars, how to use     70

TJ4, going back to     71

TJ4, reverting to     71

TJEXP export file format     109

TJXML export file format     109

to-do items     140

to-do items, creating     140

to-do items, managing     140

to-do items, report     140

toolbars, customizing     174

toolbars, how to customize     61

topic     76

Topic Name     201

Topic Usage Report     104

topic, options     173

Topics     171

topics, applying     171

topics, editing     173

topics, searching     173

topics, using     171

tree     76

Turn on Skinning     195

typing international characters     175

Typing Out Entry Links     126

Typing out Links with Tags     129

- U -
unlock entry     106

Unlock Form     192

Un-upgrading to The Journal 5     71

Upgrade Pricing     18

Upgrading Add-on Packages     73



Index 217

© 1996-2014 by David Michael

Upgrading Categories (The Journal 2.x)     73

Upgrading Entries (The Journal 2.x)     73

Upgrading from a Backup File     71

Upgrading from The Journal 2.x     73

Upgrading from The Journal 3     71

Upgrading from The Journal 4     71

Upgrading Notes     71

Upgrading Users (The Journal 2.x)     73

Upgrading Your Journal Volumes from The Journal 4
(or earlier)     71

URLs     128

USB drive, install The Journal to a     62

Use alternative editor formatting     198

Use Category Extended Security     94

Use The Journal 4 icons     195

Use TJ4 icons for the toolbars, menus and entry tree  
  195

Use WYSIWYG formatting     91

User Images     192

User Interface Font     195

User Name     205

User Preferences     194

User Preferences: Backup/Restore     206

User Preferences: Date/Time     203

User Preferences: Edit     198

User Preferences: General     194

User Preferences: Global     195

User Preferences: Links     204

User Preferences: Printing     205

User Preferences: Reminders     203

User Preferences: Security     207

User Preferences: Spell Checker     205

User Preferences: Styles     202

User Preferences: Topics     201

User Statistics     193

User Styles     202

users, changing passwords     182

users, deleting     124

Using a Blog     79

Using Categories     48

Using Images in Entries     116

Using Tables     152

Using Topics     171

- V -
Version History     20

video files     116

video files, inserting     122

View | Change Skin/Theme     174

View All Reminders     138

voice-recognition software, using The Journal with    
61

volume     123

volume, journal     123

- W -
Web pages     128

week numbers, displaying     194

week, first day of     194

Welcome to The Journal     11

What are the size limits on a Journal Volume?     62

What is a Journal Volume?     62

What is Extended Security?     69

What kind of encryption does The Journal use?     69

What's New in The Journal 6     38

When pasting as Plain Text, preserve images     198

When pasting, Rich Text Format has priority over
HTML Format     198

when selecting, auto-select entire word     198

Word Count     186, 193

word count, on the status bar     91

word count, running     91

WordPress blog setup     82

WordPress xml import     113

WordPress, importing entries from     66

wrap text around pictures     55

WYSIWYG     91

- X -
XML, export to     109
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